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Legal Disclaimer

This document and the information contained herein (collectively, the "Information") is provided to you (both the individual receiving
this document and any legal entity on behalf of which such individual is acting) (“You" and "Your") by AT&T, on behalf of itself and
its affiliates ("AT&T") for informational purposes only. AT&T is providing the Information to You because AT&T believes the
Information may be useful to You. The Information is provided to You solely on the basis that You will be responsible for making
Your own assessments of the Information and are advised to verify all representations, statements and information before using or
relying upon any of the Information. Although AT&T has exercised reasonable care in providing the Information to You, AT&T does
not warrant the accuracy of the Information and is not responsible for any damages arising from Your use of or reliance upon the
Information. You further understand and agree that AT&T in no way represents, and You in no way rely on a belief, that AT&T is
providing the Information in accordance with any standard or service (routine, customary or otherwise) related to the consulting,
services, hardware or software industries.

AT&T DOES NOT WARRANT THAT THE INFORMATION IS ERROR-FREE. AT&T IS PROVIDING THE INFORMATION TO YOU
"AS IS" AND "WITH ALL FAULTS." AT&T DOES NOT WARRANT, BY VIRTUE OF THIS DOCUMENT, OR BY ANY COURSE OF
PERFORMANCE, COURSE OF DEALING, USAGE OF TRADE OR ANY COLLATERAL DOCUMENT HEREUNDER OR
OTHERWISE, AND HEREBY EXPRESSLY DISCLAIMS, ANY REPRESENTATION OR WARRANTY OF ANY KIND WITH
RESPECT TO THE INFORMATION, INCLUDING, WITHOUT LIMITATION, ANY REPRESENTATION OR WARRANTY OF
DESIGN, PERFORMANCE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, OR
ANY REPRESENTATION OR WARRANTY THAT THE INFORMATION IS APPLICABLE TO OR INTEROPERABLE WITH ANY
SYSTEM, DATA, HARDWARE OR SOFTWARE OF ANY KIND. AT&T DISCLAIMS AND IN NO EVENT SHALL BE LIABLE FOR
ANY LOSSES OR DAMAGES OF ANY KIND, WHETHER DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, PUNITIVE,
SPECIAL OR EXEMPLARY, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF GOODWILL, COVER, TORTIOUS CONDUCT OR OTHER
PECUNIARY LOSS, ARISING OUT OF OR IN ANY WAY RELATED TO THE PROVISION, NON-PROVISION, USE OR NON-USE
OF THE INFORMATION, EVEN IF AT&T HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSSES OR DAMAGES.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide



((

AT&T Entertainment Experience Suite Video Optimizer User Guide

Table of Contents

1. INTRODUCTION. iirteirtreireeeserenseresseressessssssesessrssssssssesesssssssssssssssssssssssssssssssssssssssessssssssssssssssssnss 5
2. OVERVIEW aurteirttirieiitinireesertasisessesesssssssssssssesssssssssssesssssssssssssssssssssssssesssssssssssssssssssssssssenssssss 5
2.1. INSTALLATION REQUIREMENTS ctttetereeeterensereaserenssrensesensssrssssssssesssssssnsssenssssssssssssesenssssssssanssssen 5
P T V1V 1 N 070 )./ TR 5
P R |V 1 o © 1 TR 7
D TG T I 1 N0 ) G R 10
3. VIDEO OPTIMIZER TO COLLECT DATA .t tttettcirteiertneietnestresersnsssenserensssssssssssssrssssssssesenses 10
3.l PREREQUISITES uutiitteeeeerereererrernssesrernssessessssessessssesssssssessssssssssssssssssssssssssssssssssssnsssssssnsssssssnnses 11
3.1.1. IOS PREREQUISITES ..uciiiiottiiiiitteeeeitteeeeetteeesstteeesssseessssssaesssesseesssssseessssssesssssssessessssessesssssesessnnes 11
3.1.2. ANDROID PREREQUISITES ....cccettutttteeiiiiiiieeeereeeeesssistseteeeesssssssssseeessssssssssssssessesssssssssssseessssssssnnes 12
3.2. COLLECTING A VIDEO OPTIMIZER TRACE teuttteterenrtrenserenessrnssssressrsssssssserenssssssssessssrssssssnsssansens 12
3.2.1. COLLECTING A HD TRACE: IOS SPECIFICS (I0S 12 AND ABOVE ONLY)...cceiureierresreeresienenns 16
3.2.2. COLLECTING A SECURE TRACE (ANDROID STEPS, UP TO ANDROID 14) ......cccveeveririeierieneenns 17
3.2.3. COLLECTING AN ATTENUATED TRACE oo e e e e ee ettt ettt et ettt et ettt e e e e e e e e e e e e e e e e e e enen e e e s e neneseneeens 22
3.2.4. 105 SECURE COLLECTOR ..coeeceuttttteeettieeeiieteteeesssssssseteeeessssssssssseeesssssssssssseessssssssssssseessssssnssnee 26
3.3, TESTING YOUR APPLICATION tettuuereesereaseeessssesesersssessssersssssssssssssssssssssssserssssssssssssssssssssssssessnsens 30
3.4, ENDING THE TRACE tteuttteutrrrerersessrenserensssrsssssssssrsnsssessssssssssssssssssssssssssssessnsssssssssnssssssssssssssansas 30
4. ANALYZING A TRACE it irriiritintriitreereeeistneisesesstsssssessesenssstsssssssserssssssssssenssssssssssssssansess 33
4. 1. OPENING A TRACE tituieteueereaneresseressssessserssscrsssessssssesssssssssssssesssssssssssssssessssssssssssssssssssssssssssssess 34
4.2. BEST PRACTICES RESULTS tttttterteeertenseeresersssesessesesssessssersssesssssssssssssssesssssssssesssssssssssssssessnsss 40
4.3. PRIVATE DATA TRACKING teuutreeterereerrressrresersnsssessssensssssssssessessnssssssssssssesssssssssssenssssssssssnsesansess 44
4.4, VIDEO ANALYSIS euirtrurereusereaseresseresssssssssessserssssssssssesssssssssssssesssssssssssssssesssssssssssessssssssssssssssnses 45
A.4.D. VIDEO ANALYSIS SETUP...cttittiiiieeeeeteeee et eeeeiittteeessseassireeteesssssassssteteesssssessssseeeeesssssmmssssseeesssons 45
4.4.2. CONFIGURATION REQUIRED......ccetutttteeeeiiieiiteiteeeeeesissisreereesesssssssssssseessssssssssssessssssssssssssseesssssnnns 46
A.4.3. ANALYZING A VIDEOQ ...uuuutiiiiieeiiiieeieeteeeeeeeeeeaetteeesessssssaseeteesessssssssssessesssssssssssseessssssssssssssesesssnsns 47
444, VIDEO BEST PRACTICES ..oottiiiiiieeeeeteeeeeeeeeeeetteeeesseaasaseeseessssseasssetseesssssesssseeesssssssssssssseesesssans 55
5. VIDEO OPTIMIZER REFERENCE ....itccitttiiitteiertiireeiirtneesteniseeeserssseressersssesssssssssssssssessssessnnens 58
.0, IMENU tttuuireunerennireneerensssesnssesessrsssssessesessssssssssssssssssssessssensssssssssnsssssssssessessnssssssssensssssnssssnsssansans 58
LTt O O [ = 1Y = N ORI 58

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide



((

AT&T Entertainment Experience Suite Video Optimizer User Guide

B5.1.2.  PREFERENCES......iitcettttttetttitetstttteeeessseassaeeteesssssasssasseeeesssssssssesseesssssssssresseesssssmmsssssseesssssmssnnes 59
B5.1.3.  PROFILE IMENU ..ottt ettt e e e e ee e et teeeeeeeaa s eeteeeesssasasseaeeeessssasasreseeeeesssaaaaseeeeesssesannrenes 62
D14, TOOLS IMENU..oiiiiiieeeeeeeee ettt e e e e e e ee e st teeseesaassaaaeeeeesssasasseateeeesssasasreaeeeessssaaarsseeeeesssasannrenes 70
.15, VIEW IMENU . cueiiiiiiiieeceetetee ettt et e e e se ettt teeessssessaaateeeesssssassseseeeeesssssasarssseeeesssssssssseseesssssnsrrnes 79
5.1.6. DATA COLLECTOR MENU ...oooieutreiieeeeiiiiiiieeeteeeessseessseteeeessssssssssseessssssssssssseessssssssssssseesssssssssnnes 83
BLL.T7. HELP IMENU eeeeeee ettt ettt e e e e e e e ettt eeeeeeaaa e eeeeesseasasneaeeeeesssasaaseaeeeeesssasasseeeeesssesannnenes 84
B 2. CONTENT TABS tittuetteuieenserenereaseresessessseessssssssersssssessssssssssssssssssesssssssssesssssssssssssssssssssssssessnsans 84
5.2.1. BEST PRACTICES/RESULTS TAB coiooutttitietteeeeeteeeeeeieteeseaisteessareteessesstesssssstesssssssesssssssessssssseesssnes 85
I O 1Y/ =1 = AV | VAV N = TR 96
B.2.3.  DIAGNOSTIC TAB oiteeeeeeteeee ettt eeeeee et e e e e e e e e e et eeesseaeas s ateeeesssesasareaeeeeesssasasaeaeeeeesssasanseneeeeesssaaas 100
LI T V[Tl T Y = TP 120
LI TR w0 1TLY LS 1Y = SRR 124
B 2.8, ST ATISTICS TAB ittt et ettt e e e e e e e e e e eeeeeeseaaas s ateeeesseesasaeaeeeeesssasasaeateeeessseaasnsenaeeeesssaaas 130
2. 7. WV ATERFALL TAB otieeteetttee e e eeeeeeee et e e e e e e ee e et eeeseeeaas e eateeeeeseasaaaeaeeeeesssasasaeaeeeeesssesansenaeeeesssaaas 148
5.  APPENDIX uuirttirttuiereesereeneresneeeseserssssrssserssssssssssssssesssssssssesesssssssssssssesssssssssssssssssssssssssesansssses 151
6.1. DATA COLLECTOR ERROR MESSAGES ..cvteuirteererenerenseresseresssssssssssssesssssssssssssssssssssssssesassssses 151
6.2. VIDEO OPTIMIZER ERROR MESSAGES ..uctteuittreirrreerensirenserensssrssssssssersnsssssssssnsssrssssssssssanssssns 152
5.3, GLOSSARY tuereeuererurereeserraseressssesssssssssssssesssssssssssssssesssssssssesesssssssssssssssssssssssssssssssssssssssesansssses 163
7. APPENDIX Il irttirttuiereesereaneresneeesnserssssrsssesssssssssssssssesssssssssesssssssssssssssssssssssssssssssssssssssssesansssses 169
7.1. ROOTED DATA COLLECTOR APK uituiiieiirtnirtniiiriereeeirensireneserssssrsssersnssssssssesssessnssssssesansssses 169
7.1.1. PREREQUISITES FOR USING THE ROOTED DATA COLLECTOR APK .....uvvviiiiiiiiieeieeeeeee 169
7.1.2. INSTALLING ROOTED DATA COLLECTOR APK ..ttt ettt eeeieateee e e s s e sesnveneeeeesssenas 169

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide



((

AT&T Entertainment Experience Suite Video Optimizer User Guide

1. Introduction

The Video Optimizer User Guide describes in detail the methods for collecting an application
trace with Video Optimizer. This guide describes how to open a trace and it includes a
reference section with the tabs, menus, options, charts, graphs, and statistics. This guide is
intended for app developers who are interested in testing the performance of their apps.

. Overview

Video Optimizer is a diagnostic tool for analyzing mobile web application performance.
Video Optimizer automatically profiles your application and provides recommendations that
let you optimize performance, make battery usage more efficient, and reduce network
impact.

The traces that Video Optimizer runs against your application are benchmarked against
recommended best practices. Video Optimizer looks at how your application (and your
server) is handling caching, and how you are managing the network connections for your
application. By optimizing against these best practices, your application will run faster, use
the network less (saving valuable battery life for your users), and improve the experience of
customers using your application.

2.1. Installation Requirements

To install Video Optimizer 5.2, be sure that your computer has at least 4GB of RAM.
Please use the hyperlinks below to get installation requirements and instructions for
specific operating systems -

e Windows
e Mac
e Linux

2.1.1. Windows

e Java - Java 8 or above
o Wireshark —4.0.11 and above, preferably current

Wireshark is required for maintaining cross-platform compatibility of traces.

You can download it from https://www.wireshark.org/

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
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Stable Release (4.0.1) « October 26, 2022 ~

& Windows Installer (64-bit)
Windows PortableApps® (64-bit)
macOS Arm 64-bit .dmg

macOS Intel 64-bit .dmg
Source Code

Old Stable Release (3.6.9) « October 26, 2022 ~
Documentation ~
M Wireshark 4.0.1 64-bit Setup — g
Packet Capture
‘Wireshark requires either Npcap or WinPcap to capture live network data. 4

Currently installed Npcap or WinPcap version

Install
Install Npcap 1.71
(Use Add/Remave Programs first to uninstall any undetected old Npcap or

Important notice

TF your system has crashed during a Wireshark installation, you must run the
'net stop npcap' as Administrator before upgrading Npcap, so that it doesn't crash

Get WinPcap

Learn more about Npcap and WinPcap

<o p—

o Choose Install Npcap

{37 Npcap 1.71 Setup - X

Installation Options.
Please review the following options before installing Npcap 1.71

Dkesmd Npcap driver's access to Administrators only
[[Jsupport raw 802. 11 traffic (and monitor mode) for wireless adapters

Install Npcap in WinPcap API-compatible Mode

<tack Cance

e Choose Install Npcap in WinPcap APIl-compatible Mode
e Wireshark normally installs in Program Files. If user chooses to
install in a different location:
o Add Wireshark to the System environmental variables path.
o Or configure in Video Optimizer Preferences.
See section 5.1.2

e VLC Media Player —

Video Optimizer uses VLC media player to play most types of videos
(namely mp4/SD|HD and mov/low-res videos). You need to have VLC
installed on your computer (you can download it from
https://www.videolan.org/vic/). Version 3.x.x or higher is required.
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VLC is a free and open source cross-platform multimedia player
and framework that plays most multimedia files as well as
DVDs, Audio CDs, VCDs, and various streaming protocols.

e FFmpeg & FFProbe Setup —

FFmpeg, and FFprobe are used by Video Optimizer in a few different
ways, including Video Analysis. You can download it from
https://ffmpeg.org/. FFmpeg normally installs in Program Files.

If user chooses to install in a different location:

e Add FFmpeg bin folder to the System environmental variables
path.
e Or configure in Video Optimizer Preferences. See section 5.1.2

Additional dependencies must be met to collect network or traffic data from
Android devices.

2.1.2. Mac OS
e Java — Java 8 or above
e Xcode —

e Make sure you have the most current version
e In aterminal, run xcode-select --install

e Homebrew — install Xcode before installing Homebrew.

e Visit https://brew.sh to install

e FFmpeg — In the terminal, install with the command —

e ‘brew install ffmpeg’
e It will also install ffprobe.

PATH - Mac OS uses Z shell and as such you want to configure your path
variables in .zprofile.
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Note — For instructions on how to create a bash profile on Mac follow the
instructions specified at the link -

https://www.insightsjava.com/2022/01/how-to-create-bash-profile-on-
mac.html

A sample bash profile is available to download from our GitHub repository
using the link below —

https://raw.qgithubusercontent.com/attdevsupport/VideoOptimizer/master/s
ample.zprofile.txt

(To save the file locally, once the file opens in the browser, right click and
click ‘Save as’)

Note — A warning message is displayed if a lower version of Brew is
detected and a suggestion to update by specifying the latest version is
made.

@ Brew Version Warning

Your local Brew version is 3.6.18, the latest Brew version is 4.0.9.
We suggest update your local brew application.

Skip this version.

OK

2.1.2.1. Intel (Macs 2019 and before)

o Wireshark - 4.0.11 and above, preferably current

Stable Release (4.0.1) « October 26, 2022 -

& Windows Installer (64-bit)
Windows PortableApps® (64-bit)

macO0S Arm 64-bit .dmg
macOs Intel 64-bit .dmg
Source Code

Old Stable Release (3.6.9) « October 26, 2022 v

Documentation ~

Install the Intel version of Wireshark into /Applications.
e VLC Media Player

Video Optimizer uses VLC media player to play most types of videos
(namely mp4/SD|HD and mov/low-res videos). You need to have VLC
installed on your computer (you can download it from
https://www.videolan.org/vic/). Version 3.x.x or higher is required.
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VLC is a free and open source cross-platform multimedia player
and framework that plays most multimedia files as well as
DVDs, Audio CDs, VCDs, and various streaming protocols

Download VLC

Install the macOS version.

2.1.2.2. Apple silicon

e Wireshark - 4.0.11 and above, preferably current

Stable Release (4.0.1) « October 26, 2022 -~

& Windows Installer (64-bit)
Windows PortableApps® (64-bit)

macO0S Arm 64-bit .dmg
macOS Intel 64-bit .dmg
Source Code

0ld Stable Release (3.6.9) « October 26, 2022 ~

Documentation ~

Install the appropriate version (depending on which architecture of
Java you have installed) -

If you are using Intel builds of Java, you must install the macOS
Intel 64-bit version.

If you are using Arm 64-bit version of Java, then you must install
the macOS Arm 64-bit version.

e VLC Media Player

VLC is a free and open source cress-platform multimedia player
and framework that plays most multimedia files as well as
DVDs, Audio CDs, VCDs, and various streaming protocols

Download VLC

Install the appropriate version (depending on which architecture of
Java you have installed) -
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If you are using Intel builds of Java, you must install the macOS
version.

If you are using Arm 64-bit version of Java, then you must installl
the macOS (Apple silicon) version.

Additional dependencies must be met to collect network or traffic data from
Android, or iOS devices.

2.1.3. Linux
e Java — Java 8 or above
o Wireshark - 4.0.11 and above, preferably current

In terminal, use the following commands one by one -
sudo add-apt-repository ppa:wireshark-dev/stable
sudo apt update

sudo apt upgrade -y

sudo apt install wireshark

sudo apt install tshark

e VLC Media Player

It needs to be installed using ‘sudo apt-get install vic’. If VLC is
installed in a different way, Video Optimizer will not recognize it.

e FFmpeg
FFmpeg is available in the default repositories. Open Terminal and
run the following command to install it.

o sudo apt-get install ffmpeg

Additional dependencies must be met to collect network or traffic data from
Android devices.

Note — Video Optimizer installer will alert you of the missing dependencies during the
install process.
3. Video Optimizer to Collect Data

Video Optimizer captures the data traffic of mobile devices. As data streams across the
network during a given period, Video Optimizer captures each TCP packet and matches the
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packet information with recorded video of what the user is seeing on the device. Video
Optimizer also looks at other parameters from the mobile device such as signal strength,
network type, CPU & GPS usage, etc.

You can use Video Optimizer to test the following:

iPhone or iPad running iOS 14 or newer is supported.
Android devices (and emulators) versions 6.0 and up.

Note: The original Android Collector works on Android versions 2.3.7 - 5.1 but requires
root access. See APPENDIX Il for more information about how to use the legacy Rooted
Data Collector API.

Pcap Packet traces: Pcap packet trace files contain basic (network only) data that can
be captured using several different tools. Once captured, pcap files can be opened
directly in the Video Optimizer. Pcapng and pcap formats are supported.

Automated Collection using Video Optimizer SDK. To facilitate the integration of Video
Optimizer with developer tools, automated testing environments and Enterprise build
environments, we’ve exposed APIs for collecting and analyzing traces.

3.1. Prerequisites

This section describes the prerequisites for collecting a Video Optimizer trace on iOS
and Android devices.

3.1.1. iOS Prerequisites

Collecting a Video Optimizer trace on an iOS device requires the following:
Mac computer running OSX 10.8 or higher, with the following:

1. Administrator rights

2. Ability to use SUDO password from Terminal

3. Apple's XCode

Note - Xcode must stay up to date with the highest iOS version of the
devices that will be used to collect traces.

Required for maintaining cross-platform compatibility of traces.

4. For Apple silicon (M1/M2) machines, please ensure kernel
extensions are authorized using instructions from one of the
links below —

Kernel extensions in macOS - Apple Support

How to Enable and Activate Kernel Extensions on Apple Silicon
Macs (makeuseof.com)

5. Homebrew
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Recommended to simplify the install of the following software packages
used by Video Optimizer.

Note — On Apple silicon, brew will install software at /opt/homebrew/bin
MacFuse

Required for retrieving HD video from iOS device

Libimobiledevice and ifuse for macOS

Required for obtaining HD iOS traces. Note - With Apple silicon(M1/M2)
Macs, the default path has changed.

There are differences in the installation approach for Intel and Apple
silicon (M1/M2) architecture machines. Please find a script below that will
help you with the installation.

https://raw.githubusercontent.com/attdevsupport/VideoOptimizer/master/vo
dependency installer.sh

(To save the file locally, once the file opens in the browser, right click and
click ‘Save as’)

3.1.2. Android Prerequisites

To collect a Video Optimizer trace on an Android device, you must have the
following:

1.

PC, Mac or Linux computer along with Android SDK installed (for ADB
control of device).

Android device running 6.0 or higher.

Android SDK (Level 24 or above)

Install SDK Platform Tools for using Video Optimizer.
Windows path

Add the locations of these components to your windows path:

¢ Start Button>Computer>System Properties>Advanced
system settings>Environment Variables
Scroll down System variables to “Path” and select Edit
¢ Add the paths to adb.exe, ffmpeg.exe, ffprobe.exe,
wireshark.exe to the end of the existing Path.

ADB path set in Preferences dialog.

3.2. Collecting a Video Optimizer Trace

Collecting a trace works similarly for all devices. Simply connect the device to your
computer and open the Video Optimizer application.
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Step 1. Select Start Collector from the Data Collector menu.

[ AT&T Video Optimizer
File Profile Tools View Data Collector Help
Best Practices/Results Qv Start Collector... | Statistics Waterfal

Stop Collector...

’AT&T Video Optimizer Best Practices Results

( Date: Feb 23, 2021 02:10:07 PH
| | NON | Start Collector
Select a device: ?
State 0s API Model Device Name
Available 11 30 SM-N981U samsung-sm_n981u-R3CN403L7DT
Collector Type: Rooted VPN  © iOS
Attenuate: © None Slider Profile
Secure: Yes © No
Record Video: © Low Res (1-2 fps) HD SD No Video
Description
Target App

App Producer
Trace Type

<>

App Selector

Please enter trace folder name

Concel (S

Step 2. Select a Device in the Start Collector dialog. Video Optimizer will discover all
iOS and Android devices connected to the computer. Figure above shows
that two devices are connected: an iOS device and an Android device, with
State, OS, API, Model, Device Name is detected.

Step 3. Select the Collector Type. The recommended setting is VPN, especially for
an Android device that does not have root access. Other collector types are
available for Android devices that are rooted.

Step 4. Optional: Select an Attenuate option. This lets you reduce the throughput of
the network connection, allowing tests on networks with lower bandwidth
profiles (for more information, see the Network Attenuation section). In the
Figure above Attenuation is not selected, so it is not being used.
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Step 5.

Step 6.

Step 7.

Step 8.

Step 9.

Optional: Secure collection is available on Android versions 6.0 — 14. Select
Yes for Secure if you want Video Optimizer to decrypt HTTPS traffic —
providing you with a more thorough analysis of the traffic transmitted during
your test. You will be prompted to install a certificate if this is your first time
using secure collection. On subsequent tests, you do not need to install the
certificate.

Secure: £ Yes No Install Certificate

Select a Record Video option. Depending on your device, there will be two or
more options available for recording the screen while you are collecting Video
Optimizer data.

o Low Res:1-2 frames per second. Advantage: Smaller video size

o HD: 8 MBPS, 1920x1080.
Note: This will generate very large video files. Generally, you should only
use this format for short traces. If HD video record fails, it may indicate that
there were not enough system resources, so try with SD or Low-res
settings.

o SD:SD video 3MBPS, 960x540 video — for a smaller size (but lower
quality) video.

Click on the arrow button to add further trace collection details —

Description — add a description of the trace activities

Target App — the app that is being tested

App Producer — the details about the app producer

Trace Type — ex: video streaming, live video, downloading, browsing,
etc

o App Selector — helps select the app that you want to target the
collection from.

O O O O

Note: additional trace details can also be added at the end of the trace, or
after opening a trace for analysis.

Type a trace name in the “Please enter trace folder name” box. This is where
all the trace files will be stored. Spaces and special characters are not
allowed and if you pick an existing name you will be asked if you want to
overwrite the previous trace.

Click Start to begin collection on your device after you have selected the
appropriate parameters or click Cancel to prevent a trace from being run.

Step 10. iOS Only: Video Optimizer will prompt you to enter the OS password, this is

required to start the traffic capture utility.
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: @ @ Video Optimizer
1Enter sudo password for Video Optimizer Analyzer to perform some important functions:

1 |

]

| —l— Cancel
i

If you get any unexpected error messages when starting an iOS trace, it is
likely that one of your dependencies is not installed correctly. Please
download the following script and run it to correct your dependencies —

https://raw.githubusercontent.com/attdevsupport/VideoOptimizer/master/vo
dependency installer.sh

(To save the file locally, once the file opens in the browser, right click and
click ‘Save as’)

Step 11. Android Only: First time when vpn collector is installed on the device,
following pop up is displayed to the user to grant permissions. Choosing “Yes” will
grant the permissions automatically. Clicking on “No” will display all the permissions
on the device and user must manually allow all the permissions.

The VPN Collectar requires the following permissions to work correctly:
ACCESS_COARSE_LOCATION

ACCESS_FINE_LOCATION

BLUETOOTH_COMMNECT

CAMERA

READ_PHOME_STATE

READ_PHOME_MUMEBERS

READ_CALL_LOG

READ_CONTACTS

POST_NOTIFICATIONS.

Would you like to autematically grant these permissions during application install?

Yes MNa

Stepl2. Android Only: When collecting a trace from an Android device, you may
see a security popup message about exposing sensitive info during
casting/recording. This is just a reminder that any sensitive information revealed
during the trace will be included in the recording. Your trace recording will only be
stored on your computer and will not be sent or stored anywhere else. You will need
to click Start now in order to proceed with gathering a trace.

If the app is installed for the first time, android may pop up an alert like in the screen
shot below. This is a feature from Google to scan applications for security issues.
User can choose to send.
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® Google Play Protect

Send app for a security
check?

@ VPN Collector

This app is unknown to Play Protect. To protect
yourself and others, send it to Google for a
security check.

Always send unknown apps
Send this time

Don't send

A 4

Note — The following VPN Collector icon is installed on the device when the
collection is started —

YPN Collector

3.2.1. Collecting a HD Trace: iOS Specifics (i0OS 12 and above only)

iOS 12 added the functionality to be able to record the device screen. We now
have a companion app, capable of pulling the recorded video off the device as
long as the user requests it. The following section details some additional steps
that must be done to collect a HD video on an iOS device.

° Enabling an iOS Device for Development

If you haven’t enabled Developer settings on your iOS device, this
section details how to do that. This needs to be done only once.

1. Connect the iOS device to the Mac computer.

2. Open XCode and from the Window menu >select devices and
simulators.

3. Select the connected device from the list of devices in the left nav.
4. Click Use for Development.

5. Click Cancel when you see a prompt to join the “Apple developer
program and login with a paid developer account.” (You do not need
a paid account to continue.)

Note: Always start XCode before you start Video Optimizer so that
you can see that the device is detected and ready to use.
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6. When the device is enabled for development, you will see a
“Developer” option on the Settings menu of the device.

. Collect iOS HD Video

1. Attach the iOS device, that you want to collect from, to the Mac.
2. Launch Analyzer>Data Collector>Start Collector
3. Choose HD>Enter trace name>click start

4. On the Analyzer validate for the instructions pop-up message for
user to start screen recording

D Start Collection

Start the screen recorder on the device.
= You can reach the Control Center by sweeping up or down depending on your device

5. Continue to test the application for HD on the iPhone.

6. Click stop on live screen capture or on the Analyzer>Data
collector>stop collector.

7. Stop Screen recorder on the device

] Stop Collection

Stop the screen recorder on the device connected as well

8. Trace summary is displayed. Enter the optional metadata
information.

9. Click open.
10. Validate that the video played in the video viewer is played in HD.

3.2.2. Collecting a Secure Trace (Android steps, up to Android 14)

The Video Optimizer android collector can do an MITM based capture of
secure traffic. This requires a user certificate installed on the phone on which
the trace is being captured. Following are the steps to be followed to capture a
secure trace.

Step 1. Install a certificate (required on first test)—if you have selected a
secure trace and have opted to install a certificate. Choose the VPN
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and apps (not Wi-Fi) option for Certificate name on your device and
select OK.

Certificate name

Certificate name
ARO Cert

Used for
Wi-Fi -

CANCEL OK

Step 2. Select OK to allow the VPN connection to start on the device—when
the trace is started, Video Optimizer installs a collection app on the
device. The app establishes a VPN connection and requests
permission to allow the connection.

Note: The VPN connection is a connection to nowhere. It originates
and terminates on the device. All packets flow through the network
normally.

. Secure collection: certificate install instructions for Android

Starting with Android 11, user must install the certificate manually on
the device by following the instructions given in the pop-up below and
follow the screenshots:

Video Optimizer *

ﬁ Changes starting with Android 11 requires that users have to manually install certificates from device settings.
On your device please navigate to Settings > > Install a certificate (Encryption & credentials) == CA certificate.

Proceed te Install the certificate placed in Internal Storage > > AROCertificate folder of the device,
L ]
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138 @

€ Security

Pixel Imprint
Tapic

Smart

e admin

136 @

€ Install a certificate Q

CA certificate

VPN & app use

Wi-Fi certificate
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Encryption & credentials

5640 136 @

nstall anyway

A

Your data won't be private

CA certificates are used by websites, apps, and
VPNs for encryption. Only install CA certificates
from organizations you trust.

If you install a CA certificate, the certificate owner
could access your data, such as passwords or
credit card details, from websites you visit or apps
you use - even if your data is encrypted.

© 5640
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@\ ]E ) 11:37 @

3% @ < Trusted credentials

=  AROCertificate

© 5G4

Security certificate
ARO

Issued to:

Common name:
ARO

Organization:

Organization:

ATET
Organizational unit:
Certificate Authority

Validity:

May 10,2015

Note - For Samsung devices, the user is prompted to save the
vocert.pem file in the Downloads folder. Once the file is saved,
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navigate to Settings->Biometrics and security->Other security
settings->Install from device storage->CA certificate->Install anyway-
>Download->vocert.pem. The user is then displayed a message that
the CA certificate is installed.

After following the above steps click ok on the Analyzer information
pop-up window and the following screens will appear on Analyzer and
then on device.

On Analyzer: First Time collection
¢Video Optimizer X

=% The VPN Collector requires the following permissions to work correctly:
ACCESS_COARSE_LOCATION
ACCESS_FINE_LOCATION
BLUETOOTH_CONNECT
CAMERA
READ_PHOME_STATE
READ_PHOMNE_MUMBERS
READ_CALL_LOG
READ_CONTALTS
POST_NOTIFICATIONS.
Would you like to automatically grant these permissions during application install?

Yes MNo

On Device:

= 56:40

Install CA certificates in Settings

This certificate from VPN Collector must
be installed in Settings. Only install CA
certificates from organizations you trust.

Close

The following VPN Collector icon will be installed on the device when
a secure collection is started —
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VPN Collector

3.2.3. Collecting an Attenuated Trace

Video

Optimizer can attenuate a trace collection, restricting the

upload/download speed of traffic flowing through the VPN/MITM.

Android Attenuation

When you collect a trace, you can add a network throughput cap for
uplink or downlink, set in KBPS. This will limit all data traffic on the
phone to a maximum data throughput. This is a useful way to test
your mobile application in a network constrained environment;
perhaps at a busy sporting event, or in a country that does not yet
have a LTE network.

When you are collecting a trace, the default attenuation setting is
“‘None,” meaning that no attenuation is performed by default.

s | D
E Start Collector X =

Select a device: ?
State 0s APL Model Device Name
noabe i 5 Pewss s

Collector Type: Rooted (@ VPN

Attenuate: @ None (7) Slider () Profile

Secure: Yes (@ No
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Static Attenuation
Step 1. Select Slider from the attenuate options.

8 Start Collector X

Select a device: ?

Onone @ 5ide O Profile
|

Cloownink ¢ T
At t 4G 36 26
100 Mbps
|
Clupink 4 W
4G 36 26
100 Mbps
Secure: Qves @MNo
Record Video: OlowRes (12fps) @HD (OsD (O Novideo
Video Orientati (O Portrait @) Landscape

Description

Target App.

App Producer

Trace Type

App Selector -

Please enter trace folder name

Step 2. Select Downlink to lower the throughput of the
packets being downloaded from the server or
select Uplink to lower the throughput of the
device uploading files to the server.

Step 3. Set the speed to 4G, 3G or 2G on the slider. A
value between 3G and 2G will allow tests on
“slow 3G.” Video Optimizer sets the attenuation
value that you selected as the maximum
throughput available for the entire test. Note: If
you set a maximum throughput value that is
higher than the actual speed of your network, you
will not see an improvement. Video Optimizer
attenuation will only SLOW the network
throughput — it cannot enhance the speed of your
network. If your phone is on a slow network, and
attenuation is set to 4G, it will still be a slow
connection.

Dynamic Attenuation

The Attenuate feature in Video Optimizer is a useful way to
test how apps and video behave in a constrained
environment. But when you are testing mobile video, it is
also interesting to consider how changes in network
throughput affect a stream that is in progress.

When network changes occur while a video is playing, the
player may change the bitrate of the video to ensure that
the video buffer remains full — because when the buffer is
dry, the video will stall. It may request multiple versions of
the same segment — yet only play the highest quality
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segment received. Understanding how your video stream
behaves in changing network environments is the best way
to understand and prevent stalls from occurring.

The dynamic profile option allows you to change the
network speeds while the trace is running. Now you can
test your app or video in changing network conditions (that
you can control and re-use systematically and in a
repeatable manner). Video Optimizer Library folder-
>Default_Profile file has been updated with an additional
Packet Latency parameter (in milliseconds) in the end of
each line for Dynamic Attenuation which is accounted in
VO while taking a collection.

Step 1. Select Profile from the attenuate options.

Noe () Sider @ rofie
Altenuate: X :
Load... SC:\Users:_,,ai\lideoOptimizerlibrary\DelauIt_ProﬁIe.txt

Step 2. To modify the default profile, you can create
your own script file—just modify the
default_profile.txt document in a text editor and
save with a new name.

Step 3. The format of the text file is comma delimited, with
4 entries per line: time in seconds, downlink in
KBPS, uplink in KBPS & Latency. 102400 KBPS
indicates “no throttle” in that time frame.

Step 4. For example, in the figure below, the first 20
seconds of the trace, throttling begins at 6144
kbps downlink, 1024 kbps for uplink and 0 ms for
latency. After that, next 20 seconds, throttling
adjusts to 5120kbps for downlink, 1024 for uplink,
and 50 ms for latency.
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| Default_Profile.txt - Notepad

File Edit Format WView Help
28,6144 ,1024,0
2e,5126,1624,58
28,4096,512,108
Pe,zer2,-1,15a
[28,2048,1024,2006
re,l1e24,512,258
2e,-1,1824,360
2e,2e48,512,166
28,4096, -1,75
2e,6144,1624,58
e, -1,-1,25
2e,1096,2018,0

. iOS Attenuation

Starting with Catalina and above, user must use a LAN or an iOS
device for setting up the hotspot connection.
Note: Previous mac OSs allowed any source of hotspot connection.

Following are the steps to setup the environment on MAC.
Step 1. Choose Apple menu > System Preference, then click

Network.
Step 2. Select Ethernet (wired) or the USB tethering for network
connection.
[ ] < HH Network Q
Location: Location (4/16/18, 3:58 PM) ﬂ
L ("i‘?,’,‘,f .e:.d Status: Connected
Nexus 6 Is currently active and has the IP
Wi-Fi — address 192.168.42.147.
Self-Assigned IP -
@ Bluetoath PAN 8 Configure IPva: Using DHCP B
@ iPhone USB . IP Address: 192.168.42.147
Hot connected Subnet Mask: 255.255.255.0
P Thunde...It Bridge

Not Connected Router: 192.168.42.129
DNS Server:

Search Domains:

T Advanced...

Step 3. Turn the Mac Hotspot on.
Step 4. Choose Apple menu > System preferences, then click

Sharing ® , open Sharing preferences if it isn’t already
open.
Step 5. Select the internet Sharing checkbox.
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Step 6.

Step 7.

Step 8.
Step 9.

Step 10.

Video Optimizer User Guide

Click the “Share your connection from” pop-up, then choose
the Internet connection you want to share.

Select the type to share your internet connection in the “To
computers using” list.

- ry

Are you SUTe you want to turn on
Imernet shareg T

B e e e el R e W]
e R e Eaaaiad
ey

oVDe X

[ Coreet |

- ta e

Sensa 88 C e
-y —

Voo Srarng

Printer Sharing T par COnvesan o

Rerate Log -

et Varagemet b aonncbacy <

Rerarte Apge | ety

et Lherng

Buscorr Darng

Cormet Cactvng

Select Wi-Fi.

If your Internet connection and your local network use Wi-Fi,
sharing your internet connection disrupts the network.
Observe on the Mac, the internet sharing icon is seen in the
Menu bar.

% SystemPreferences Edit View Window Help & &

ile Profile Tools View Data Collector Help

Following are the steps to setup the environment on wi-fi on iOS

device:

Step 1.
Step 2.

Step 3.
Step 4.

Step 5.

Go to settings>Wi-Fi. Turn on Wi-Fi and Airplane mode.
For wi-fi: select the Mac computer shared hot spot from the
listed networks, then enter the password, if required.

Adjust the settings for a Wi-Fi network: Select the more Info
button next to a network. Set up a HTTP proxy.

Set Proxy: Enter the IP address of the Mac computer
Hotspot and port number is “8080”

Depending on the device make sure the wi-fi and air-plane
mode are enabled and displayed.

3.2.4. i0S Secure Collector

Introduction:
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Video Optimizer iOS collector can be used as a man-in-the-middle HTTPS
proxy, enabling you to view the communication between web browser and SSL
web server.

Video Optimizer does this by becoming a man-in-the-middle. Instead of your
browser seeing the server’s certificate, Video Optimizer generates a certificate
for the server and signs it with its own root certificate (the Video Optimizer CA
Certificate). Video Optimizer receives the server’s certificate, while your
browser receives Video Optimizer’s certificate. Therefore, you will see a
security warning, indicating that the root authority is not trusted. If you add the
Video Optimizer CA Certificate to your trusted certificates you will no longer see
any warnings — see below for how to do this.

Video Optimizer still communicates via SSL to the web server. The
communication is SSL (encrypted) from web browser to Video Optimizer and
SSL (encrypted) from Video Optimizer to the web server.

Connection Set-up for Secure Trace:
Pre-Requisite- MITM Proxy setup
->Navigate to Menu>Start collector to launch the start collector window.

->0n the start collector window Secure(yes) should display MITM status with
Internet Sharing Status, Server address IP and server port and then enter a
valid trace name and then click start. Refer to the screenshot below.

Select a device: ?
State 0s APl Model Device Name
Available i0S 12.1.2 iPhonel0,6 ARO’s iPhoneX
Available 7.1.1 25 Nexus 6 motorola-nexus_6-NP5A340052

Collector Type: Rooted VPN (e i0OS

Attenuate: ® None Slider Profile

Secure: * Yes No

Record Video: * Low Res (1-2 fps) HD SD No Video

Please enter trace folder name

Cancel Start

Attenuation Status

Please make sure Mac WiFi sharing is turned on, and the iOS device is connected to the WiFi before proceeding.

ol 2
.:__o Internet Sharing Status: true
Server IP address: 192.168.2.1

Server Port: 8080

—~>Navigate to Safari and type in IP address 192.168.2.1:9091 to install the SSL
certificate on the phone.
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wl ATET = 2:09 PM 100% 14 all ATET = 2:09 PM 100% b4

Cancel Warning Install Profile Installed Done

UNMANAGED ROOT CERTIFICATE

Installing the certificate "Video Optimizer” will @ Video Optimizer
add it to the list of trusted certificates on your
iPhone. This certificate will not be trusted for

. " o . Signed by Video Optimizer
websites until you enable it in Certificate Trust Verifisd
Settings.

Contains Certificate
UNVERIFIED PROFILE More Details

The authenticity of “Video Optimizer"” cannot
be verified.

->Navigate to settings>general>Profiles and Device Management to verify that
Video Optimizer is present in the configuration profile and click on it to see that
the certificate is verified.

Wl ATET = 2:09 PM 100% § all ATRT F 2:10 PM 100% [ +

4 Profiles & Device Management £ Back Profile

CONFIGURATION PROFILE

Video Optimi
@ Video Optimizer ideo Optimizer

by Video Optimizer

Verified v
DEVELOPER APP

tains Certificate

© CE—

Remove Profile

- If you are on iOS 10.3 or higher, open the Settings>General > About >
Certificate Trust Settings, and find the Video Optimizer Proxy certificate, switch
it “ON” to enable full trust for it.
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Root Certificate

Warning: enabling this certificate for
websites will allow third parties to view

any private data sent to websites.

Cancel Continue

->Open Safari or Google to validate the certificate.

->0n Safari following screenshots display the method to validate secured

» 2:29 PM 99% -
& google.com (&
= AL IMAGES i Sign in

@ AirDrop. Tap to turn on Wi-Fi and Blustooth to
share with AirDrop.

. [ress——
. A Wi -
3 ‘Z - s O 8 :
Sports !
Message Mail

Reminders  Add to Notes.

A= Q

Add to
Home Screen

Certificate Find on Page

Request
Desktop Site

@ Unknown - Use precise location
Cancel

& @ o)

—>0n Google click on the lock symbol to validate that the connection is secure.
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www.google.com

Connection is secure

Your information (for example,
passwords or credit card numbers)
is private when it is sent to this site.

Chrome verified that Video

Optimizer issued this website's
certificate.

Learn more

Testing your Application

Now that the Video Optimizer is running on your mobile device, you can run tests on
your mobile application or website.

When testing your application, use your app like a typical user. Test logging in, or other
common use cases. Follow general test cases that you may run on each build to
ensure that the application functions properly.

Note: All the data transmitted during your test is being recorded, and the screen may
also be recorded if you have chosen to record video. Please only use test data while
using the Video Optimizer, or your private credentials will become available to anyone
who has access to the trace.

Ending the Trace

When you have completed the Video Optimizer recording, use the following steps to
stop the trace, confirm that the trace files have been pulled to your computer, and
begin your Video Optimizer analysis.

Step 1. Stop the trace in one of the following ways.

a. If you are collecting video: Click the stop button on the video viewer (as
shown in Figure).

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.

Video Optimizer User Guide



=,
—

AT&T Entertainment Experience Suite Video Optimizer User Guide

°® Live Video Screen Capture
'\l b4%E 09:30

| Elapsed Time: 00:00:00 O so
| stop
.

b. If you elected to not collect video: Stop the trace using the Stop Collector

option on the Data Collector menu (as shown in Figure).

8 AT&T Video Optimizer
File Profile Tools View Data Collector Help

Best Practices/Results O Start Collector... | Statistics Waterfall
Stop Collector...

[ AT&T Video Optimizer Best Pra

Step 2. When the trace collection is stopped, the files will be pulled across to your
computer. The trace will be saved by default in the VideoOptimizerAndroid /
VideoOptimizeriOS trace folder depending on the device used.

ne>ervices : 7.u
tzon : 8.6.1.200

glePlz @ Video Optimizer
tzonV
s Stopping Data Collector. Please wait...
orola
T ————
T LTE
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Step 3. Once the files have been pulled across (this may take a while if you recorded
HD or SD video due to the large file size), the Confirm window is displayed
(Figure). The fields under the Additional notes section are editable and you
can enter further details about the trace. You can use the Notes section to
add details about the trace being collected. Next, you can open the trace in

the Video
trace.

Trace Summary
Path :

Dwration :

Trace has Video :

4 Additional notes:

Target APP
Video Mame
URL
MNetwork

Motes

Optimizer analyzer or click “OK” to continue without opening the

ClUsersiois SWideoOptimizerAndroidW 0525

00:02:18

‘r’es

Test
Test
Test
5G

This is atesttrace.

Step 4. The trace folder contains a file called environment_details.json which records
the environment when the trace was taken. This file is created when the trace
is launched. It displays the following details —

Trace path — location where the trace is saved
Date & Time - Date and Time information with local time zone of
the trace
VO version — Video Optimizer version
Collector details —

o VPN version

o Xcode version

= dumpcap version
= libimobiledevice version

Platform

o Mac

o Windows

o Linux
OS version
Java version
voTimeZonelD — computer’s timezone 1D
voTimestamp — computer’'s UTC date
Device the trace was collected on-

o OS version

o Platform

o Rooted

o Timing offset
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deviceTimeZonelD - TimeZone of the device

deviceTimestamp - Date/Time of the device

timeDiff

locallpAddressList - includes both the IPV4 and IPV6

addresses from the networkinterfaceList plus the VPN

collector. (Populated on Android only)

o networkinterfaceList — includes the Network IPs for the
connected device. (Populated on Android only)

o VvolpAddressList - includes the IPV4 and IPV6 addresses for

the computer running Video Optimizer at the time of
collecting a trace.

O O O O

: "Ci\\Users\\ b \V:
v 15 16:19:45 PST 2
.5.0-SHNAPSHOT (buil

ptimizerAndroid\\ormmninng

.2022-11-12",

341",
"Bmerica/Los_Angeles”,

1

"platform™ : "Android",

: false,
" : "America/Los_Angeles™,

44:59ff:fe0b:afds", "10.103.25.185", "2600:351:9£07:1134:2939

: "rmnetl:",
00:381:9£07:1134:2939:327f:bb81:75B1"

" i "rmnetl:",

¢ "rmnet2:",

00:391:9£41:5££5:d31:940a:3b32:1890"

: "rmnet2:",

"devInterface” : "wlan0:",
"ipv" @ "ipve",
"address™ : "fef0::5a24:29ff:fedb:edid"

g ™poIphddressList™ : [ {

sInterface” : "Ethernet adapter Ethernet”,
"ipv" i “ipvd",
"address™ : "135.70.125.32"
oA
"devInterface” : "Ethernet adapter Ethernec”,

4. Analyzing a Trace

Video Optimizer will perform an analysis of your network trace, including the radio resource
and energy usage of the applications run during the trace. Video Optimizer works from
application traces gathered through its Data Collector to do the analysis.
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Video Optimizer provides the following:

* Visibility into radio resource and energy utilization.
» Benchmarking of resource efficiencies.

« Automatic diagnosis of application inefficiencies.

4.1. Opening a Trace

When you open a trace in Video Optimizer, the data is evaluated against a set of
recommended best practices. Video Optimizer looks at how your application (and
your server) is handling caching, how you are managing the network connections for
your application, how your app is using HTML, whether your app is treating data
securely, and how it is handling video streaming. Use the following options to open a

Video Optimizer User Guide

trace file.
a. Select Open Trace from the File menu to display the Open dialog box.
Lookin: | () Traces v 2 rEE
Q}l) \) 2012-06-13-10-38-09
My Recent
Documents
a7,
My Documents
L]
My Computer
o Net‘\:):rk File name: C:\Documents and Settingsiuser\DeskkopiTraces
Vbleces | Fles oftype:’ [atFics v

Select a trace folder and click Open. The trace files are loaded, and Video
Optimizer begins analyzing the data.

Note: The time required for Video Optimizer to complete the analysis depends
on the size of the trace. As soon as the analysis is complete, all the content
tabs in the Video Optimizer are updated with the analysis results.

Video Optimizer can recognize a folder which has one packet trace (.cap or
.pcap file) and one video file (.mp4 or .mov) and convert it to a Video
Optimizer trace folder. For example, if a pcap file was captured on an Android
device using the PCAPdroid app and a mov/mp4 file was created during this
capture using Screen Recording, and these files were placed in a folder, Video
Optimizer would be able to open this folder as a trace folder and perform video
analysis for this capture. Similarly, it would also work with pcapng files
captured if using the Wireshark app and a mov/mp4 file present in a folder.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.

Video Optimizer User Guide



((

AT&T Entertainment Experience Suite

Additionally, a folder with

Video Optimizer User Guide

just a packet trace and no video in it can also be

converted into a trace folder in the same manner.

b. Select “Open Trace with Time Range...” from the File menu.

A partial section of a trace can be opened and analyzed, excluding data
before a start point and eliminating data after an end point. This can be helpful
if there is unwanted data in an otherwise good trace. For example, if a speed
test was run at the beginning of a trace, but you don’t want the speed test data
included in your app analysis.

[ Time Range Setup

U Start analysis: 4.800

Configuration name:

Save

' End analysis: 57.800
Auto Launch: MANUAL 0

Save & Analyze Analyze Cancel

The dialog displays

e Frames from user’s device video (video.mp4 or video.mov).

¢ Time Range

o Start Analysis:

Slider - user can slide it or select it, then use left or
right arrow keys for fine control.

Text field - user can enter a value directly, image
gets updated after leaving the text field.

o End Analysis:

Slider - user can slide it or select it, then use left or
right arrow keys for fine control.

Text field - user can enter a value directly, image
gets updated after leaving the text field.
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o Configuration Name - Text field where the user can enter a name for
the time range. Naming is optional if user just wants to click on the
Analyze button to analyze the trace for the specified trace range.

e Auto Launch -

o Default — time range that is used to automatically launch
the trace.

o Manual — time range the user must manually select to
launch the trace with the specified time range.

e A button bar at bottom of dialog
o Save

= if no configuration name is specified, a popup
message - "Invalid: cannot be saved without a
name" is displayed to the user.

= saves any changes.

o Save & Analyze - Saves then continues with opening trace
with selected time range.

o Analyze - Analyzes trace with the displayed time range,
does not require a name, since it will not save a new
configuration or any changes if editing.

o Cancel - does not save changes or does not open a trace.

User will be able to scan/play through the video to set start and end time-
range.

If the start time is beyond the end time, the user is displayed an error
message.

il Message

o- Invalid: Time range is negative, start must be before the end

L Start analysis: 532.520 ] End analysis; 213.320

WARNING overlap Configuration name: Stream 1 Auto Launch; MANUAL v |

Save & Analyze Analyze Cancel
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Opening a trace with Open Trace with Time Range... that does not contain a
video.mov or video.mp4 will result in an Error Dialog displaying "Exception in
TimeRangeDialog: No Device Video file".

If time-range(s) already exist, they will be listed in the Time Range Chooser

dialog.

[ (& Time Range Chooser *

E Choose a line:

|* FULL 0.000 - 895.160 | .
Stream 1 16.800 - 213.320
Stream 2 276.040 - 311.040 _
Stream 3 354.120 - 465.640
Stream 4 488.640 - 659.360
Stream 5 672.480 - 758.720
Stream 6 828.960 - 896.527 - .

" Denotes the default time range Aad Bdit Deiste LAUNCR il Analyze based on selected range, otherwise, I no selecton will analyzs the whole trace]

Time Range can be added, edited, selected, or deleted. An entry, “FULL”, is
created at the top of the list as a Default and will display the complete trace
range, after user creates the first configuration. When setting a different entry
to be Default, any entry that was Default earlier will become Manual. At any
time, there can only be one entry marked as Default. If the Auto Launch
option for a time range is selected as Default, it will be marked with an asterisk
to denote the default time range. Any time range that is Default will be the
range used to open the trace in the future. Selecting a time range and clicking
on the Launch button opens a part of a trace specified by a time range.
Progress dialog will display a second line, detailing the time range being used
while opening a trace.

! Loading trace analysis results....

TimeRange: Stream 3 [354.120 - 465.640]
|
Note: If a trace has a Default entry and the user wants to bring up the chooser,
they need to use the menu, File->Open Trace with Time Range.

For traces that have time range set, and none of the time ranges are marked
as Default, the File->Open Trace, and the File->Open Recent menu options
display the following dialog to let the user know that this trace has time ranges
detected -
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and displays the chooser dialog to let the user choose the time range to

launch.

AT&T Video Optimizer Best Practices Results

Date :
Trace:

SUMMARY

Feb 23,2021 02:10:07 PM

Time Range : Stream 3 [354.120 - 465 640]
Application Name(s) : Version :
Data Collector Version : 4.0.12

Network Type(s) :

ATTENIIATOR Simulation

DEVIGE INFO

Device Make/lodel : samsung / SM-G85U

Display Resolution : PORTRAIT (Width : 1080, Height : 2400)
©OS/Patform Version : 11

14.95 minutes
118,069,339 bytes
117,567,035 bytes
291.71J (Energy)
METADATA

Trara hme

A new label "Time Range:" is displayed in the Best Practices/Results tab
summary section which lists the time range used for the trace/pcap/cap file

that was opened.

When time ranges are created, they are saved in a json file called time-
range.json in the trace folder. It will contain one or more time ranges. It will list
the details of the time range saved such as the Title, the time range type —
Default or Manual, the Start Time, End Time, and the Range.

[&f causers

-range.son - Notepads+

File Edit Search View Encoding Language Settings Tools Macre Run  Plugins

cHHBRa& sab/ o aplax|BE|I=

B logé4-spplcatonlog. 10 £3 | B 000048021_00045573

m_7000K_7000_complete_aeng-trimn

1 [t

2 E "timeRangeList" : [ {

3 "title" : "FULL",

4 "timeRangsType" : "DEFAULT",

5 "beginTims" :

6 "endTime" : 395 1¢,

7 "path” : null,

8 "range" : "FULL [0.000 - 895.160]"

9 o

10 "title" : "Stream 1",

11 "timeRangeType™ : "MANUAL",

12 "beginTime" :

13 "endTime" : 213.32

14 "path" : null,

15 "range" : "Stream 1 [16.800 - 213.320]"
ie A

17 "title" : "Stream 2",

18 "timeRangeType" : "MANUAL",

1s "beginTime" : 276.04,

20 "endTime" : 311.0%,

21 "path" : null,

22 "range" : "Stream 2 [276.040 - 311.040]"
23 o

24 "title" : "Stream 3",

25 "timeRangeType"” : "MANUAL",

26 "beginTime" : 2

27 "endTime" : ¢

28

29 : "Stream 3 [354.120 - 465.640]"
30

31 : "Stream 4",

32 "MANUAL" ,

33 g4

S

35

36 : "Stream 4 [488.640 - £59.360]"

If a time range is marked as default, Open Trace or Open Recent will open the
trace with the specified time range automatically or by default. If none of the
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time ranges are marked as default, the time range chooser dialog is displayed
so that the user can select which time range to open the trace with.

By deleting all entries or time ranges, the entire json file will be deleted.

C. Select “Open Pcap File...” from the File menu (instead of Open Trace) to open
pcap/pcapng trace files. These files allow you to view statistical and analytical
data for the trace based on the packet information in the file, but you will not
be able to view any video information in the Viewer and you will not see any
information for peripheral applications (i.e. GPS or Bluetooth). Note: If the
trace is too big to load due to the current memory setting then Video Optimizer
will quit and restart and present a dialog with options for the user.

Video Optimizer needs to create several folders while performing analysis.
When using the “Open Pcap file...” feature to analyze a standalone pcap or
pcapng file, which may not be in a Video Optimizer Trace folder, a dialog will
be displayed with options of performing the analysis in either a temporary or a
permanent folder. The new folder's name will be the name of pcap/pcapng file
without the extension. The new folder will be created at the same path of the
pcap/pcang file. The temporary folder will be deleted immediately after the
analysis. Tools->Edit Metadata option will be disabled, and the user will not be
able to save any metadata or any notes in the Trace Notes section. If the user
attempts to double click the notes area, it will display “Sorry, You cannot edit
or save notes on filename.cap, try reopening the PCAP and approve
conversion.” If permanent folder analysis is selected, the original pcap/pcapng
file is moved to the newly created folder. The user is able to save metadata
and trace notes when the permanent folder option is selected.

| £ Open PCAP File et

VideoOptimizer creates several directories and files while performing the analysis. In
order to analyze a PCAPF file, we need to create a new directory to avoid cluttering
your local system. The new directory will be created at the same path of the current

pcap file. The name of the new directory will be: ol

Do you want to retain the new directory after the analysis is completed by Video
Optimizer?

Mo Cancel

“Open Pcap File...” function remembers the location of the last PCAP file
opened. For any exports or images to be saved for the currently opened pcap
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file, the location displayed in the Save window is the same location where the
opened pcap file resides.

Open Recent: User has the option to open the recent 15 traces/files from
Analyzer which allows user to find the last few traces/files. File->Open Recent
menu displays the recently opened pcap, and pcapng files as well. If the user
had decided to create a folder when opening a pcap file, the Open Recent
menu will list the folder name in the menu. If a folder wasn't created, the
menu will list the pcap file including its extension to differentiate files from
folders.

8 AT&T Video Optimizer
File Profile Tools View Data Collector Help
Open Trace... cs Video Statistics Waterfall
Open Trace with Time Range...
Open Pcap File...
Open Recent... 3 F2u_Android_Airplane_3Videos_5G_SSoff_1
S MCUI_ATT_5G_SS_Android_Downloads Test2.pcap
Preferences... -
VO4p6B71TD1122 6
Print... IECTER Mac_Chrome_Mcombat1.pcapng
MultipleVideoApps
Bt VO4p6RelBIGTD123: \Chrome ; DEVIGE INFO
b STERIIIEE dmmns e PORTRAT . 144, o200
race: Fac "
Tone Range: ol VOSBSATD1013SecurelnstCert p 937848 btes [ o Version: 12
- PCAPdroid." Airplane_56_5$0ff_1 - C 850350 bytsa
|Appiication Name(s) : Version : roid. “Airplane_5G_5Soff_1 - Copy 57209 ) Enerey
Data Collector Version - 43| VO4p6eBT2ID1123: METADATA
Network Type(s) : 56 _Device2_MacOS_Scenario3_TC6_3_Redone nulation Trace type Streaming
i"""‘ef"ﬂme'm””‘ \qd T Device2 MacOS Scenario3 TC6.3 NA Device orientation:  PORTRAIT
rofile:
Secure: Fal 1_stall_108_133 NiA Targeted App -
. _VOD stall faraday1 Application producer : 1407
Trace storage : & _Device2_MacOS_Scenario3_TC6_2 T”*‘“_E source Manual .
Description:  This s 3 Fiasact TeSTWIth AIrplane mode SIH Stream saver o
Network 5G Sub-6
Trace Notes Greator ¢
This 13 a SyoReels test with Airplane mode. ~
Steps used to test
1. cle the oo
2. Start trace
B

Open Recent file: When user re-names any file which was opened and
displayed in the open recent file, the file name will be removed from list. The
file name will not appear in the open recent until the user re-loads the trace.
Also, user can re-name the trace with any special characters and load it in the
Analyzer. For error traces like, no activity in traffic file, or, there is no traffic file
in the trace, will not be shown in the open recent files. User can hover over the
open recent menu names and a tooltip will be displayed which will list the full
path for the traceffile.

4.2. Best Practices Results

Video Optimizer trace analysis starts at a high level, with the Best Practices Results,
and then it helps you to pinpoint the issue as much as is required to solve the problem.
The high-level views work well for executive readouts, while moderate digging might
be useful for a deeper dive, and for a deep technical understanding — you can dig even

deeper.
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B AT&T video Optimize

File Profile Tools View Data Collector Help

Best Pr /Results Overview D ics Video Statistics Waterfall

AT&T Video Optimizer Best Practices Results

DEVICE INFO

SUMMARY TEST STATISTICS

Date: Dec 3, 2022 013526 PM Suration” 03 minutas Device MakeiModel: Google / Pixel 6

Trace: VO4pERelBI4TD123SecurelnsiCert 1ol Data Transfermed 2107673 bytes | P1SPI3 ReS0IUON  PORTRAIT (Widn 1080, Height: 2400)

: - o OS/Platform Ve 13

Time Range : FULL [0.000 - 558.085] Total Payload Data 20,690,021 bytes atiorm Version

Application Name(s) : Version : Energy Consumed 1692.13 J (Energy)

Data Collector Version : 480 METADATA

Network Type(s) : 56 Sub-6 ) !

ypets) ATTENUATOR Simulation Trace tyne Browsing
Carrier Name / Cell ID: AT&T (108187408
profi ATeTLIE Dawn link Throttle NiA Device orientation . PORTRAIT
Tofile:
s gl Up link Throttle NIA Targeted App Chrome
ecure:

Application producer: Google
Trace source Manual

Trace storage : VO4p6RelBIdTD123SecureinstCert

Description:  This is a secure trace with the ARO cerlificate installed during trace collection Sl Regular
Network 5G Sub-6

Trace Notes Creator

This is a secure trace where the ARO certificate was installed during the trace collection.

The websites browssd were cnn.com, bbe.com, yahoo.com, api6.ipify.org, api.ipify.org, ve.ident.ms, vi.ident.me.

The top of the Best Practices/Results tab tells you some basic information about the
trace such as the date, trace name, and information about the device that was used for
the test. The trace name is clickable and when clicked opens the trace folder. It also
displays the details of the trace collected as entered by the user. Double clicking on
the Trace Notes section is a shortcut into the Metadata editor section to be able to
make changes to the trace information and trace notes. The Summary section reveals
a few high-level statistics recorded in the trace. Right below this is the Tests
Conducted section, which contains a summary of the best practices so that you can
quickly determine which best practices failed. The below screenshot refers to a trace
that is uploaded in the analyzer.
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A ‘N/A’ icon is displayed to indicate that a Best Practice is not applicable when a trace
does not have relevant data available for analysis. Refer the image below -

r,..;- File Download: Image Metadata

Q File Download: Image Compression
N/A) File Download: Image Format

rr File Download: Image Comparison

Generally, the Tests Conducted section of the Best Practices tab is the best place to
start to improve your application.

Step 1. Click on the text for the Best Practices test to go to a larger summary. A green
checkmark means that the test was successful, and a red x means that the
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Step 3.

Step 4.

Step 5.
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test failed. For example, here is a trace that failed the Duplicate Content best
practice.

0 Test: Duplicate Content
About: This test measures duplicate content. Excess duplicate content means that content was downloaded multiple times, which leads to slower applications and wasted
bandwidth. Learn more...
Results: Your trace had 32.4% duplicated TCP content. By reducing the duplicate content (9 items, 0.556 M of 1.716M total TCP content), your application will appear faster to
your customers.

File Size Count File Name

5797 4.000 /images/account/50/16/logo-c_3b1d17c7ef854c528a7b123f661e6f50.jpg ez
27239 3.000 /media/CtoFo4 LXEAAzuph.jpg

7190 3.000 /profile_images/1980294624/DJT_Headshot_V2_normal.jpg

2187 2.000 /profile_images/745768799849308160/KrZhjkpH_normal.jpg

2339 2.000 /profile_images/754406384461029377/iHSbVOAC_normal.jpg

Review the About section to learn more about this best practice. Review the
Results section for details about how to fix the problem. This example has a
table listing files that were sent multiple times including the count of
downloads and the file name.

Click one of the table entries for more information—every best practice table
will let you do this. In this example, you are taken to the full list of duplicate
content in the Overview tab, from which you may be able to determine the
time ranges or other details to figure out the issue.

Dugplicate Content Type Tione Fie Size (bytes)

View

ORICINAL FILE 111.894 5,797
OBJOUP_NOT_EXPIRED 111.907 5.797
ORIGINAL FILE 246.799 71,995 Save As

ORIGINAL FILE 267.349
[ORIGINAL FiLE
ORIGINAL FILE 267.402

ea... 7,190

27,23
2,187

Select a row in the table and click View to view the contents of the file. This
helps when a file name is obscure, and you don’t really know what the file is or
the type of content. The Diagnostics tab is displayed, and you can see the
request/response for the file.

fizooe}

st Name Content Tyoe: ‘Obyectame Content Lengh onwre HITP Compression

Click Content View to see the headers. In Figure, the top table shows the IP
and domain (pbs.twimg.com) indicating a request from Twitter's image
servers. The bottom table shows the request/response. In this example, the
file is coming from Twitter. Check the cache-control parameter in the
DOWNLINK header to see if the file has the correct cache headers. In Figure,
cache-control shows a max-age of 604800s—a cache timeframe of one
week—so in this application, the image cache may not be properly set to store
files locally on the phone.
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Request/Response View  Packet View ‘Content View

Host: pbs.twimg.com

-~DOWNLINK--
HTTP/1.1 200 OK
Accept-Ranges: bytes
access-control-allow-origin: *

cache-control: max-age=604800, must-revalidate
content-md5: noHHFp1HiF61I0K)sTbvlg==
Content-Type: image/jpeg

Date: Fri, 30 Sep 2016 20:36:06 GMT
Last-Modified: Fri, 30 Sep 2016 19:47:57 GMT
Server: ECS (sjc/4E93)

L b _iiM 1 iMAAAANAAFAAFY ANAT A

4.3. Private Data Tracking

The Transmission of Private Data best practice test allows you to examine all the
decrypted and clear text data files for leakage of private data.

Step 1. Select Private Data Tracking from the Tools menu.

8 AT&T Video Optimizer

File Profile Tools View Data Collector Help
Best Practice PCAP File Analysis... deo Flows
Time Range Analysis...

—
sul Auto FlowsTab Export...
Date Export Results.. 5 141210526
Trac Ex Session D [D3222024|
i port Session Data... 3-217235)
APl Edit Metadata..
Data
Netw Private Data Tracking...
Carrier Name 7 Cell IU: ATETTTUB187401
Profile: AT&TLTE
Secure: FALSE

Step 2. In the Private Data Tracking dialog, complete the fields that apply to your
trace.

e e Private Data Tracking
- Private Data

Calendar Event
Date of Birth
Phone Number

Email Address  soccerdad@gmail.com

Location
Password ILoveSoccerd2
SSN
fon -122.4
at 48.01
+ 13 Cancel
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Step 3. Click OK to analyze the trace for these values. A report will be provided for
you in the best practices tab. The Data Types and Data Values in Figure were
found in the Video Optimizer trace because they were entered in the Private
Data Tracking dialog.

0 Test: Transmission of Private Data
About: The transmission of private customer data is something that should be done with utmost case. In this trace, we found the following personal details being transmitted
during the trace. If you must collect private data, make sure that you are using HTTPS, and even better, encrypt the data before sending. Learn more...

Results: ARO discovered 7 transmissions that might contain private information. Examine these transmissions to ensure that you require this data, and that you are securing this
private data properly.

Destination IP Domain Name Destination Port Data Type ¥ Data Value

169.44.145.213 bootstrap.upsight-... 443 lon -122.4 el
169.46.12.93 batch.upsight-api.c... 443 lon -122.4

169.46.12.93 batch.upsight-api.c... 443 lat 48.01

169.44.145.213 bootstrap.upsight-... 443 lat 48.01

Step 4. Click one of the rows in the table to see the Diagnostics tab. The top table
shows the TCP stream and the bottom table shows the Request/Response

Time Byte Co... Packet C... Protocol
046 27 ] TCP 0.0
056 103 2 NS WA
062 263 2 DHS WA
064 156 2 DS WA
067 92 2 NS WA
260 9243 22 TP 0.001
26 132200 97 TCP 0.002
TCP 0.001

ont View Delay

Object NameyContent Langth On Wire

4.4. Video Analysis

Video Optimizer contains several functions to analyze the delivery of streaming video
in your mobile application. These specialized tools have some unique features that
require additional configuration.

When testing video, your trace should ideally be of a DRM free video, and the
application should allow screen recording. Video Optimizer can perform several
analyses without these two features, but the examples in this section are of a trace
with a DRM free video, and the recorded screen.

Oracle Java 8 is required if video analysis will include DASH manifests with encoded
segment list format otherwise any Java 8 and above will work.
4.4.1.Video Analysis Setup

Begin by opening a trace with video content in it, but before beginning analysis,
there are a few manual steps required.

Step 1. Select File>Preferences>Video.
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4.4.2.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Step 7.

Video Optimizer User Guide

| Cuarating - 44 4 rinut, |Disirn Mala®ladal - Canale | Divel &

3 Preferences X
General BestPractices Video
Warning Fail

Startup Delay (seconds) 5.000

Stall Duration (seconds) 0.500 1.000

Segment Redundancy (percentage) 15.0 25.0

Default

Targeted Startup Delay (seconds) 10.00

Stall trigger (seconds) 0,050

Stall Pause Point (seconds) 0.5000

Stall Recovery (seconds) 0.1000

Near Stall (seconds) 0.0100

Preferred Maximum Buffer (MBytes) 100.0

Duplicate Handling LAST ~

Save Only Save & Reload Cancel

Enter the Targeted Startup Delay in seconds. This is the KPI (Key
Performance Indicator) requirement for how quickly a video should
begin playing. The default is set at 10 seconds. A video that takes
longer to begin playing than the value set for Startup Delay will fail the
Video Startup best practice.

Enter the Stall trigger in seconds. The default value is 0.05s (50ms).
Stalls that are under the threshold value set for Stall trigger will not be
counted in the best practice. For example, the value in Figure means
that stalls under 0.05s will not be counted in the best practice.

Enter the Preferred Maximum Buffer. Video Optimizer measures the
amount of video stored in the buffer. Here you can set the max buffer
size (in MB). For example, the value in Figure denotes a 100 MB video
buffer.

Stall Pause Point - if a segment is late to arrive, the currently playing
segment must pause before it finishes playing, a value greater than 0 is
suggested.

Stall Recovery — estimated time it takes for a player to start or resume
playing once segments are arriving. A value greater than 0 is
suggested.

Click OK.

Configuration Required

From the best practices tab, user can set the start-up delay by clicking on the
icon of any of these three best practices - Video: Stalls, Start-up Delay, Buffer
Occupancy. Refer to the screenshot below —
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AT&(T Video Opti

2 Collector Help

werview Diagnostics Video Statistics Waterfal

Data Collector Version: 4366

Device Make/Model: Google /Pixel 6

Display Resolution: PORTRAIT (Width: 1080, Height 2400)
OS/Platform Version: 12

Network Type(s): LTE

Profile: ATETLTE

Secure: FALSE

N g
/: Test:  Stalls

Reauned] 95Urs When either a user's device or their network cannot keep up with a video file when streaming. This results in a total pause of video playback. Learn more..

Results: The actual startup delay has not yet been set Clickto set To change

goto File. Video

. ” A
/; Test:  Start-up Delay

About:  Streaming video requires a startup delay for smooth delivery. In order to manage buffer occupancy, it is importantto understand the startup delay and determine a way to coverthis delay for the user with messaging. Learn more...

Results: The actual startup delay has not yet been set. Clickto set Tochange go'toFile:

Video,

N
f" Test:  Buffer Occupancy

About:  Buffer occupancy is the amount of video stored in RAM to help prevent interruption due to transmission dslays, known as “buffering”. Leam more...

Results: The actual startup delay has not yet been set. Clickto set Tochange o0 Fil

4.4.3.Analyzing a Video

Video Optimizer will extract streaming video from the trace, when successful,
you will see the video stream table as in step 1 below. However, sometimes
there are video requests, but no streams showing, in such a case, the user is

displayed a message that ‘Video segments could not be assigned to a Video
Stream.’

Video Optimizer can handle Dash, HLS, MPEG, as well as Transport Stream.
For other video streaming you may need to use inferencing.

Step 1. Navigate to Video tab->Video Stream and choose a stream. You can

choose by using the checkbox or clicking the Set/Edit StartupDelay
button. The first stream is chosen by default.

Video Stream !
O] | sweams

segmentcounts0 | EdtSmposay | There is 1 segment gap Fvwke [ sudo Stanup Time:21.492
O 2] sream2 dm_210223_SVP._on_Tiger_crashiim_210223_SvP_on_Tiger_crash smilimaster m3ull segment count 10 | Set:

t Starisiely | Startup Time : 278317

O ] sweams 30354022 v-cir-OBI7: . HaBIET 1-CC506

m3ull segment count 22 | EdtStarhclelsy | [vdeo EJdudo Startup Time : 350.849

[+ Sreams:am_201215_susving_mutems._nonrandeq_ssnsomanicim_201215_ausiina_mutsme_nondranded_Ssnacrpant amimasier m3ug sepment count 17 | EONSaruo0sy | There is 1 segment gap SIarup Time : 499,031
[ 2] Sreams: sefiwensaosz200atest m3us, segment count 13 | SetSarupOciay | Startup Time : 696.928

O 4] sweamé 3086055318 10UVBO0SS31$10U3 m3uB, segment count 54 | Set Starkseler | Startup Tame : 834.841

Step 2. On selecting the stream, the Segment Throughput graph, the Segment
Progress graph, and the Segment Buffer graph are displayed.

Segment Throughpat

S NN N

- £ w W C "o w0
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The Segment Throughput graph displays the throughput for the video
and audio segments in the case of demuxed video and for the
segments in the case of muxed video. Hovering over each of the points
displays a tooltip with the following information — Segment #, Track #,
Download Start Time, Download End Time, Duration, and the
Throughput.

Segment Progress |
-

-

o L T
Dura [+ ViDED = 2UDIO & Vidso PlayTims - Audio PiayTime|

440 40 00 o a0 500

w VIDEO -+ AUBIO -+ Videa PlayTime < Audio PlayTime

Pragress : 78.000s
A3 | Content : VIDEQ

The Segment Progress graph displays the progress of the Video and
Audio segments. Hovering over each of the points displays the
following information - Segment #, Track #, Download Start Time,
Download End Time, Duration, and the Progress. The graph also
displays the Video and the Audio PlayTime. Hovering over each of the
points displays a tooltip with the following information — Segment #,
Track #, Play Start Time, Play End Time, Duration, Progress, and the
Content (Video/Audio). The Legend in the graph helps the user
differentiate between the various graphs. For a muxed video, there
would be just two graphs — the Download_Progress graph and the
PlayTime_Progress graph. Graph refreshes when each stream is
§elected.

Segment Progress |
-

= Download_Progress -e- PlayTime_Progress
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The Segment Buffer graph displays information about the playback buffer.
Hovering over the points in the graph displays the following information —
Segment #, PlayBack Buffer in seconds, the TimeStamp, and the Plays at
value. The graph refreshes when each selected stream has its startup

delay set.
” = el e e e D T e D e e T e T e
C i

Step 3.

Double clicking on the header of the Segment Throughput, Segment
Progress, and Segment Buffer graphs can expand/collapse the graph.
On hover over the headers, a tooltip is displayed to let the user know
about the same.

[ Segment Throughput
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Click on Set StartupDelay button in red which indicates that the startup
delay is not set or Edit Startup Delay in blue which indicates it was
previously set. If the video you tested was DRM free, the view will be of
the first frame in each chunk.

User input window is displayed.
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Stream4: Manifest Request Time: 493.967

Position slider to user touch event

e R T R
lUser Event type: SCREEN_TOUCH, Time: £67.145 5
lUser Event type: SCREEN_TOUCH, Tme: 658,167 5
|User Event type: SCREEN_TOUCH, Time: 669,613 s
lUser Event type: SCREEN_TOUCH, Time: 670.634 s
lUser Event type: SCREEN_TOUCH, Tme: 672,496 5
|User Event type: SCREEN_TOUCH, Time: 674.473 5
lUser Event type: SCREEN_TOUCH, Time: 759.222 5
|User Event type: SCREEN_TOUCH, Time: 761.574 s
|User Event type: SCREEN_TOUCH, Time: 763.710 s
|User Event type: SCREEN_TOUCH, Time: 758.704 5
|User Event type: SCREEN_TOUCH, Time: 780.103 s
lUser Event type: SCREEN_TOUCH, Time: 781.350 ¢
|User Event type: SCREEN_TOUCH, Time: 783.219 5
|User Event type: SCREEN_TOUCH, Time: 784.308 s
lUser Event type: SCREEN_TOUCH, Time: 789.203 ¢
|User Event type: SCREEN_TOUCH, Time: 792.136 5
|User Event type: SCREEN_TOUCH, Time: 794,455 s
lUser Event type: SCREEN_TOUCH, Time: 795.610 ¢
\User Event type: SCREEN_TOUCH, Tme: 808,299 5
|User Event type: SCREEN_TOUCH, Time: 810.119 s
Iser Fuent hne: SCRFEN TOUCH. Time: 81116 &

493.042 - +

Position slider to video startup time
Segment: 0, Tradc 2, DL Time Range: 498.530 - 498.931, Play: 569.520

] 569.520

Cancel

In the above image, user events and video start up time are displayed.
Selecting an event or segment will highlight the entire line and only one
event or segment can be selected at any time. If there are no user
events in the trace, then the user event area will be collapsed. If there
are no segment thumbnails, then the segment thumbnail area will
collapse.

In the User Touch Event section, navigate through the touch events
viewing the simultaneously changing frame images on the right-hand
side of the dialog to choose the time stamp of the precise video
playback requested time. The time chosen should be before the
Manifest Request Time displayed at the top of the window and less than
the time range found in the first segment. Enabling the Settings-
>Developer Option->Show Taps option on an Android device helps with
the identification of the precise video playback requested time. Next,
position the slider in the Video Startup Time window to a point where
the video startup time is greater than the arrival time of the first
segment. The arrival time is the second number in the highlighted Time
Range. In the example above its 498.931. Click Set.
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Video Stream '

O 4] sweams. ss2anes 2 ¥ 79 | Setsiwicossy | Fwke Flao

D0 4] Stream2 am_210223_SVP_on._Tiger_crashtdm_210223_SVP. on_Tiger_crash amilfmasor m 3.8, segment count 10 | 5=l Sarhgbay

O ) streama disneyf 2. OG0T 450387 o1t i 9670 138, segment count 22 v [ Aude

B x| sreamd dm_201216_a: nonbranded_: 0m_201216_susving_muieme_nenbranded._sahaorpant

aster m3u8, segment count 17 Startup Time : 560,52

Segen Toack Choin | Revottion | Bitrate | TotatBrtm Sagevess Foniion Duaation DL Start Tione DL Ené Time Faback Tune St Tume TCP Samicn
Ripa)
9 W 3 W W ) W Co X () 3
1 MK 2 m s o 0 514 - o a1
i I 2 ™ 100 Ex) 504,04 5w () =387
2 7 | mm| 2 70 a5 w0 o sa0.087 0.5 o 87
2 s | mae 2 a2 a0 20 0.0 7,088 ) gy
MED T %08 20 0.0 25,704 e
M 2 ™ e EX) 50,252 52 w0 35
A 2 ™ %% 0 0.0 7878 ons2 () 867
MK 2 e 00 0.0 sm.am 1852 () sman
s 7 mm 2 ™ W &0 0.0 58,719 .52 o 137
7 7 | mae 2 ™ s 0 0.0 00,25 .8 () 53887
MAED 2 ™ A 0.0 = ena [ s
a2 ™ 0.0 1903 sz w0 5
0 M 2 ™ s 1000 0.0 630,115 652 [X) 67
1 MK 2 ™ am .0 0.0 063 .52 [X) =107
2 M 2 ™ Wz 1m0 0.0 Esa.104 .52 () 1387
3 7 | mee| 2 ™ % 0.0 0.0 652328 s () 5887

D) _+| Svesma snvesvaezzorsest miue, sepmen

[ 4 Steame 30100553:910U3B0055318100/2 m3u8, segme

Initially video streams will have an estimated start time. These will show a
red StartupDelay button. You can set the actual startup delay by clicking
this button, the button will become green while using the dialog and
becomes blue once the set button has been clicked.

Step 4. Once the Startup Delay has been set for a stream/streams, the values
for the Play requested time and the startup time are saved in a file called
video_stream_startup.json which is saved in the trace folder. Subsequently
when the trace is opened at any time and the startup delay must be set, these
previously set values are displayed when the Startup Delay window opens for the
stream. A validationStartup field displays the following -

e USER - User has set the startup delay

e ESTIMATED - VO estimated the startup, user has not set startup delay
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5 video_sream_starup json £ |

r }
bod

r }
o

"y

r }
bt

.

"manifestRegTime" :

: "30/B005531910U3/B005531910U3.m3u8",
tup" : "ESTIMATED",

"releaseTime"

"pressTime"

"releassTims" : £595.715¢

"manifestName" : “dm 201216_ausvind muteme nonbranded sahaorpant/dm_ 201216 ausvind muteme_nonbranded_sahaorpant.smil/master.m3u8",

alidationscarcup”

"releaseTime"

anifestName"

3bdd-3039-4=2a2-9186-d66c07£2%abS/ regular-ctr—0bd0745c-a28£-4545-acd2-4c54fdaéicTl-cc59e194-c2bf-492e-bd3b-5%a8258€670al0.m3us",
"validationStartup” : "USER",
. 57.5

anifestReqTime” & 257.5,

If the default video analysis does not provide any results and a manifest
is available, then the CSI(Chunk Sequence Inferencer) feature can be
used for analysis. Adaptive Bitrate Streaming behavior and QoE
measurement and analysis is becoming challenging due to the increase
in usage of end to end encryption protocols like HTTPS and QUIC. CSI
helps here in inferring the ABR behavior based on packet size and
timing information that is available in the encrypted traffic. The CSI
feature in Video Optimizer is based off of research by Shichang Xu,
Subhabrata Sen, and Z. Morley Mao presented in the white paper “CSl:
Inferring Mobile ABR Video Adaptation Behavior under HTTPS and
QUIC”, 2020. https://doi.org/10.1145/3342195.3387558

To use the CSI feature, after loading a trace, navigate to Video tab-
>Video Stream, check the CSI checkbox and click on the Load button to
load the manifest.

o e ——— e ——]

Date b 05 172839 PST 2021 Metwork Type{s): e OS/Pration Version: android/ 11

VacaJ B open x i Gonge [ PIued 4 XL “Total Bytes: 58562311
n Look e [T FOCRREL @ ][] e
\ H™ML s 3 jsan
@, "
ems g { =

W oemme | =

Fles of type: Al Fies v Coreel

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.

Video Optimizer User Guide


https://doi.org/10.1145/3342195.3387558

=,
—~

AT&T Entertainment Experience Suite

Video Optimizer User Guide

This loads a video stream and allows video analysis based on

inference-

400 az5 a0

a7s
= VIDEO -~ AUDIO

Segment Progress |

a00 a5 280

|- VIDEC -8 AUDIO - Vidzo PlayTime - Audio PlayTime

Video Stream |

| Stream: WoodTurmBowlingBall, segment count 46 | _Set StartupDely | [ Video (7] Audio

A video_stream_startup.json file, which records the play requested time,
and startup time set, is stored even for CSI analysis when the startup
delay for the stream has been set. For subsequent analysis of the
same trace, when startup delay has to be set, it displays the stored
values when the startup delay dialog opens up.

When performing CSI analysis, if the manifest loaded is in a path
different from the trace folder, then a copy of the manifest file is stored
within a CSI subfolder for the trace folder. If the CSI manifest exists in
the root trace folder, then it is moved to the CSI subfolder. If the CSI
subfolder already has the manifest, then it is not copied again. If the
CSI subfolder already has an alternate manifest in it, the user is
prompted and asked if the existing files should be deleted. After the CSI
analysis is completed, the status of the CSI analysis along with the new
path for the manifest is stored inside of the CSI subfolder in a file
named CSlIState.json. Subsequent analysis of the same trace will
automatically lookup the stored CSI status and auto-analyze CSI.

Viewing Buffer Details

The Diagnostics tab shows the Playback Buffer (the seconds of video
stored locally) and the Buffer Occupancy (the KB of video stored
locally). Examine the Video chunks line closely—in Figure there is a red
line starting at chunk 1 and ending when the chunk appears on the
screen—in this case, around 569s. This allows Video Optimizer to
calculate if the video buffer runs out of video time or KB. When this
occurs, there is no more video to play, and a stall occurs to the viewer.
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Video Optimizer will use the startup occupancy found at the start to
estimate when the video will resume playing. Please note some
processing now happens in the background for video stream analysis.

As a result, you may notice the image of a thumbnail updating over
time.

° Getting Video Information

1. Move the pointer over a video chunk to determine when the
download started, stopped, played on the screen, and the number of
KB in the chunk.

- =
[ 1Fre-] 18-}
Segment No: &

DL Start Time: 321325 |
DL End Tirme: 32.930 5
Play StartTime: 59.590 5
Byte Size: 420:9.49 KB

2. Point to the Play Back Buffer and Buffer Occupancy lines for more
information about how much playback is stored in the buffer and how
much is used. In the Image below for segment 6, at 32.930, the video
buffer has 4.16MB of data, which contains 59.590s of video playback
time. These steps will also allow Video Optimizer to calculate the
data presented in the Video Best Practices.

Lt =
" — @
Segment No: 6
VIDEO Segment: 6 DL Start Time: 321325 |
Segment: 6 Buffer Size: 4.16 MB DL End Time: 32930 s
PlayBack Buffer: 1814 s [ ® 1o ocramn 32930 ¢ [~ |Play StartTime: 59.590 s
TimeStamp: 6147 s | |Plays at: 59.590 s Byte Size: 4209.49 KB
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4.4.4.Video Best Practices

The following are examples of the best practices in Video Optimizer. These best
practices are still very experimental and are simply providing information. As
Video Optimizer matures, these will become fully fledged tests with pass and fail
criteria.

y, . .
Y Video: Stalls

'x’ Video: Start-up Delay

'x’ Video: Buffer Occupancy

Video: Metwork Comparison
Video: TCP Connection

Video: Segment Size

Video: Segment Pacing

Video: Redundancy

Video: Concurrent Session
Video: Variable Bitrate

Video: Resolution and Perception

Video: Analyzing the Adaptive Bitrate Ladder

O 000006 OOOO

Video: Streaming Separate Audio and Video

. Video Conditions

1)There is no video in the trace

o [NA] across all VBP

o Response: No streaming video data found.
o no Stream

o Nno segments

o nourls
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WA Video: Stalls
","" Video: Start-up Delay
WA Video: Buffer Occupancy
Video: Network Comparison
WA Video: TCP Connection
N/A) Video: Segment Size
WA Video: Segment Pacing
N/A) Video: Redundancy
WA) Video: Concurrent Session
N/A) Video: Variable Bitrate
N/A) Video: Resolution and Perception
Video: Analyzing the Adaptive Bitrate Ladder
N/A) Video: Streaming Separate Audio and Video

—— =]

em [y

2)Video not handled in the trace

o [Config_Required] across all VBP (no analysis)

o Response:Video Optimizer was unable to analyze video stream
file(s) Hint: look for ways to locate Stream/segment information
with the Video Parser Wizard. Click here to select Request URL
<a href="selectStream"><b> Stream</b></a> on the Video tab

o no Streams
o no segments
o urls exist

3)There is only one invalid Stream created.
o [Config_Required] across all VBP (no analysis)
o Response: Invalid Streams. Video Optimizer did not have enough
information for analyzing streaming video. Hint: look for ways to
locate segment information with the Video Parser Wizard. Click
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here to select Request URL <a href="selectStream"><b>
Stream</b></a> on the Video tab.

o Stream - invalid

o segments

o urls exist

4)There is only one valid video Stream created
apply tests to all VBP for selected Stream only
o Stream-Valid

o segments

o urls Exist

O

5)There is only one valid Stream but de-selected video Streams
o [Config_Required] across all VBP (no analysis)
o Response: No Stream is selected. Please select a <a
href="selectStream"><b> Stream</b></a> on the Video tab.
o Stream
o segments
o urls exist

6) There are Multiple valid Streams
One selected

o [Config_Required] across all VBP (no analysis)

o Response: Please select only one Stream on the Video tab.
Click here to select a <a href="selectStream"><b>
Stream</b></a> on the Video tab.

o none selected

o [Config_Required] across all VBP (no analysis)

o No Stream is selected. Please select a <a
href="selectStream"><b> Stream</b></a> on the Video tab.

7) There are Invalid with valid Stream
o one Selected Stream
o apply tests to all VBP for selected Stream only
o ignore invalid Streams

8)There are invalid with valid Stream

o none Selected Stream

o [Config_Required] across all VBP (no analysis)

o Response: No valid Stream has been selected. Please select a <a
href="selectStream"><b> Stream</b></a> on the Video tab. Note:
There are invalid Streams detected. Video Optimizer did not have
enough information for analyzing streaming video. Hint: look for
ways to locate segment information with the Video Parser Wizard.
Click here to select Request URL <a href="selectStream"><b>
Stream</b></a> on the Video tab.
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5. Video Optimizer Reference

The following sections are a complete reference of the Menus and Content Tabs that are
available in Video Optimizer.

5.1. Menu
Video Optimizer has the following menus.
Menu Description

File Contains options for opening trace, opening Trace with Time
Range, opening Pcap File, Open Recent, Go To Recent
Folder, Preferences, Printing results, and Exiting the
application.

Profile Contains options for loading and customizing device/trace
profiles.

Tools Contains options for running a Pcap file analysis, running a
Time Range Analysis, Auto FlowsTab Export - exporting the
Flows Tab for multiple traces at a time, Export Results->HTML,
Json, Excel, Export Session Data, Edit Metadata, Private Data
Tracking.

View Contains options for displaying the video viewer, filtering the
set of data that appears in the analysis and diagnostics based
on application, IP address, and time range, and configuring
which data should appear in the Diagnostics Chart.

Data Contains options for accessing the Video Optimizer Data
Collector Collector.

Help Contains options for displaying the Video Optimizer version,
the FAQ page, User Documentation,
Dependencies, Support, Downloads, and other Help
documentation.

5.1.1.File Menu

File menu contains the following selections.
Selection Description

Open Trace Opens a file for trace analysis. When this menu item is
selected, a dialog box is displayed that prompts you to
select the location of the trace folder containing the
trace files. You must select a trace file using this
command before you can view the trace analysis of
that file.
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Selection Description
Open Trace Opens a part of a trace, with a time range. When this
with Time menu item is selected, a dialog box will open the
Range frames from the device video. User will be able to

scan/play through the video to set the start and end
time-range. If time-range(s) already exist they will be
listed in the chooser dialog. User can create, edit,
select, or delete time-ranges. The time-range will be
used to open the trace.

Open Pcap Opens a Pcap/pcapng file for packet data analysis.

File When this menu item is selected, a dialog box is
displayed that prompts you to select the location of the
Pcap/pcapng file. You must select a Pcap/pcapng file
using this command before you can view a packet
data analysis of that file.

Open Recent | User has the option to open the recent 15 traces/files
from Analyzer which allows user to find the last few
traces/files.

Go To Recent | This option lists the 15 recent traces opened. Click on
Folder... the trace name to open the trace folder without
opening the trace for analysis.

Preferences Opens a Preferences dialog where you can choose
the Best Practices that you want to analyze and set a
path for the Android Debug Bridge (ADB), Max heap in
GB and Logging level. User can also set the
preferences using the Video tab.

Print Prints the results that are displayed when the Best
Practices or Statistics tab is selected. This menu
option is only enabled when the Best Practices or
Statistics tab is selected.

Exit Exits the Video Optimizer application.

5.1.2.Preferences

This feature opens a dialog with three tabs available, General, Best
Practices, and Video. Select Preferences from the File menu. Select
the General tab.
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8 preferences K

i General! BestPractices Video

Max heapin GB 12.0
Adb Path >:'Program Files\SDK\platform-tools'adb. exe Browse
Wireshark Path | C:\Program Fies\Wireshark \Wireshark.exe | Browse

FFMpeg Path ffmpeg Browse
FFProbe Path  ffprobe Browse
Logging Level ERROR ~

Save Only Save &Reload Cancel

e Enter the Max heap in GB. Here you can set the
maximum memory heap size for Video Optimizer (in GB).
For example, the value in Figure above denotes 12 GB as
the heap size. If the total system memory is 8GB or greater
then you can choose from 2 GB to within 4GB of Full
memory. If the total system memory is less than 8GB then
the memory allocation allowed is up to 85% of total
installed memory. Only one decimal point value is allowed
and no letters/special characters are allowed. An error
message is displayed if the value entered is invalid or out of
range.

8 preferences X

General Best Practices Video

Max heap in GB | 13|
Adb Path :\Program Files\SDK'platform-tools\adb.exe Browse

Wireshark Path | C:\Program Files\Wireshark\Wireshark.exe Browse
FFMpeg Path fmpeg Browse
FFProbe Path ffprobe Browse
Logging Level ERROR ~

Invalid memory request. You have 16.0 GB of system memory; Please enter value between 2.0 and 12.0

Save Only Save & Reload Cancel

e Enter the Adb Path. This is the location of the Android
Debug Bridge (ADB) on your computer.
Note: When entering the ADB path in this dialog, you
must include the “adb.exe” at the end of the path.

e @ Preferences
Best Practices  Video

Max heap in 6B 12.0

AdbPath droid-sdks/platform-tools1/adb | Browse 2
Wireshark Path / Applications /Wireshark.app Browse
IDevicoScreenshot Path /usr/local/bin/idevicescreenshot | Browse
FFMpog Path /usr/local/bin/fimpeg Browse
FFProbe Path /usr/local/bin/ffprobe Browse
105 Provisioning Proflle Browse
108 Caortificate
108 Bundle Identifier
LoggingLevel  DEBUG [2]

sveoy (NN Conco
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e Wireshark path: required.
e iDeviceScreenshot Path: required on iOS for screen

capture.

o ffmpeg path: required for video analysis

e ffprobe path: required for video analysis

e Logging Level: There are 5 types of levels that user can
choose — Trace, Debug, Info, Warn, and Error.

e Select the Best Practices tab.

e Choose the best practices that you want to analyze

while opening the trace.

3 Pre x
General
Deselect Al z
File Download HTML
[] select Al [] select Al
Text File Compression Asynchronous Load of JavaScript in HTML
Duplicate Content HTTP 1.0 Usage
Cache Control File Order
Content Expiration Empty Source and Link Attributes
Combine 15 and CSS Requests “display:none”in €55
Resize Images for Mobile video
Image Metadata [ select al
Image Compression Stalls
Image Format Startup Delay
Image Comparison Buffer Occupancy
Minify €SS, 15, HTML Metwork Comparisan
Use CS55 Sprites for Images TCP Connection
Connections Segment Size
[ select Al Segment Pacing
A Cannar tinn Ananina A Radindzney N
Save Only Cancel

Select/Deselect All

User has the ability to select or de-select all the best practices

preferences.

e Select Video

¢ Here you can modify the parameters for pass/fail
criteria for some of the video best practices. In the
screenshot below, a startup delay over 8s is a warning.
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[ preferences X

General  BestPractices | /i9e0;

Warning Fail
Startup Delay (seconds) 8.000
Stall Duration (seconds) 0.500 1,000

Segment Redundancy (percentage) 15.0 250
Default

Targeted Startup Delay (seconds) 10.00
Stalltrigger (seconds) 0.050
Stall Pause Point (seconds) 0.1000
Stall Recovery (seconds) 0.1000
Near Stall (seconds) 0.0100
Preferred Maximum Buffer (MBytes) 100.00
Duplicate Handiing HIGHEST ~

Default

Save Only Save &Reload Cancel

The Save Only button only saves the current
preferences and doesn't reload the trace. It will not
affect the current state of analysis of an open trace,
changes will only be seen after opening another trace
or using Save & Reload. The Save & Reload button
saves the changes in the Preferences dialog, a refresh
is done on the trace and the selected values are
persisted across Video Optimizer launches. This means
that only the selected best practices are run while
opening the trace. Also, we limit the video segments to
be displayed in the diagnostics and Video tabs when
any of the Video best practices or any of the Image best
practices such as Compression, Metadata or Format
are selected for analysis.

5.1.3.Profile Menu

The Profile menu contains the following selections-

Note: Profiles are intended for advanced users of Video Optimizer trace
analysis.

Selection Description

Load Loads the selected Profile.

Customize | Displays the attribute values of the selected
Profile and allows you to edit them.

AT&T 3G Profile Network and Device Attributes
The following network attributes are defined for the AT&T 3G profile.
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Network Attribute Description
Carrier The network carrier for the device.
DCH (Active)->FACH The amount of time (in seconds) used
(Standby) timer (sec) when the RRC state changes from

(direct channel) DCH to (forward access
channel) FACH.

FACH (Standby)->IDLE timer | The amount of time (in seconds) used

(sec) when the RRC state changes from
FACH (Forward access channel) to
IDLE.

Min IDLE->DCH (Active) The minimum amount of time used (in

promotion delay (sec) seconds) when the RRC state is

promoted from IDLE to DCH (Active).
Avg IDLE->DCH (Active) The average amount of time used (in

promaotion delay (sec) seconds) when the RRC state is
promoted from IDLE to DCH (Active).

Max IDLE->DCH (Active) The maximum amount of time used (in

promotion delay (sec) seconds) when the RRC state is

promoted from IDLE to DCH (Active).

Min FACH (Standby)->DCH The minimum amount of time used (in

(Active) promotion delay (sec) seconds) when the RRC state is
promoted from IDLE to DCH (Active)
and FACH (Forward access channel) to
DCH (Active).

Avg FACH (Standby)->DCH The average amount of time used (in

(Active) promotion delay (sec) | seconds) when the RRC state is
promoted from IDLE to DCH (Active)
and FACH (Forward access channel) to
DCH (Active).

Max FACH (Standby)->DCH | The maximum amount of time used (in

(Active) promotion delay (sec) seconds) when the RRC state is
promoted from IDLE to DCH (Active)
and FACH (Forward access channel) to
DCH (Active).

RLC threshold for uplink The RLC threshold value (in bytes) for
(bytes) uplink.

RLC threshold for downlink The RLC threshold value (in bytes) for
(bytes) downlink.

Threshold for resetting DCH | The threshold for resetting the DCH
(Active) timer (bytes) (Active) timer (in bytes).

Timing window for resetting The timing window for resetting the

DCH (Active) timer (sec) DCH (Active) timer (in seconds).

RLC consumption rate (*2) for | The RLC consumption rate (*2) for
uplink uplink.
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Network Attribute

Description

RLC consumption rate (*1) for
uplink

RLC consumption rate (*0) for
uplink

RLC consumption rate (*2) for
downlink

RLC consumption rate (*1) for
downlink

RLC consumption rate (*0) for
downlink

Time delta for throughput
calculations (sec)

Threshold for defining a burst
(sec)

Threshold for defining a long
burst (sec)

Threshold for user input
window (sec)

Periodical Transfer Analysis -
Min size of periodical clusters
(sec)

Periodical Transfer Analysis -
Max tolerable variation for
periodical transfers (sec)
Periodical Transfer Analysis -
Min number of periodical
transfers

Threshold for duration of a
large burst (sec)

Threshold for size of a large
burst (bytes)

Threshold for close spaced
bursts (sec)

The RLC consumption rate (*1) for
uplink.

The RLC consumption rate ("0) for
uplink.

The RLC consumption rate (*2) for
downlink.

The RLC consumption rate (*1) for
downlink.

The RLC consumption rate ("0) for
downlink.

The time delta (in seconds) used for
calculating throughput.

The time threshold (in seconds) used for
defining a burst.

The time threshold (in seconds) used for
defining a long burst.

The time threshold (in seconds) used for
calculating user input.

The minimum size (in seconds) of a
cluster of periodical transfers.

The maximum tolerable variation (in
seconds) used for calculating periodical
transfers.

The minimum number of periodical
transfers.

The duration threshold (in seconds)
used for defining a large burst.

The size threshold (in bytes) used for
defining a large burst.

The threshold (in seconds) used for
defining a close spaced burst.

The following device attributes are defined for the AT&T 3G profile.

Device Description
Attribute

Device Name The make and model of the device.

DCH (Active)
Power (w)

The amount of power (in watts) that should be used
when the RRC state is DCH (Active).
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Device Description
Attribute
FACH The amount of power (in watts) that should be used
(Standby) when the RRC state is FACH (Standby).
Power (w)

IDLE Power (w) = The amount of power (in watts) that should be used
when the RRC state is IDLE.

Average power | The average amount of energy used when the RRC

for IDLE->DCH | state is promoted from IDLE to DCH (Active).

(Active)

promotion (w)

Average power | The average amount of power (in watts) that should

for be used when the RRC state is promoted from FACH
FACH (Standby) to DCH (Active).

(Standby)>DCH

(Active)

promation (w)
Average power | The average amount of power (in watts) for active
for active GPS | GPS.

(w)

Average power | The average amount of power (in watts) for standby
for standby GPS.

GPS (w)

Average power | The average amount of power (in watts) when the
when camera is | camera is on.
on (w)

Average power | The average amount of power (in watts) for active

for active Bluetooth.
Bluetooth (w)

Average power | The average amount of power (in watts) for standby
for standby Bluetooth.
Bluetooth (w)

Average power | The average amount of power (in watts) when the
when screen is | screen is on.
on (w)

iii.  AT&T LTE Profile Network and Device Attributes
iv.  The following network attributes are defined for the AT&T LTE profile.
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Network Description

Attribute

Carrier The network carrier for the device.

Promotion time | The amount of time (in seconds) spent in promotion
from Idle to CR | from the IDLE state to the CR state.

(sec)

Time of The amount of inactive time (in seconds) spent in the
inactivity from | CR state before changing to the DRX state.

CR before

DRX (sec)

Time in short | The amount of time (in seconds) spent in the Short
DRX (sec) DRX state.

Ping length | The length of a ping (in seconds) during the DRX state.
during DRX

(sec)

Time inLong | The amount of time (in seconds) spent in the Long
DRX (sec) DRX state.

Ping length in| The length of a ping (in seconds) during the IDLE state.
IDLE (sec)

Period The length of the period between pings (in seconds) in
between pings | the Short DRX state.

DRX Short

(sec)

Period The length of the period between pings (in seconds) in
between pings | the Long DRX state.

DRX Long

(sec)

Period The length of the period between pings (in seconds) in
between pings | the IDLE state.

IDLE (sec)

Time delta for | The time delta (in seconds) used for calculating
throughput throughput.

calculations

(sec)

Threshold for | The time threshold (in seconds) used for defining a
defining a | burst.

burst (sec)

Threshold for | The time threshold (in seconds) used for defining a long
defining a | burst.

long burst

(sec)

Threshold for | The time threshold (in seconds) used for calculating
user input | user input.

window (sec)
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transfers (sec)
Max tolerable
variation for
periodical
transfers (sec)
Min observed
samples for
periodical
transfers
Threshold for
duration of a
large burst
(sec)
Threshold for
size of a large
burst (bytes)

Network Description

Attribute

Min cycle for The minimum cycle time (in seconds) used for
periodical calculating periodical transfers.

The maximum tolerable variation (in seconds) used for
calculating periodical transfers.

The minimum number of observed samples used for
calculating periodical transfers.

The duration threshold (in seconds) used for defining a
large burst.

The size threshold (in bytes) used for defining a large
burst.

The following device attributes are defined for the AT&T LTE profile.

Device
Attribute

Description

Device Name

Average
power during
promotion (w)
Average
power of ping
during short
DRX (w)
Average
power of ping
during long
DRX (w)
Average
power during
tail (baseline)
(w)

Average
power of ping
in idle (w)

The make and model of the device.
The average power (in watts) used during promotion.

The average power (in watts) used by a ping in the
Short DRX state.

The average power (in watts) used by a ping in the
Long DRX state.

The average power baseline (in watts) used in a tail
state.

The average power (in watts) used by a ping in the
IDLE state.
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Device Description
Attribute

Multiplier for The multiplier used for throughput energy calculations,

throughput expressed in mW/Mbps.
upload energy

calc.

(mW/Mbps)

Multiplier for The multiplier used for download energy calculations,

throughput expressed in mW/Mbps.
download

energy calc.

(mW/Mbps)

Baseline for The baseline value (in watts) for energy used in the CR
CR energy state, before throughput modifiers are added.
(before

throughput

modifiers

added) (w)

Average The average amount of power (in watts) for active
power for GPS.

active GPS (w)

Average The average amount of power (in watts) for standby
power for GPS.

standby GPS

(W)

Average power The average amount of power (in watts) when the
when camera | camerais on.
is on (w)

Average power The average amount of power (in watts) for active

for active Bluetooth.
Bluetooth (w)

Average power The average amount of power (in watts) for standby
for standby Bluetooth.
Bluetooth (w)

Average power The average amount of power (in watts) when the
when screen is | screen is on.
on (w)

v.  AT&T WiFi Profile Network and Device Attributes
vi.  The following network attributes are defined for the AT&T WiFi profile.
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Network Description

Attribute

Carrier The network carrier for the device.

WiFi tail time The amount of time (in seconds) spent in promotion
(sec) from the IDLE state to the CR state.

Time delta for | The time delta (in seconds) used for calculating
throughput throughput.

calculations

(sec)

Threshold for | The time threshold (in seconds) used for defining a
defining a | burst.

burst (sec)
Threshold for

defining a
long burst
(sec)

Threshold for
user  input
window (sec)
Min cycle for
periodical
transfers (sec)

The time threshold (in seconds) used for defining a long
burst.

The time threshold (in seconds) used for calculating
user input.

The minimum cycle time (in seconds) used for
calculating periodical transfers.

Max tolerable
variation for
periodical
transfers (sec)
Min observed
samples for
periodical
transfers
Threshold for
duration of a
large burst
(sec)
Threshold for
size of a large
burst (bytes)

The maximum tolerable variation (in seconds) used for
calculating periodical transfers.

The minimum number of observed samples used for
calculating periodical transfers.

The duration threshold (in seconds) used for defining a
large burst.

The size threshold (in bytes) used for defining a large
burst.

The following device attributes are defined for the AT&T WiFi profile.

Device
Attribute

Description

Device Name

The make and model of the device.
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Average The amount of inactive time (in seconds) spent in the
power WiFi CR state before changing to the DRX state.
connected (w)

Average The amount of time (in seconds) spent in the Short
power WiFi DRX state.

inactive

(w)

Average The average amount of power (in watts) for active
power for GPS.

active GPS

(W)

Average The average amount of power (in watts) for standby
power for GPS.

standby GPS

(W)

Average The average amount of power (in watts) when the
power when camera is on.

camera is on

(w)

Average The average amount of power (in watts) for active
power for Bluetooth.

active

Bluetooth (w)

Average The average amount of power (in watts) for standby
power for Bluetooth.

standby

Bluetooth (w)

Average The average amount of power (in watts) when the
power when screen is on.

screen is on

(W)

5.1.4.Tools Menu

The Tools menu contains the following selections.

Selection Description

PCAP File Opens Wireshark to access the Pcap file and displays the
Analysis trace results in the Video Optimizer Data Analyzer.

Time Range Displays the Time Range Analysis dialog box that allows
Analysis you to set a time range, reset the time range, start or cancel

the analysis, calculate the statistics for the time range,
analyze based on the applied filters for IPv4, IPv6, TCP,
UDP, and DNS for a specific time range, and display the
analysis results.
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Export Results

Export
Session data

Edit Metadata

Private Data

Selection Description
Auto FlowsTab @ Provides the option to export the Flows tab information for
Export multiple traces automatically.

Html->Opens a Save As dialog box that allows you to export
the currently loaded trace data to a html file with the results
from the Best Practices tab.

Json-> Opens a Save As dialog box that allows you to
export the statistical and analytical data from the current
trace to a single json file.

Excel-> Exports the required trace information from the best
practices tab along with all the best practices test results.

All three export files include details of the time range that is
currently active such as Average Total Throughput, Uplink
Bytes, Average Upload Throughput, Downlink Bytes,
Average Download Throughput.

The exported files having a default naming convention of
<Trace_Folder_Name>_best practices_results)

This feature exports all the request response and packet
view results information of all the sessions in the TCP/UDP
Flows table

Opens the metadata window where the user can enter/edit
information about the trace such as - Trace storage,
Description, Trace Type, Target App, Application Producer,
Application Version, Sim, Network, Creator, and Trace
notes. This option is disabled if the user opens a PCAP file
and chooses not to retain the directory that is created during
opening of the file.

Opens a menu that allows you to set parameters for the

Tracking Video Optimizer to search for in the trace. This allows you to
find instances where private data is transmitted in an
unsecure way.

o Time Range Analysis

This feature allows you to set a time range, start or cancel the
analysis, analyze based on the applied filters for IPv4, IPv6, TCP,
UDP, and DNS for a specific time range, and display the analysis
results. Start and end times can be entered in seconds,
minutes:seconds, or hours:minutes:seconds format. If the time
range entry is invalid, an error message is displayed for the input
time range format. The data populated in the Results text area is
selectable so that it can be copied to another application for
comparison & further analysis.
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Time Range Analysis X

Starttime: |30 End time: 600

[“Pws [Pve  [v]Tce [»]upP [~]DnS

Reset Reanalyze [ " Calculate Statistics Cancel
Results:
“““ Time Range Analysis: 30.000 to 600,000 *#xx%
Payload length (bytes) = 347,472,743

Total Bytes = 345,707,763
Uplink Bytes = 3,851,705
Downlink Bytes = 345,855,886

RRC Energy (Joules) = 1120.17

LTE Continuous Reception Time (sec) = 252.91
Maximum Throughput (kbps) = 176032.13

Maximum Uplink Throughput (kbps) = 1505.%&
Maximum Downlink Throughput (kbps) = 175768.66
Average Throughput (kbps) = 4908.18

Average Uplink Throughput (kbps) = 54.06
Average Downlink Throughput (kbps) = 4554.12

Note: Current data doess not have any IPvé packets!

User has the ability to filter based on the IPV4, and IPV6 packets and
further for TCP, UDP, and DNS for each of those options. All 5 boxes
are checked by default when a trace is loaded. The user can choose
a specific time range and analysis will be done based on applied
filters and time range.

The Calculate Statistics button performs the analysis on the
provided time range and filters. The statistics results are
displayed in the text area based on the network profile that has
been selected in Profile->Load.

The Reanalyze button reanalyzes the trace with the selected time
range and filter.

The Reset button resets the timestamp to the entire trace
duration.

For a 3G Profile, you will see the following results in the Time
Range Analysis dialog box.

Time Range Analysis x

Starttime: 30 End time: 600
AP [Awrve [~]Tce [“Juoep []Duns
Reset Reanalyze {| Cancel
Results:
** Time Range Analysis: 30.000 to 600.000 *###%
Payload length (bytes) = 347,472,743

Total Bytes = 349,707,763
Uplink Bytes = 3,851,705
Downlink Bytes = 345,855,866

RRC Energy (Joules) = 677.15

DCH Time (sec) = 496.38

Maximum Throughput (kbps) = 176032.13

Maximum Uplink Throughput (kbps) = 1505.96
Maximum Downlink Throughput (kbps) = 175768.66
Average Throughput (kbps) = 4908.18

Average Uplink Throughput (kbps) = 54.06
Average Downlink Throughput (kbps) = 4854.12

Note: Current data does not have any IPvé packets!
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Result Description

Payload The length of the payload in bytes.

length

Total Bytes | The total number of bytes in the trace.

Uplink The total number of bytes of uplink data in the trace.

Bytes

Downlink The total number of bytes of downlink data in the

Bytes trace.

RRC The amount of energy used in joules.

Energy

DCH Time The amount of time, in seconds, that was spent in
the DCH state.

Maximum The maximum data throughput in kilobytes per

Throughput | second.

Maximum The maximum uplink data throughput in kilobytes per

Uplink second.

Throughput

Maximum The maximum downlink data throughput in kilobytes

Downlink per second.

Throughput

Average The average data throughput in kilobytes per

Throughput | second.

Average The average uplink data throughput in kilobytes per

Uplink second.

Throughput

Average The average downlink data throughput in kilobytes

Downlink per second.

Throughput

For an LTE Profile, you will see the following results in the
Time Range Analysis dialog box.
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Time Range Analysis K
Start time: |30 End time: 600
[ e [ZTcP [“upp [Z]Dns
Reset || Reanalyze || Calculate Statistics || Cancel

Results:

Payload length (bytes) = 347,472,743
Total Bytes = 349,707,763

Uplink Bytes = 3,851,705

| pownlink Bytes = 345,855,866

ERC Energy (Joules) = 1120.17
LTE Continuous Reception Time (sec) = 252.91
Maximum Throughput (kbps) = 176032.13

Maximum Uplink Throughput (kbps) = 1505.96
Maximum Downlink Throughput (kbps) = 175768.66
Average Throughput (kbps) = 4908.18

Average Uplink Throughput (kbps) = 54.06
Average Downlink Throughput (kbps) = 4854.12

Note: Current data does not have any IPvé packets!

Time Range Analysis: 30.000 to 6€00.000 *#%*x%

Result Description

Payload The length of the payload in bytes.

length

Total Bytes The total number of bytes in the trace.

Uplink Bytes | The total number of bytes of uplink data in the
trace.

Downlink The total number of bytes of downlink data in the

Bytes trace.

RRC Energy | The amount of energy used in joules.

LTE Time The amount of time, in seconds, that was spent in
the Continuous Reception (CR) state.

Maximum The maximum data throughput in kilobytes per

Throughput second.

Maximum The maximum uplink data throughput in kilobytes

Uplink per second.

Throughput

Maximum The maximum downlink data throughput in

Downlink kilobytes per second.

Throughput

Average The average data throughput in kilobytes per

Throughput | second.

Average The average uplink data throughput in kilobytes

Uplink per second.

Throughput

Average The average downlink data throughput in kilobytes

Downlink per second.

Throughput
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For a WiFi Profile, you will see the following results in the Time
Range Analysis dialog box.

Time Range Analysis X

Start time: |30
Py Pv6
Reanalyze

End time: |600

TCP UDP DNS

Results:

“““ Time Range Analysis: 30.000 to 600.000 #*#%=%
Payload length (bytes) = 347,472,743

Total Bytes = 349,707,763

Uplink Bytes = 3,851,705

Downlink Bytes = 345,855,866

RRC Energy (Joules) = 125.24

WiFi Active Time (sec) = 297.24

Maximum Throughput (kbps) = 178032.13

Maximum Uplink Throughput (kbkps) = 1505.96
Maximum Downlink Throughput (kbps) = 175768.6&6
Average Throughput (kbps) = 4908.18

Average Uplink Throughput (kbps) = 54.06
Average Downlink Throughput (kbps) = 4854.12

Note: Current data does not have any IPvé packets!

Result

Description

Payload
length

Total Bytes
Uplink Bytes
Downlink
Bytes

RRC Energy
WiFi Active
Time

The length of the payload in bytes.

The total number of bytes in the trace.
The total number of bytes of uplink data in the trace.
The total number of bytes of downlink data in the trace.

The amount of energy used in joules.

The amount of time, in seconds, that was spent in the
WiFi Active state.

Maximum
Throughput

The maximum data throughput in kilobytes per second.

Maximum
Uplink
Throughput

The maximum uplink data throughput in kilobytes per
second.

Maximum
Downlink
Throughput

The maximum downlink data throughput in kilobytes
per second.

Average
Throughput

The average data throughput in kilobytes per second.

Average
Uplink
Throughput

The average uplink data throughput in kilobytes per
second.

Average
Downlink
Throughput

The average downlink data throughput in kilobytes per
second.
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. Auto FlowsTab Export

This option under the Tools menu launches an automatic process of
analyzing all traces/pcap files within a folder, links included, and exports
the Flows Tab details as an xlIsx spreadsheet, for each of the traces/pcap
files. The exported reports output will be saved in a user designated folder.
This feature helps the user who wants to export the flows tab reports for
multiple traces by avoiding having to open each trace manually in Video
Optimizer to be able to export the flows tab report.

The Video Viewer will be hidden until the export is completed or the export
is cancelled.

E8 AT&T video Optimizer

File Profile Tools View Data Collector Help

Best Practice:

— Auto FlowsTab Export... l

Export Results... >

St Private Data Tracking...

Stage = CHOOSE

() clone traffic file to a temporary folder Delete History and Rebuild Flows
© Analyze In Place Include chart in export

Report folder: Reports Choose Source Run Open Reports Clear Cancel

The window on the top part of the dialog box specifies the stage of the
auto export. For example, stage=CHOOSE specifies that Video Optimizer
is waiting for the user to choose the files to be auto exported.

There are 2 radio buttons -

- Clone traffic file to a temporary folder — this option can be chosen
when the trace files do not reside in the local machine but exist in an
external source like OneDrive. A trace folder will be created in the ‘work’
folder (\.VideoOptimizenAutoExport\AutoExportFolder\Work) of the same
name. The traffic file will be the only file copied into the new trace folder
and once Video Optimizer opens the new folder, all other files will be
created as needed for analysis. This work folder is temporary and will be
deleted the next time the Auto FlowsTab Export is launched.

- Analyze in Place - opens trace folders in place.

The chosen option persists across multiple launches of the dialog until the
user changes the option.

There are 2 check boxes -

- Delete History and Rebuild Flows — any existing
FlowTableHistory.json file will be deleted, and the FlowGroup assignments
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will be rebuilt. If unchecked, the pre-existing FlowsTableHistory will be
used.

- Include chart in export — when checked, the Flows tab graph will be
exported along with the report.
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Flow# Time # Domain SNI Flow Group Label RemotelP Byte Count Percent Average kbps Peak kbps Active Protocol
T-0067 60.245 (£151.101.25.15 §002-vod-us-cmaf-prd-fy.cdn.peacocktv.com 151.101.25.15 9733087 11.99 761.066 2210856 7.000 Tisvi3
T-0078 75.335 (£151.101.25.15 rd- m 151.101.25.15 5375080 6.62 502.256 1846576 8.000 TLSv13
T-0303 384.576 (£146.75.93.15 146.75.93.15 4538460 5.59 907.715 1683.072  18.000 Tisv1.3
T-0066 60.244 (£151.101.25.15 151.101.25.15 1034 0.00 0.550 8272 1.000 TiSvi
T0273  359.938 [ image 23.53.122.91 5953333 7.33 1305.055 6373.016  3.000 Tisvi3
T-0208 215137 (Zimag 2353.122.01 4843515 5.97 1066.677 5150232 8.000 TiSvi3
1-0027 15.402 () imag 23.53.122.91 4297914 529 1254.499 5978712 5.000 TLSv.3
T-0321 456,614 (£ 23.53.122.77 3213598 3.96 713.261 4427.680  3.000 TLSv1.3
T0207 215135 (£ 2353.122.91 505 0.00 0317 4760  1.000 Tisvi
T-0000 6.070 [ acockn di ktv.com 235312201 517 0.00 0.274 4136 2.000 TiSv1

© Analyze In Place B inciude chart in export

Report folder: Reports Chosse Source OpenReports  Cesr  Cance

There is a text box present called 'Report Folder'. User can enter the name
of the folder to receive the exported reports. This folder will be created in
the VideoOptimizerReports folder, in the user’'s home directory.

A button called 'Choose Source' is present. Clicking on the button opens a
dialog where the user can choose -

- a single trace folder
or
- a folder containing multiple traces

Note — All traffic files will be found within the selection and analyzed no
matter how deep into the directory structure.

Click on the 'Open’ button in the 'Choose folder' dialog box. The Auto
Export [Flows] window displays the path of the ‘Source’ folder chosen for
Auto export and lists the total number of traffic files for which the
report/reports will be exported.

The window will also display the message, 'Press [Run] to begin analysis'.

[£]

Selected C:\Users\@s\VideoOptimizerAndroid e
® 47 traces

Press [Run] to begin analysis

() Clone traffic file to a temporary folder Delete History and Rebuild Flows
© analyze In Place Include chart in export

Repon folder: Reports Choose Source Run Open Reports Clear Cancel
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The Run button will become active after a source has been selected.
Clicking on the Run button starts the auto export. The window displays the
progress of the exporting flows tab reports as they cycle through the
traces chosen for export.

o
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At any point during the auto export if Video Optimizer runs into issue like
memory, Video Optimizer will close and relaunch and then continue with
the auto export processing.

After the export is completed, a message is displayed, 'Finished exporting,
The reports folder has been opened. NOTE: The currently opened trace
has only exported Flows data, you would need to ‘open' the trace if you
wish a full display.' The Auto FlowsTab Export has been optimized for
speed and as such does not analyze best practices and some of the other
tabs will not be fully populated.

£
Finished exporting WENCENINNNN, The reports folder has been cpened.

NOTE: The currently opened trace has only exported Flows data, you would need to ‘open’ the trace if you wish a full display.

() Clene traffic file to a temporary folder Delete History and Rebuild Flows
© Analyze In Place Include chart in export

Report folder: Reports choose Source Run Open Reparts Clear Cancel

The Report folder specified in the text box is opened after the export is
completed and all the traces in the folder have a corresponding Flows tab
exported.

The 'Open Reports' button opens the folder mentioned in the Report folder
text box. New export folders will only be created and can be opened as
soon as the Run button has been clicked.

The 'Clear’ button clears all items that are currently in the queue. Normally
there is one final report that will be exported before processing stops.
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Ready to [Start] a new export

(O clone traffic file to a temporary folder Delete History and Rebuild Flows
© Analyze In Place Include chart in export

Report folder: Reports Choose Source Run Open Reports Clear Cancel

The 'Cancel' button closes the Auto Export [Flows] dialog box.

5.1.5.View Menu

The View menu contains the following selections.

Selection Description

Show Video Opens a window that displays the video of the

Viewer activities carried out on the device while the trace
data was being collected.

Select Opens the Select Applications/IPs dialog box that

Applications/IPs allows you to select the application and IP address
that are included in the analysis.

Select Time Displays the Time Range Analysis dialog box that

Range allows you to set a time range, reset the time range,
start or cancel the analysis, calculate the statistics
for the time range, analyze based on the applied
filters for IPv4, IPv6, TCP, UDP, and DNS for a
specific time range, and display the analysis results.

Options Opens the View Options dialog box that allows you
to select the events and states that will be plotted in
the Diagnostics View chart

° Displaying a Video

i. The Video Viewer in Video Optimizer displays the video of the
activities carried out on the device while the trace data was being
collected.

ii. Select Show Video Viewer from the View menu.

ii. Play/Pause: Plays or pauses the video.

. Selecting Applications and IP Addresses

i.Choose Select Applications/IPs from the View Menu.

ii.You can select individual applications from a table and assign colors to

them. Another table lets you do the same thing to individual IP

Addresses. The data from each selected application and IP Address is

included in the analysis. The colors that you assign are used to mark

the
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packet information for that specific application or IP Address on the

Diagnostics Chart.

iii. Click any of the rows in the Color column to select a color.

|£) Select Applications / IP Addresses X
Select Application Name Color
unknown |

P4 [ PVe

(FATee Fluoe [FbNs

Select  Application Name Domain Name 1P Address Color

[ |unknown I | ~

[~]  |Unknown 8.8.8.8 8.8.8.8 [ 1

[ |unknown directvaav.vo.linwd.net |59.28.162.28 [ 1

[~]  |Unknown 5af10.v.fwmrm.net 34.223.159.221 [ 1

[#] |Unknown 5af10.v.fumrm.net 34.223,199.220 [ 1

]  |Unknown 5af10.v.fwmrm.net 34.223.199.219 [ 1

[#] |Unknown 5af10.v.fumrm.net 34.223,199.218 [ 1

[l |Unknown 54.196.120.204 54,196, 120,204 I |
oK Cancel

lect Co!
Swatches ‘Ess h RGB|

Recent:

Preview

n n . Sample Text Sample Text

. . . Sample Text Sample Text

[ OK ][ Cancel ][ Reset

]

Once a color is selected, the trace will be recalculated,
and all packets in the Diagnostics tab will be recolored

based on your selections.

iv.User has the ability to filter based on the IPV4, and IPV6 packets and
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Select Application Name Color

|unknown |

[Jwva [Jrve  [#]TcP [ZuDP [ DNS

Error X

Select

M B g9 s

TR ) Current selection does not return any data. Please select either IPV4 or [PV6.

| -

=

M

=

[ |Unknown 52.35.224.42 52.35.2249.42

[ |Unknown 65.8.17.2 65.8.17.2 [ 1

] [Unknown 12,120, 14.114 12,120,14.114 I |
| cance

. Selecting a Time Range

You can set a new time range for the trace analysis. This
allows you to analyze a subset of the loaded trace. When you
set the new start and end times, all of the analysis data in the
Best Practices/Results, Overview, Diagnostics, and Statistics
Tabs will display information for only your selected time
range.

1. Choose Select Time Range from the View menu.
2. Enter a Start time and End time for the trace analysis.

3. User has the ability to filter based on the IPV4, and
IPV6 packets and further for TCP, UDP, and DNS for each of
those options. All 5 boxes are checked by default when a
trace is loaded.

4. Click on Reanalyze to reanalyze the best practices with
the selected time range.

5. The Reset button resets the timestamp to the entire
trace length.

6. Calculate Statistics calculates throughput and data
statistics for the selected time range and displays it in the
Results section.
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Filter selections made in the TCP/UDP streams table (after the
refresh button has been clicked) will carry over to the Time
Range Analysis dialog. The Start time and End Time fields
reflect the time for the session/s. Time range analysis
calculation is based on this selection. Complete trace analysis
or individual stream analysis can be done as required.
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. Options

From File>View>Options list, you can determine what will be
plotted in the Diagnostics View chart. Default View and Video
View are two checkboxes at the bottom with preset views for
the diagnostic window. Video Optimizer allows 11 views at a
time.

1. Select Options from the View menu.

2. Select the events and states that you want to be plotted
in the Diagnostics View chart.

3. Click OK.

E8 View Options X
Packet Analysis
] GPs State
[ signal Strength
[ Bluetooth State
[ camera State
D Screen State
D Battery State
[ wakelock State
[ wiFi State
[ alarm Triggered
[ network Type
D Attenuation State
Throughput
Uplink Throughput
Downlink Throughput
Latency
D Session Count
Uplink Packets
Downlink Packets
Bursts
User Inputs
RRC States
] cru usage
[ Buffer Seconds
[ Buffer MBytes
[ video Chunks
D CPU Temperature

i [ video View Cancel

See the Diagnostics Tab section for more
details on this menu.

5.1.6. Data Collector Menu
The Data Collector menu contains the following selections.

Selection Description

Start Collector | Starts the Video Optimizer Data Collector.
Stop Collector | Stops the Video Optimizer Data Collector.
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5.1.7. Help Menu

Video Optimizer User Guide

The Help menu contains the following selections.

Selection

Description

FAQ

User Guide

Opens the default web browser and displays the Video
Optimizer FAQs web page.

Opens the default web browser and displays the Video
Optimizer User Guide

Dependencies

Support

Downloads

Learn More

About

Displays a dialog box containing the license information
for the open source libraries and binaries that are
distributed within the Video Optimizer package.

Provides a link to log in to the AT&T Developer Program
and file a ticket with Video Optimizer Support.

Opens the default web browser and displays the Video
Optimizer Downloads web page that contains links for
downloading and installing the different types of Video
Optimizer.

Opens the default web browser and displays the Learn
More about Video Optimizer web page.

Displays a dialog box containing information about the
Video Optimizer application including its version.

5.2. Content Tabs

The Video Optimizer user interface is divided into the following tabbed

sections.

Tab

Description

Best Practices /
Results

Overview
Diagnostics
Video

Flows

Statistics

Displays the results of the Best Practices tests that are
conducted on the trace data.

Displays charts and tables that present an overview of
key statistical data from the trace.

Displays charts and tables that present key diagnostic
data from the trace.

Displays throughput chart, Movie Streams, and Video
Requests.

Displays a graph and tables for the analysis done on
network flows.

Displays charts and tables that present key statistical
data from the trace.
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Tab

Description

Waterfall

Displays a waterfall view chart of the TCP connections
from the trace spread over time. The details, requests,
and responses of each connection can be viewed when
the chart is clicked.

5.2.1. Best Practices/Results Tab
The Best Practices/Results tab displays the results for all the Best
Practices tests that are conducted on the data captured in the trace

files.

AT&T Video Optimizer

File Profile Tools View Data Collector Help

Best Practices/Results Overview Diagnostics Video Statistics Waterfall

SUMMARY
Date.

Trace:

Time Range :

Profile:

Secure:

Application Name(s) : Version
Data Collector Version
Network Type(s)

Carrier Name / Cell ID:

DEVICE INFO

Device Make/Model : Google Pixel 6

Display Resolution - PORTRAIT (Width - 1080, Height : 2400)
OS/Platform Version : 13

TEST STATISTICS

Duration 12.65 minutes
44,915,587 bytes
41,864,703 bytes
2161.1J (Eneray)

Nov 17,2022 12:19.07 P
ThisleATestTrace
FULL [0.000 - 758.957]

Total Data Transferred
Total Payload Data

Energy Consumed
4320

56 SUb-6

METADATA

jueind ATTENUATOR Simulation Trace type Browsing
Down link Throttle 3G- 271 Mops. Device orientation PORTRAIT
AT&T 1108187408
Up link Throttle 3G- 351 Mops. | Targeted App Chrome

TRUE
| Application producer : Google

Trace Note:

Trace storage : ThislsATestTrace
Description:  This is 3 secure trace with the ARO certficate installed during trace collection on an Android 13

Manual
Stream Saver off
56 5Ub-6

25 installed during the trace collection. Downlink and Uplink Attenua
o.com, api6.ipify.org, api.ipify.org, vé.ident.me, vi.idenc.me, google

When trace files are loaded into Video Optimizer, the Best
Practices/Results tab displays the following test results.

A SUMMARY section with basic information about the
trace.

A TEST STATISTICS section with high-level test statistics
and ATTENUATOR Simulation section with attenuator
information.

A DEVICE INFO section which provides details about the
device the trace was collected on — Device Make/Model,
Display Resolution, and OS/Platform version.

Details of the trace collected as entered by the user —
Trace storage, Description, Trace type, Device Orientation,
Targeted App, Application Producer, Trace source, Sim,
Network, Creator, and Trace notes.

A TESTS CONDUCTED section that lists all the tests and
has a basic pass/fail/warning result indicated by a specific
icon.
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High-level results pages for all the tests grouped into the
test categories: File Download, Connections, HTML,
Security, Video, and Others.

Each of these pages has a common header panel that
shows the following information about the loaded trace files:

Label Description

Date The date when the trace files were generated.

Trace The name of the folder containing the trace files.

Time Range | The time range description name followed by the
time range that is used to open the trace.

Application | The names and versions of the applications that

Name (s): were running when the trace data was collected.

Version Note: on iOS, application name and version are
not displayed. On Android 8 and above the
application names are not displayed.

Data The version of the Video Optimizer Data

Collector Collector that was used to collect the trace data.

Version

Device The make and model of the device from which

Make/Model | the data was collected.

Display The Orientation mode, and the Width and height

Resolution | of the display from which the data was collected.

OS/Platform | The operating system version or platform

Version version of the device that the trace was captured
on.

Network The types of any networks (such as 3G or LTE)

Type(s) that were in use when the data was collected.

Carrier Carrier name, and the Cell tower ID the device

Name/Cell was connected to when the trace was captured.

ID

Profile The device profile that was used for the trace
analysis.

Secure Option for true and false is displayed.

iPhone Make/Model

The iPhone make & model displayed by Video Optimizer is confusing to
many users. However, it is based on the manufacturer settings. Please
refer to the chart below to clarify iOS make & model.
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VO displays IOS device VO displays iOS device
iPhonel,1 iPhone iPhonel0,6 iPhone X
GSM
iPhonel,2 iPhone 3G iPhonell,?2 iPhone XS
iPhone2,1 iPhone 3GS iPhonell,4 iPhone XS
Max
iPhone3,1 iPhone 4 iPhonell,6 iPhone XS
Max China
iPhone3,2 iPhone 4 iPhonell,8 iPhone XR
GSM Rev A
iPhone3,3 iPhone 4 iPhonel2,1 iPhone 11
CDMA
iPhone4,1 iPhone 4S iPhone 11 Pro
iPhonel2,3
iPhoneb,1 iPhone 5 iPhone 11 Pro
(GSM) iPhonel2,5 Max
iPhone5s,2 iPhone 5 iPhonel2,8 iPhone SE 2™
(GSM+CDMA) Gen
iPhone5,3 iPhone 5C iPhonel3,1 iPhone 12 mini
(GSM)
iPhone5,4 iPhone 5C iPhonel3,2 iPhone 12
(Global)
iPhone6,1 iPhone 5S iPhonel3,3 iPhone 12 Pro
(GSM)
iPhone6,2 iPhone 5S iPhonel3,4 iPhone 12 Pro
(Global) Max
iPhone7,1 iPhone 6 Plus | iPhonel4,4 iPhone 13 mini
iPhone?7,2 iPhone 6 iPhonel4,5 iPhone 13
iPhone8,1 iPhone 6s iPhonel4,2 iPhone 13 Pro
iPhone8,2 iPhone 6s iPhonel4,3 iPhone 13 Pro
Plus Max
iPhone8,3 iPhone SE iPhonel4,6 iPhone SE 3rd
(GSM+CDMA) Gen
iPhone8,4 iPhone SE iPhonel4,7 iPhone 14
(GSM)
iPhone9,1 iPhone 7 iPhonel4,8 iPhone 14
Plus
iPhone9,2 iPhone 7 Plus | iPhonel5,2 iPhone 14 Pro
iPhone9,3 iPhone 7 iPhonel5,3 iPhone 14 Pro
Max
iPhone9,4 iPhone 7 Plus | iPhonel5,4 iPhone 15
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iPhonel0,1 iPhone 8 iPhonel5,5 iPhone 15
Plus

iPhonel0,2 iPhone 8 Plus | iPhonel6,1 iPhone 15 Pro

iPhonel0,3 iPhone X iPhonel6,2 iPhone 15 Pro
Global Max

iPhonel0,4 iPhone 8

iPhonel0,5 iPhone 8 Plus

Summary

The Summary section shows the summary of results for all
the best practices tests conducted on the loaded trace files. It

contains the following sections.

TEST STATISTICS shows the following information about the

loaded trace files.

Label Description

Duration The total time, in minutes, for which the trace data

was collected.

Total Data | The total size, in bytes, of all data packets that are
Transferred | transferred for the entire duration of the trace data
collection. This total includes the size of the

packet and the packet header.

Total This gives the total payload of the entire traffic.
Payload

Data

Energy The total energy, in Joules, that is consumed

Consumed | during the entire duration of the trace data
collection. This total includes the energy of RRC,
GPS, WiFi, Bluetooth, Camera and Screen.

ATTENUATOR shows the parameters that were used for

network attenuation during collection. For example,

Downlink throttle provides the ms delay in the downlink

throttling, and uplink is the delay placed on uplink
connections. See Network Attenuation.

TESTS CONDUCTED displays a list of all the best practices
tests that were conducted on the loaded trace files with an
icon to the left of each test name that indicates the test
result status (Pass, Fail, Warning, Configuration required

and no data(N/A) icon.

The tests are grouped into the following categories.
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Note: When any of the best practice tests in a category fails,
the header for that category turns red. The category header
remains green if all the tests in that category have passed.

Test

Category

Description

Text File
Compression

File Download

Tests if any text files sent by
the app that were larger than
850 bytes are uncompressed.

Duplicate
Content

Cache
Control

Content
Expiration

Combine
Java Script
and CSS
Requests

Resize
Images for
Mobile

Image
Metadata

Image
Compression

File Download

File Download

File Download

File Download

File Download

File Download

File Download

Tests if more than three files
are downloaded in a duplicate
manner in the loaded trace
files.

Tests if the amount of “not
expired duplicate data” is
greater than the amount of
“not changed data” in the
loaded trace files.

Tests if there is more than
10% of non-cacheable data
available in the loaded trace
files.

Tests if there are multiple
requests for CSS or JS files
occurring within 2 seconds of
one another.

Tests if there are any images
that are 150% larger than the
area specified for them.

Tests for EXIF text metadata
in your images. An image fails
if the file is more than 1%
metadata.

Tests JPEG images for
compression. If a file is saved
at 85% quality and is >15%
smaller (in KB), the best
practice fails.
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Test

Category

Description

Image Format | File Download

Image
Comparison

Minify CSS,
JS, and
HTML

Use CSS
Sprites for
Images

Connection
Opening

Unnecessary
Connections
— Multiple
Simultaneous
Connections

File Download

File Download

File Download

Connections

Connections

Alternative image formats can
help increase the speed of
your mobile application, as
newer compression
algorithms compress the files
to a much smaller size, with
virtually no loss in quality.
Images downloaded from the
network should be
approximately the same size
as the images that appear on
the screen. Video Optimizer
measures each image on the
screen and compares the
dimensions to the images
downloaded over the network.
Tests if there are any files that
could be minified (shrunk
through the removal of
whitespace).

Tests for any groups of small
images that are downloaded at
once, which could be
combined into one image
using sprites.

This test helps ensure
connections are opened
properly. Some connection
startups consist of an input
burst, followed by a series of
bursts spread out over time
which can dramatically slow
down the application's
response time and waste
energy on the device. This is a
self test.

Tests if there are several
bursts in a row that are not
user initiated in the loaded
trace files.
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Test Category Description

Multiple Connections With HTTP2, you can utilize

Simultaneous multiplexing — to download

Connections multiple files in one

to One connection. Using fewer

Endpoint connections allows content to
be downloaded faster and
uses fewer resources on the
device. The threshold is
increased to 7 or more
simultaneous connections to
same server.

Multiple Connections Opening many connections all

Simultaneous at once can cause bottlenecks

Connections in slower network conditions.

to Many Android limits the number of

Endpoints TCP connections to 15.

Inefficient Connections Tests if a periodic connection

Connections is detected in the loaded trace

— Periodic files.

Transfers

Inefficient Connections Tests if the application triggers

Connections network activity when the

— Screen screen orientation changes.

Rotation

Inefficient Connections Tests if 5% of the energy is

Connections used for TCP control in the

- loaded trace files.

Connection

Closing

Problems

400,500 Connections Tests if there are any HTTP

HTTP Status response codes in the 400

Response range (indicating a client

Codes request error) or in the 500

range (indicating a server
request error) in the loaded
trace files.
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Test Category Description

301,302 Connections Tests if there are any

HTTP Status occurrences of the HTTP

Response status response code 301

Codes (indicating that the URI of a
requested resource has been
changed permanently), and
any occurrences of the HTTP
status response code 302
(indicating that the URI of a
requested resource has been
changed temporarily) in the
loaded trace files...

3" Party Connections Tests for files where at least 2

Scripts external scripts are being
called.

Asynchronous  HTML Tests for any HTML files with a

Load of synchronous load of

JavaScript in JavaScript in the HEAD.

HTML

Http 1.0 HTML Tests if HTTP 1.0 is seen in

Usage the header of the loaded trace
files.

File Order HTML Tests for any HTML files
where JS is loaded
immediately before CSS.

Empty HTML Tests for the empty attributes:

Source and iframe src, href src, img src,

Link script src, and link href, in the

Attributes trace files.

“display: HTML Tests for any instances of the

none” in CSS CSS command
“display:none” in the trace
files.

HTTPS Security Looks for connections that do

Usage not feature HTTPS. The best
practice displays information
about Total HTTPS data, Total
HTTPS unanalyzed and % of
Total HTTPS Data.

Transmission | Security Scans all transmitted data for

of Private potential leaks of private data.

Data

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.

Video Optimizer User Guide




((

AT&T Entertainment Experience Suite

Video Optimizer User Guide

Test Category Description

Unsecure Security There are several versions of

SSL Version SSL that are not considered
secure. This test identifies
connections that use those
versions.

Forward Security Encryption that allows key

Secrecy capture, allowing attackers to
gain access to all security
keys.

Stalls Video Identifies when a video stalls
(stops playing due to an empty
buffer).

Start Up Video Quantifies the time it takes for

Delay video to start from the first
download of video data.

Buffer Video Quantifies the amount of

Occupancy video stored in the buffer
over time.

Network Video Compares the video

Comparison bandwidth download with the
available network bandwidth,
to determine if the optimal
bitrate is being displayed.
Results section include
Declared Manifest(kbps) and
Calculated Network
Bitrate(Kbps) for each
segment.

TCP Video Count of connections used to

Connection deliver video during the trace.

Segment size | Video Average size of the video
chunks downloaded during
streaming.

Segment Video Pacing of the video chunks

Pacing downloaded during streaming.

Redundancy | Video Looks to see if the same
chunk is downloaded multiple
times.

Concurrent Video Using too many concurrent

Session sessions may cause problems

with smooth delivery of
content
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Test Category Description

Variable Video Analysis for Non- DRM
Bitrate stream.

Resolution Video Video Optimizer conducts a
and test that flags video files with
Perception resolutions greater than 720p

Analyzing the | Video
Adaptive
bitrate ladder

Streaming Video
Separate
Audio and

Video

Accessing Others
Peripheral

Applications

that are being sentto a
smartphone.

By analyzing your ABR Ladder
and designing it to stream files
more efficiently over HTTP
networks, with careful
consideration of device.
Results Section includes Track
#, Resolution, Playback %,
Segment Count, Total
Duration(Sec), Segment
Position(Sec), Declared
Bitrate(kbps), Average
Bitrate(Kbps)

Streaming Separate Audio and
Video segments, known as
demuxing, has a number of
benefits. There are also
challenges that can lead to
video stalling

Tests if any peripheral
applications are seen to be
ON for more than 5% of the
total duration recorded in the
loaded trace files. The
peripheral applications
checked during this test are:
GPS, WiFi, Bluetooth, and
camera.

Tables

For more detail on each of these best practices, visit
https://developer.att.com/video-optimizer/docs/best-practices.

The tables in the Video Optimizer best practices sections

help you pinpoint the issues flagged by the best practice and
they let you further investigate the issues. Double-click a line
in the Best Practices table to view the Diagnostics tab, which
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highlights the connection or file that is failing the best
practice.

Right click a line in the Best Practices table to export the
table. (Alternatively, command-a (select all) command-c
(copy) will allow you to paste (command v) the table into
your favorite spreadsheet software). Export table feature has
a relevant default table name as file name - (Default
filename => <Trace_Folder_Name>_<table name>). For
example, for best practices results export: Default filename
=> <Trace_Folder_Name>_ <best_practice_name>. The
<best_practice_name> usually follows the naming
convention of best practice category and corresponding test
name.

Images tables have additional features such as metadata

VIews.
1. Click an image table to open a content view with the
metadata:
o0 e Content viewer
Orientation: 1
|XResolution: 72 I
|YResolution: 72 ]
ResolutionUnit: 2
|Software: 'Adobe Photoshop CC 2017 (Windows)' b
DateTime: '2016:11:15 12:48:20' |
ExifOffset: 168
ColorSpace: -1 }
ExiflmageWidth: 640 !
ExiflmageLength: 480 )
Compression: 6 i
|XResolution: 72 F
|YResolution: 72
ResolutionUnit: 2
JpgFromRawStart: 306
JpgFromRawLength: 6450 \

Close

2. Click the file name or original file size columns in the Image
Compression table to open a view of the original image.

3. Click the 85% column to open the 85% compressed image
and click the 70% column to open the 70% compressed
image. In Figure, all three images are open in the Content
Viewer (the original image, the 85% compressed image, and
the 70% compressed image).
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[ XoX ] Content viewer

Close Close

Results: If all of the images below were delivered at 85% compression, 50,244 less data would be used.

Time Image Name Original Ima... 85% Compre... 70%Compre...

18.628 /media/2016/11/shmuley-boteach-steve-bannon-200x150.jpg 20225 8653 7052
62.918 /media/2016/11/Gettylmages-623342984-200x150.jpg 11220 5682 4754
328.352 J/media/nw-798/a2bad3e3-f2d4-4058-b076-623698d36b78.jpg 59180 43435 32868
346.738 /media/nw-805/4091fbab-a5e6-49ca-88f6-b1d78cdcacfl.jpg 52311 34922 26112

5.2.2. Overview Tab

The Overview Tab displays charts and tables that summarize the
data in the loaded trace files. The top part of the Overview tab
contains the following information:

*Date: The date when the trace files were generated.
*Trace: The name of the folder containing the trace files.

*Downlink Throttle: If the Network attenuator downlink function was
used during this trace, it will register the speed in mbps/kbps.

*Uplink Throttle: If Network Attenuator uplink function was used
during this trace, this will record the speed in mbps/kbps.

*Network Type: The type of network, like 3G or LTE, which was in
use when the data was collected.

*Profile: The profile that was used for the trace analysis.
*Total Bytes: The total number of bytes in the trace

. Charts

The top of the Overview tab has three charts with high level
information about the type of content, the energy usage
compared with benchmark traces, and the number and type
of connections used.

The File Types chart plots the percentage of the various file
types found in the trace data.
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File Types

application/json
text/html
image/jpeg
text/plain
application/xml
Unknown

image/gif 1[0

0 10 20 30 40 50 60 70 80 90 100
% of Data Transfer

The Trace Benchmarking chart plots the average data
rate, energy efficiency, and signaling overhead of the
loaded trace, as a percentage, compared with a set of
sample benchmark traces.

Trace Benchmarking

Avg Rate: 17.0 kbps

Energy Efficiency: 0.4 Jkb

Signaling Overhead: 0.1

0 10 20 30 40 50 60 70 80 90 100
Percentile Compared To Sample Traces

The Connection Statistics chart plots the percentage of the
various types of session terminations based on the data
captured in the trace. Four types of session terminations are
plotted: Proper session termination, tightly grouped
connection, nonperiodic bursts connection, and large burst
connection.

Connection Statistics

Proper session termination %
Tightly grouped connection %
Non-Periodic Burst connection %

Large Burst connection % 1[0

0 10 20 30 40 50 60 70 80 90 100
Percentage
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The Connection Statistics chart contains the following fields:

Field Description
Proper If the amount of time between the last data packet and
session the data packet that signaled the TCP session

termination | termination is less than or equal to 1 sec, then the
session termination is represented as proper session
termination. In the session termination plot, the
sessions are displayed as a percentage of the total
number of TCP sessions.

Tightly If 3 bursts occur in less than 15 seconds or 4 bursts

grouped occur in less than 60 seconds, then those sets of bursts

connection | are referred to a tightly grouped connection. In the
session termination plot, these bursts are displayed as
a percentage of the total number of bursts.

Non- If the Internet Addresses, host names, or object names
Periodic are not the same for the packets in a set burst over a
Burst period, then those bursts are considered nonperiodic

connection | bursts. In the session termination plot, these bursts are
displayed as a percentage of the total number of bursts.

Large If the burst duration is more than 5 seconds, then that

Burst burst is considered a large burst. In the session

connection | termination plot, these bursts are displayed as a
percentage of the total number of bursts.

Tables

The bottom section of the Overview tab has tables for the
accessed domains. You can get more information about
these items by clicking on table rows.

The Duplicate Content table lists files that have been
identified as duplicate content. By default, the table is sorted
by content type, and it includes the following columns.

Column Description
Duplicate Content | One of the following types of duplicate content:
Type ORIGINAL_FILE

OBJDUP_NOT_EXPIRED
OBJDUP_NOT_CHANGED_SERVER
OBJDUP_NOT_CHANGED_CLIENT
OBJDUP_PARTIAL_NOT_CHANGED_SERVER
OBJDUP_PARTIAL_NOT_CHANGED_CLIENT
OBJDUP_PARTIAL_NOT_EXPIRED
OBJDUP_DIFF_ETAG
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Time The timestamp for this occurrence of the
duplicate content.
File Name The name of the duplicate file.

File Size (bytes) The size of the duplicate file in bytes.

Click the title of any column to sort the table.

Select a file and click View or Save As to view or save the
content of the file.

Right-click the table to export the data. The default naming
convention for the exported file is
<Trace_Folder_Name>_overview_<table_name>

The Accessed Domains table contains details about each
domain that was accessed during the trace. The table
includes the following columns.

Column Description

Domain Name The list of domain names that are captured in
the loaded trace files. These domain names
are application independent and may have
occurred in the browser app or any other

application.
TCP Sessions The count of TCP sessions for the
corresponding domain name.
Average Session The average session length in seconds. This
Length (sec) average is calculated by dividing the total

TCP session time (the difference between the
session end time and the session start time)
by the size of the session for this domain
name.

Files Downloaded The number of files downloaded for the
domain name session.

Click the title of any column to sort the table.

Left-click a domain in this table to populate the adjoining
table (Domain TCP Sessions) with information about the TCP
sessions that were used when accessing that domain.

Right-click the table to export the data in preferred format.
The default naming convention for the exported file is
<Trace_Folder_Name>_overview_accessed_domains.

The Domain TCP Sessions table contains the collection of
TCP Session information for the currently selected domain
name in the Accessed Domains table and refreshes each

Video Optimizer User Guide




((

AT&T Entertainment Experience Suite Video Optimizer User Guide

time a new domain name is selected. The table includes the
following columns.

Column Description

Time The time stamp of the Domain TCP
Session.

Remote IP Address The Remote IP Address of the
Domain TCP Session.

Local Port The Local port value of the Domain
TCP Session.

Session Length (sec) | The session length, in seconds, of
the Domain TCP Session. The
session length is the difference
between the starting time stamp
and the ending time stamp for the
session.

Bytes Transmitted The number of bytes transmitted
during the Domain TCP session.

Session Close Delay | The session termination delay, in

(sec) seconds, of the Domain TCP
Session.
Closed By Indicates whether the Client or the

Server closed the

Domain TCP Session. The Closed
By value can be Client, Server, or
Status Unknown, and is
determined by the session packet
direction.

Click the title of any column to sort the table.

2. Double-click a domain in this table to navigate to the
TCP/UDP Flows Table in the Diagnostics tab where you can
view the TCP flow information for the selected Domain TCP
session. The selected TCP information will be indicated by
highlighted type.

3. Right-click the table to export the data in preferred format.
The default naming convention for the exported file is
<Trace_Folder_Name>_overview_ domain_tcp_sessions.

5.2.3. Diagnostic Tab

The Diagnostics tab plots data from the loaded trace files and
displays it in a Diagnostics chart. Detailed information is displayed in
the TCP/UDP Streams Table, which has additional tabs for three
different views into the TCP or UDP data.
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The Diagnostics tab displays the following information at the top
before the chart:

» Date: The date when the trace files were generated.
* Trace: The name of the folder containing the trace files.

* Downlink Throttle: If the Network attenuator downlink function was
used during this trace, it will register the ms delay.

* Uplink Throttle: If Network Attenuator uplink function was used during
this trace, this will record the ms delay uplink.

* Total Bytes: The total number of bytes in the trace.

* Network type: The type of network, like 3G or LTE, which was in use
when the data was collected.

» Profile: The profile that was used for the trace analysis.

o Diagnostics Tab Chart

The Diagnostics tab chart displays the graph data with an X-
axis for the trace timeline and a Y-axis for labels of the
information that is being plotted.

R
e Click

e Click ’ to save a snapshot of the chart. The File
name field is populated with tracename_img by default
in the Save dialog box. The location chosen by default
is the trace folder.

e Choosing a resolution from the drop down helps change
the time resolution of the graphs displayed. On hover
over the icon, a dialog informs the user that the graphs
can change based on the setting. The default resolution
is set to 1s

for a zoom view.
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Re-scale throughput time in seconds

Changing the resolution does not reload the trace and
all relevant graphs use the same resolution settings.
The chosen resolution persists across trace loads and
Video Optimizer restarts.

Use the following procedure to configure the items that are
plotted on the Diagnostics tab chart.

Select Options from the View menu.
Select the items to be plotted in the View Options dialog
Click OK.

Move the pointer over the graphed items in the Diagnostics
tab chart for more information on each one.

A

E§ view Options X
Packet Analysis
] GPS State
D Signal Strength
[ Bluetooth State
D Camera State
D Screen State
D Battery State
] wakelock State
] wiFi State
] Alarm Triggered
[ network Type
D Attenuation State
Throughput
Uplink Throughput
Downlink Throughput
Latency
D Session Count
Uplink Packets
Downlink Packets
Bursts
User Inputs
RRC States
I:‘ CPU Usage
[ Buffer Seconds
[ Buffer MBytes
[ video chunks
D CPU Temperature

[ video View Cancel

Note: In addition to creating your own custom view, there is a
Default View and a Video View — especially created to help
analyze video traces.
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. Diagnostics Tab Chart Items

The following sections describe in detail the different types of
information that can be plotted on the Diagnostics tab chart.

* GPS State— shows the variation in GPS states over the
duration of the trace.

GPS State

| Description

GPS Active

GPS
Standby

GPS Off

The GPS receiver is turned on and is fixing
the location. Energy consumption during this
state is high. This state is colored green in the
plot.
The GPS receiver is turned on but is in
standby mode. Energy consumption during
this state is low. This state is colored yellow in
the plot.
The GPS receiver is turned off.

+ Signal Strength—shows the variation in radio signal strength
(expressed in Dbm) over the duration of the trace.

* Bluetooth State—shows the variation in Bluetooth states over
the duration of the trace.

Bluetooth State Description

Bluetooth Connected | The Bluetooth is turned on and the

Bluetooth Standby The Bluetooth is turned on, but the

Bluetooth Off The Bluetooth is turned off.

device is paired with another device
for data transfer. Energy
consumption during this state is high.
This state is colored green in the
plot.

device is not paired with another
device. Energy consumption during
this state is low. This state is colored
yellow in the plot.

« Camera State—shows the variation in camera states over the
duration of the trace

Camera State Description

Camera On

Camera Off

The Camera is turned on. Energy
consumption during this state is high. This
state is colored green in the plot.

The Camera is turned off.
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* Screen State—shows the variation in screen states over the
duration of the trace.

Screen State Description

Screen On The Screen is active. Energy consumption
during this state is high. This state is
colored green in the plot. When you place
the tooltip over this state in the plot, the
screen time out value (in seconds) and the
brightness (in %) are displayed.

Screen Off The device is in sleep mode.

+ Battery State—shows the variation in battery level over the
duration of the trace. Includes battery level, battery
temperature, and battery connection status.

*  WiFi State—shows the variation in WiFi states over the
duration of the trace.

WiFi State Description

WiFi Connecting The device is trying to connect to
a WiFi network. Energy
consumption during this state is
high. This state is colored green
in the plot.

WiFi Connected The device is connected to a WiFi
network. Energy consumption
during this state is high. This state
is colored green in the plot. In
addition to state detail, also
shows the Mac Address, Radio
Received Signal Strength
Indication (RSSI) and Service set
identifier (SSID).

WiFi The device is disconnecting from

Disconnecting a WiFi network. Energy
consumption during this state is
high. This state is colored green
in the plot.

WiFi Standby The device is disconnected from
WiFi network. Energy
consumption during this state is
low. This state is colored yellow in
the plot.
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WiFi State Description

WiFi Suspended A WiFi network was disconnected
unexpectedly. Energy
consumption during this state is
low. This state is colored yellow in

the plot.
WiFi Off WiFi is disabled in the device.
WiFi Unknown State The WiFi is in an unknown state.

*  Throughput — shows the variation in network traffic
(expressed in kbps) over the duration of the trace. The higher
the throughput, the higher the energy consumption. The Y
axis displays values to help with analysis.

v
20,000
Time: 11255
15,000 1 Throughput : 22,938.704 kbps
Throughput (kb..
10,000
5,000 | f M J
oy lu )
- I L . U | O S Y | Y SR L

* Uplink Throughput (UL Throughput) — shows the variation in
uplink network traffic (expressed in kbps) over the duration of
the trace. The higher the throughput, the higher the energy
consumption. The Y axis displays values to help with

analysis.
) v
780 {
UkLbThm"unpm see ;.IA Time: 111,55
(kbps) 20l M Throughput: 714.256 kbps
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* Downlink Throughput (DL Throughput) — shows the variation
in downlink network traffic (expressed in kbps) over the
duration of the trace. The higher the throughput, the higher
the energy consumption. The Y axis displays values to help
with analysis.

* Latency — each TCP session’s latency measurements
captured over the course of the trace is mapped and
displayed graphically in a horizontal band in the diagnostics
tab. Hovering over the points in the graph displays the Start
time, Latency, SYN time, and the SYNACK time.
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* Session Count- A graphic element added to the Diagnostics
Tab titled 'Session count'. Values will be from a count of
simultaneous sessions open at a given time. User will be able
to see how many sessions are open at each transition, using
the tool tip. A sharp rise in session count should allow user to
see in the TCP/UDP Flows section, exactly which sessions
were being connected to cause the sudden rise.

|ER ATacT Video Optimizer - o X
ile Profile Tools View Data Collector Help
[Best PractcesResuts Overview Diagnostcs Video Statistics Waterfol

Date: Tue Jan 22 112344 PST 2019 Down link Throttie: NA Up ink Throttie: A Network Type(s):  WIF|
race Total Bytes: 106504420 Profile: ATAT L
v
lattenuation state
[ i
\ 0 M
Throughput \I‘pvr‘,\»\ﬂ_ ﬂ”-'w ,H"ﬁ T A
il i I8P YUK B 7 R U W Q
\ 100 —
Session Count | o _— Q
N e . - - ]
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* Uplink Packets (Packets UL)—shows the packets that were
uploaded (uplinked) in the sessions over the duration of the
trace. Includes Packet Info, TCP, UDP, UDP/QUIC, DNS

Session Info.
oy
iss/ BN W, JMJ_.JI.L\M il e R
‘ | Packet Info:
Packet ID: 745
Packets DL ‘ Packet Timestamp: 69.417
Timeline 0 2 5'0 Application: Unknown
TCP Session Info:
B £ Begin Time: 69.317
End Time: 101.72 TCE
Tlmeﬁ [  Domain Name Remote P:121.101.167 Local Port Remote IP
Remote Port: 443
4,171 [ dns.google Local Port: 37250 42762 8.8.4.4
6,701 [ dns.google 33492 8.8.8.8
68.238 [ dns.google 57212 8.8.8.8

+ Downlink Packets (Packets DL)—shows the packets that
were downloaded (down linked) in the sessions over the
duration of the trace. Includes Packet Info, TCP, UDP,
UDP/QUIC, DNS Session Info.
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o) I e N WL P e e o W A
Packets DL | | | | | |I | | |III | |||| |
. Packet Info:
Timeline 0 25 79 packet ID: 3,087 150 175 200 225
£ Packet Timestamp: 77.336
— Application: Unknown
A DNS Session Info:
Time Domain Mame Begin Time: 77.256 Local Port Remote IP
4171 [4] dns.google End Time: 77.336 42762 8.8.4.4
6.701 [ dns.google Remote IP: 8.8.8.8 33492 8.88.8
58,238 [ dns.google Remote Port: 53 57212 8.8.5.8
& [ons.google Local Por 22732
58,254 [A dns.google 15677 3.8.4.4

*  Bursts—shows the various types of bursts that occurred over
the duration of the trace. A burst consists of consecutive
packets transferred in a batch. Includes the burst type, a
message, the packet count, the total bytes, and the

throughput (in kbps).

Burst Type

Description

TcpControl

TcpLossRecoverOrDup

Userlnput

This category of burst is colored blue in
the chart plot, and displays the tooltip
message: "TcpControl: Traffic that is
delayed from a previous burst.”

This category of burst is colored black in
the chart plot, and displays the tooltip
message: “TcpLossRecover:

Traffic that has been resent due to long
delay.”

This category of burst is colored green
in the chart plot and displays the tooltip
message: “User Input: Traffic initiated
after a User Input event.”

Screen Rotation

App

SvrNetDelay

This category denotes a burst caused
by the rotation of the device. It displays
the following tooltip message: “Screen
Rotation: This traffic was initiated by a
rotation of the device”.

This category of burst is colored red in
the chart plot and displays the tooltip
message: “App: Traffic initiated by the
client.”

This category of burst is colored yellow
in the plot, and displays the tooltip
message: “SvrNetDelay: Traffic
initiated by the server.”
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Burst Type

Description

Large Burst

Periodical

User Defined

Unknown

If a burst duration is more than 5
seconds, then that burst is considered
to be a long (or large) burst. This
category of burst is colored gray in the
chart plot, and displays the tooltip
message: “LargeBurst: Traffic in a large
burst (configurable in settings).” Note:
The tooltip refers to the fact that the
length and size thresholds for what is
considered to be a long/large burst can
be configured using the Customize
dialog in the Profile menu.

If the Internet Addresses, or the host
names, or object names are the same
for the packets in a set burst over a
period of time, then those bursts are
considered periodic bursts. This
category of burst is colored purple/pink
in the chart plot, and displays the tooltip
message: “Periodical: Traffic that has a
distinct periodic pattern.”

These are user defined bursts. This
category of burst is colored magenta in
the chart plot.

This category denotes an unknown type
of burst.

* User Input—shows the various user input events that have

occurred over the duration of the trace including the

following:

SCREEN_LANDSCAPE->BLUE

SCREEN_PORTRAIT->RED

SCREEN_TOUCH - > GREEN
KEY_VOLUP ->DARK_GRAY
KEY_VOLDOWN -> MAGENTA

KEY_POWER ->YELLOW

* RRC States—shows the variation in the Radio Resource
Control (RRC) states over the duration of the trace. The
states are determined by calculating the battery usage when
network packets are received.
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Note: DCH stands for dedicated channel, FACH stands for
forward access channel, and CR stands for Continuous

Reception.

RRC State

Description

IDLE
DCH (Active)

DCH TAIL

FACH (Standby)

FACH TAIL

PROMOTION
IDLE->DCH
(Active)

PROMOTION
FACH (Standby)-
>DCH (Active)

Indicates the radio is off.

This state is colored yellow in the chart plot. It
indicates

that the radio is in a high data, high radio
energy, and high bandwidth mode which
allows maximum throughput.

This state is colored with a yellow cross hatch
pattern in the chart plot. It indicates that the
radio is in a high throughput, high bandwidth
state, but no packets are being sent.

This state is colored green in the chart plot. It
indicates that the radio is in low power state.
Signaling packets may be sent, but content
requires transition to DCH.

This state is colored with a green cross hatch
pattern in the chart plot. It indicates that the
radio is in a low power state with no traffic.
Transition from IDLE to DCH (Active) state.
This state is represented by a red triangle in
the chart plot. It indicates the radio switching
from off to a high-power state.

Transition from FACH (Standby) to DCH
(Active) state. This state is represented by a
red polygon in the chart plot. It indicates
switching from low power state to the high-
power state.

LTE IDLE Indicates that the radio is in an idle state, with
occasional pings to the network for data.

LTE Continuous Reception is the time of active

CONTINUOUS packet transfer. High throughput high energy
data transfer. Energy here is indicated as
constant, but it does vary based on
throughput.

LTE CR TAIL Continuous Reception Tail is the inactivity

LTE DRX SHORT

timer after packets are sent, prior to DRX.

The Short DRX state indicates that the radio
is in a high bandwidth, high energy state,
looking for packets.
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RRC State

Description

LTE DRX LONG

WIFI ACTIVE

WIFI TAIL

WIFI IDLE

The Long DRX state is the LTE Talil. It
indicates that the radio is in a high bandwidth,
high energy state, looking for packets.

The WiFi transmitter is at full power - sending
and receiving information.

The WiFi Tail state is an inactivity timer after
packets are sent.

The Radio is in an idle state, with a small
trickle of power usage

* Network Type—indicates how long the device has been
connected to a particular network type, or if the network type
has changed during the trace. The network types that are
identified include GPRS, UMTS, HSDPA, HSPA, HSPAP,
HSUPA, Wi-fi, and LTE. For 5G, the following will the

displayed

o OVERRIDE_NETWORK_TYPE_LTE_ADVANCED
_PRO ->Advanced pro LTE (5Ge)

o OVERRIDE_NETWORK_TYPE_NR_NSA -> NR
(5G) -> 5G Sub-6 networks

o OVERRIDE_NETWORK_TYPE_NR_NSA MMWA
VE -> (5G+/5G UW) -> 5G mmWave networks

« Wakelock State—indicates whether the device is in the wake
state (active for user input) or the lock state during the trace.
Includes the number of times the wakelock state has been
changed from the plot point to the beginning of the trace.

+ CPU Usage—shows the total percentage of CPU usage for
each process followed by the name of each selected process
and the percentage of CPU that it is using (Figure). Although
the CPU Usage percentages for all the processes can be
viewed at once, this chart is most useful when only one
process is selected or when a small number of processes are
selected, because the changes between the data points is
more clearly visible.

* total: 66%
com.att.android.arodatacollector: 62%|__
top: 1%
system_server: 1%
| * other: 2%
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Note: It is possible that the percentages for individual
processes may not always add up to the total percentage.
This is because the process called top is a command that
pulls the information from different locations that may not be
completely in sync.

Alarm Triggered—indicates when an application has
triggered an alarm. Includes the type and timestamp of the
alarm, the name of the application that triggered it, and the
number of times it repeated.

Buffer Occupancy—provides an estimate on how much video
(in KB) has been downloaded into the buffer. This line is
populated after the video chunk startup is calculated (see
Video analysis section for details).

Video Chunks—displays the first frame of each chunk (for
videos without DRM) to indicate when the chunk download
started. If the chunk has DRM, or Video Optimizer cannot
parse the first frame, a placeholder image will be displayed.

1. Click a chunk thumbnail to open a dialog to “match” the
screenshot with the time it appears in the video (see
video analysis section for details).

2. Once the video has been matched with the screen video,
point to a video frame to display information about the
video playback.

Playback Buffer Occupancy—provides an estimate on how
much video (in seconds) is stored in the buffer. This line is
populated after the video chunk startup is calculated (see
Video analysis section for details).

CPU Temperature — displays the temperature of the device
for Android captures. The CPU temperature is captured
every 5 seconds and plotted.

CPU Temperatu..

Timeline 100 200

Temperature Info:
Temperature (C): 55

75
50

The chart also displays the thermal events that have
occurred over the duration of the trace, indicating where the
device may have overheated and throttled. The functionality
is available only for devices running Android 10 or above.
Thermal mitigation has become increasingly important and is
needed when a device starts to overheat.

U Teamperate..

Taatine.

e NO throttling -> Green color

e LIGHT throttling -> Blue color-> UX isn't impacted.

e MODERATE throttling ->Yellow color -> UX isn't greatly
impacted.

T "'“".
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e SEVERE throttling ->Magenta color -> UX is largely
impacted.
e CRITICAL ->Red color ->Platform has done everything
to reduce power.
¢ EMERGENCY -> Purple color -> Key components in
the platform are shutting down due to thermal
conditions.
e SHUTDOWN -> Black color -> Shutdown immediately.

Please refer to the link below for additional information -
https://source.android.com/devices/architecture/hidl/ther
mal-mitigation
The thermal status is displayed on the device during trace
collection —

1218 & 5IR 5" 497%0

Tue, Jun 15 -]

000

Alerting notifications

Devices

g

Data warning
You've used 5.60 GB of data

SportsCenter

a
AT RO Y\dc?‘unx\mvzcv V’F‘N Collector T

Account action required t8630@gmail corr
Did you sign in? A new device accessed your acc

Silent notifications

"] 8 AM
SportsCenter Inside CPU Temperature: 59 C

Severe throttling. UX is largely impacte

(]

Thermal status: Severe throttling. UX is
largely impacted.

Watch Now

Notification settings ~ Clear

° Diagnostics Tab Tables

The TCP/UDP Streams table in the Diagnostics tab has rows
of TCP or UDP session data that correspond to trace points
in the Diagnostics chart.

1. Select or deselect the rows of TCP or UDP data and click on
the Refresh button next to the TCP/UDP Streams table to
narrow the trace data that appears in the Diagnostics chart.
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2. Click the check box in the title row to select or deselect all of
the TCP and UDP data.

TCPIUDP Streams

Time: Domain Name Local Port Remote IP Remote Port Byte Count  Packet Count Protocol  Round Trip
50548 ] 80 81298932 (8143 TCP 0.001 ~
24368 3 75903935 (3380 TCP 0.002
44486 E 80 73939730 [5461 TCP 0,001
24488 E 80 42359300 3243 TCR 0.002
46136 ] 80 37359550 |4476 TCP 0.001 1
36500
54362
59216
56008
45288

493,867
439,336
358,321
358.324
278.09%
833,626
515,501
21,169

695.615
22.937

80 26659277 |1710 TP 0,001
3 20353589 [2722 TCP 0,001
a0 18534894 (2010 TCR 0,001
80 18098595 1429 TCR 0.001
3 9327584 520 TCP 0.001

HNHEERQERE &

The TCP/UDP Streams table contains the following columns
of information. These columns are sortable.

Column Description

Time The amount of time (in seconds) from the
beginning of the trace when this request was
made.

Domain Name | The name of the domain to which the request
is being made. When loading traces, Domain
information is populated by prioritizing DNS
gueries already present in the traffic file rather
than current network data (Reverse DNS of
Session Remote IP). This is so that the data
reflects information at the time of collection
rather than DNS changes that may have
happened since then.

Local port The local port through which the request is
being made
Remote Ip List all the remote IP server addresses.

Support for IPV4 and IPV6. Supports parsing
IPV6 headers and all different formats of IPV6

representations.

Remote Port The number of the remote port (on the
domain) through which the request is being
received.

Byte Count The number of bytes in the TCP/UDP Stream.

Packet Count | The number of packets in the request.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide



((

AT&T Entertainment Experience Suite Video Optimizer User Guide

Column Description

Protocol Indicates whether the TCP or UDP or QUIC or
DNS or STUN protocol was used. The highest-
level protocol will be the entry in the protocol
column. For example, TLSv1.3 is a higher
level than TCP, so if a TCP stream has
TLSv1.3, the TLSv1.3 will be displayed. If a
stream started before the trace capture
started, then not enough information is
available to determine the protocol and it will
be displayed in lowercase.

RTT(Round RTT time is calculated by SYNC and ASYNC

Trip Time) time displayed in the Packet view. The
calculated value is displayed in the TCP/UDP
streams.

Note — Additional functionality — double clicking on the session
will bring up a dialog box. The SNI is populated for TCP, and
UDP/QUIC sessions where the data is available. This data is
select-able for copying, but not editable.

| £+ Server Name Indication Dialog x

Serwver IP: 172.217.11.170
Server Name Indication: notifications-pa.googleapis.com
Byte Count: 7565

z

A second table below the TCP/UDP Streams table has tabs
that let you change the data view in four different ways:
Request/Response (default view), Packet, Content View and
Delay.

The Request/Response View tab displays the
request/responses associated with the selected row highlighted
in the TCP/UDP Streams Table.

ReQuEstRESpOnse VW Podetlen Conlend Vew Deay.

e Dreckn ReqType/Stans st ame Content Type Obct Nane Content Lengih Onire HITP Compressn
.10 FEQUEST ] pay.guoge.con £
. 1 FESOIGE o] =

Column headings in the Request/Response View have different
meanings (separate by a “/” in the column name) depending on
whether the row contains a request or a response.
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Column Description

Time The time of the request or response, in seconds, from
the beginning of the trace.

Direction The direction of the TCP stream (REQUEST or
RESPONSE)

Req HTTP request type (GET, PUT, POST, or DELETE) or

Type/Status the HTTP status of the response (such as 200 for OK
or 404 for resource not found).

Host The host name for the HTTP request or the content

Name/Content | type of the response. Content type consists of a pair

Type of values (type/subtype) representing the Internet
media type, for example, text/plain (simple text
messages), text/html (HTML document), text/CSS
(cascading style sheet), image/gif (GIF Image),
image/jpeg (JPEG Image), application/JSON (JSON
data object).

Object The name of the object requested from the host or the

Name/Content | length, in bytes, of the response.

Length

On Wire The number of bytes on the wire during this request or
response.

HTTP This column is only used for responses with a text

Compression

MIME type. If the response contains a text file, this
column indicates if HTTP compression was used or if
there was none. BR and gzip Compression are
triggered under HTTP Compression.

1. Select one of the rows from the Request/Response
View tab that has a response.

2. Click View to display the data object in the response.
For an image, the image will be displayed in the Content viewer
(Figure). If the data object is text, HTML, or JSON it will be
displayed in the Content viewer (Figure).
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fideo Optimizer

File Profile Tools View Data Collector Help

Best Practices/Results Overview Diagnostics video Statistics Waterfall
Date : Mon Mar 15 13:23:54 PDT 2021 Down link Throttle : NiA

Up link Throttle : NIA
Total Byt

Network Type(s) : Advanced pro LTE

: 18190462 Profile : AT&T LTE

|£] Content viewer [m] X

>
TCP/UDP Streams
Time Domain Name Local Port Remote IP Remote Port Byte Co... Packet Count Protocol Round...
184.347 M a184-28-154-140.deploy.static.akam... 45566 184.28.154.140 5905 24 TCP 0.01 ~
| & 55 54.140 306170 Js3 ______TCP___[0.002 |
184.984 M ec2-34-250-237-172.eu-west-1.com... 38094 34.250.237.172 443 6066 29 TCP 0.001
184.986 M a184-28-154-140.deploy.static.akam... 45578 184.28.154.140 443 4398 23 TCP 0.001 3 @
185.079 M server-13-224-13-133.sea19.r.cloudf... 40928 13.224.13.133 443 17886 23 TCP 0.001
185.797 M ec2-34-250-237-172.eu-west-1.com... 38106 34.250.237.172 443 2583 21 TCP 0.003
185.801 M ec2-34-250-237-172.eu-west-1.com... 38108 34.250.237.172 443 2583 21 TCP 0.008
185.898 M a184-28-154-140.deploy.static.akam... 45596 184.28.154.140 443 4434 23 TCP 0.007
185.906 || a184-28-154-140.deploy.static.akam... 45598 184.28.154.140 443 4437 23 TCP 0.003 hd
Request/Response View Packet View Content View Delay
Time Direction Req Type/Status Host Name/Content... Object Name/Conte... On Wire HTTP Compression View
184.976 REQUEST chef.bbei.co.uk /news/976/cpsprodp... 600
REseonce mag/peg o7 T —
186.199 REQUEST ichef.bbci.co.uk /images/ic/1376x77... 569
186,357 RESPONSE 200 image/jpeg 112944 105822
195.926 REQUEST GET ichef.bbci.co.uk /news/976/cpsprodp... 598
195.981 RESPONSE 200 image/png 188 866
196.125 REQUEST GET ichef.bbci.co.uk /news/976/cpsprodp... 609
196.186 RESPONSE 200 image/png 123785 120828

Video Optimizer

File Profile Tools View Data Collector Help

Best Practices/Results Overview Diagnostics Video Statistics Waterfall
Date : Mon Mar 15 13:23:54 PDT 2021 Down link Throttie : N/A

Up link Throttle : \WA
1 Total Bytes : 18190462

Network Type(s) : Advanced pro LTE
Profile : AT&T LTE

|2/ Content viewer - [m] x

<!DOCTYPE html><html class="no-js"><head><meta content="IE=edge,chr A
ome=1" nttp-equiv="X-UA-Compatible"><meta charset="utf-§"><meta con
tent=rtext/Atml" ACTp-equiv="Content-TYDE"><NMEta NaNMe="ViEWport" oo
ntent="uidch=device-width,
ink rel="dns-prefetch" href="/optimizelyjs/131788053.3s" /><link re
1="dns-prefetch” href="//tpc.googlesyndication.com” /><link rel="dn
s-prefecch" href="//pagead2.googlesyndication.com” /><link rel="dns
-prefetch” href="//wiw.googletagservices.com” /><link rel="dns-pref
etch™ href="//partner.googleadservices.com” /><link rel="dns-prefet
ch" nref="//wwi.google.com" /><link rel="dns-prefetch" href="//aax.
amazon-adsystem.com” /><link rel="dns-prefetch” href=r//c.amazon-ad
system.com" />clink rel="dns-prefecch” href="//cdn.krxd.net” /><lin
k rel=rdns-prefectch” href="//ads.rubicomproject.com” /><link rel="d
ns-prefetch” href="//optimized-by.rubiconproject.com” /><link rel="
dns-prefetch" href="//fastlane.rubiconproject.com" /><link rel
dns-prefetch” href="//fastlane-adv.rubiconproject.com” /><link re
1="dns-prefetch” href="//ib.adnxs.com”/><link rel="dns-prefetch” hr
/prebid.adnxs.com”/><link rel="dns-prefetch" href="htip://segm
ent-data-us-east.zgtk.net/turner-47£cf6" /><link rel="dns-prefetch”
href="//static.yisldmo.com” /><link rel="dns-prefetch” href="//w.u

initial-scale=1.0, minimum-scale=l.0"><l

v

>
TCPIUDP Streams.
Time Domain Name Local Port  Remote TP Remote Port Byte Co... Packet Count Protocol Round...
82.018 | |v| [2a01:7e00:0:0:f03c:01ff:fe70:2b0d (30162 |2aD1:7e00:0:0:f03c:01fF:fe70:2b0d 443 4137 28 TCP 0.002 | A
82.920 || 2a01:7e00:0:0:f03c:91ff:fe70:2b9d 39164  2aD1:7e00:0:0:f03c:91fF:fe70:2b0d 443 TCP 0.002
91.461 | || server-13-224-10-65.sealS.r.cloudfr... 43502 13.224.10.65 443 TCP 0.001
|| 151.101.1.67 40468 151.101.1.67 443 TCP 0.002 »@
N
93.374  |v| 151.101.1.67 40476 151.101.1.67 443 TCP 0.002
93.376 | |v| sfon3s08-in-f2.1e100.net 47136 172.217.6.34 443 TCP 0.002
93.582 | |V server-99-86-36-75.seal9.r.cloudfro... 44116 99.86.36.75 443 TCP 0.003
93.680 | || [a184-28-155-197.deploy.static.akam... 40612 184.28.155.107 443 TCP 0002 v
Request/Response View Packet View Content View Delay
Time Direction Req Type/Status Host Name/Conten... Object Name/Cont... On Wire HTTP Compression View
93.781 REQUEST. wavave.cnn. com / A~
9 RESPONSE text/html 15876 qzi
94.093 REQUEST GET WWW.CNIN. COM /.a/2.258.3/js/cnn-
94.158 RESPONSE 200 application/javascript 378189 azip
94.334 REQUEST GET Joptimizelyjs/13178... | 2658
04 207 RFSENNSF 200 tevtliavacrrint 176010 114580 azin

3. Click Save As to save the object as a file in the specified

directory.
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(Note that the View and Save As buttons are not available
for Requests).

BB AT&T Video Optimizer - O X
File Profile Tools View Data Collector Help
Best Practices/Results Overview Diagnostics Video Statistics Waterfall
Date : Mon Mar 15 13:23:54 PDT 2021 Down link Throttle : N/A Up link Throttle :N/A Network Type(s) : Advanced pro LTE
190462 Profile :AT&T LTE
Save As x B
Savein: | Saved Pictures v e
2
]
=
Recent Ttems
Desktop
Documents
This PC
@ File name: _117583299_066126243-1
Network iies of type: | file Chooser.contentDisplayType jpg:failed = Cancel
I e
[< >
TCP/UDP Streams
Time Domain Name Local Port Remote IP Remote Port Byte Co... Packet Count Protocol Round...
184.347 M alE4-28-154-14[|.dep\uy.slat\c.akam... 45566 184.28.154.140 443 5905 24 TCP 0.01 ~
| M |a184-28-154-140.deploy.static.akam. . [45572___[184.28.154.140
184.984 M ec2-34-250-237-172.eu-west-1.com... 38094 34.250.237.172 443 6066 29 TCP 0.001
184.980 M 3184-28-154-140.deploy.static.akam... 45578 184.28.154.140 443 4398 23 TCFP 0.001 » o
185.079 M server-13-224-13-133.seal9.r.cloudf... 40928 13.224.13.133 443 17886 23 TCP 0.001
185.797 M ec2-34-250-237-172.eu-west-1.com... 38106 34.250.237.172 443 2583 21 TCP 0.003
185.801 M ec2-34-250-237-172.eu-west-1.com... 38108 34.250.237.172 443 2583 21 TCP 0.008
185.898 M 3184-28-154-140.deploy.static.akam... 45596 184.28.154.140 443 4434 23 TCP 0.007
185.906 ‘Jl 2184-28-154-140.deploy.static.akam... 45508 184.28.154.140 443 4437 23 TCP 0.003 v
Request/Response View Packet View Content View Delay
Time Direction Req Type/Status Host Name/Content... Object Name/Conte... On Wire HTTP Compression View
184.976 REQUEST GET ichef bbci.co.uk /newss/076/cpsprodp... 600
SEsponse T si07o T
186.199 REQUEST GET ichef.bbci.co.uk fimages/ic/1376x77... 569
186.357 RESPONSE 200 \mage/]peg 112044 105822
195.926 REQUEST GET ichef.bbei.co.uk /news/976/cpsprodp... 598
195.981 RESPONSE 200 image/png 88 866
196.125 REQUEST GET ichef.bbei.co.uk /news/976/cpsprodp... 609
196.186 RESPONSE 200 image/png 123785 120828

If the object cannot be displayed, an error message will
indicate that the content was unable to be viewed because it
may be corrupted.

The Packet View tab shows information about the individual
packets associated with the selected TCP or UDP stream
(Figure).

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide



&
N—

AT&T Entertainment Experience Suite Video Optimizer User Guide

3 AT&T Video Optimizer — [m} X
File Profile Tools View Data Callector Help

Best P Overview | Di Video Statistics Waterfall
Date: Mon Mar 15 13 2364 PDT 2021 Down link Throttle : N/A Up link Throttle : N/A Network Type(s) : Advanced pro LTE
Trace:] oot Total Bytes : 18190462 Profile : AT&T LTE
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RRC States } ; : ] ‘ ; L . ] , ; ‘
Timeline o 25 50 75 100 125 150 175 200 225 250 275 300 325
< >
TCPIUDP Streams
Time Domain Name Local Port  Remote IP Remote Port Byte Co... Packet Count Protocol Round...
184.347 M 3184-28-154-140.deploy.static.akam... 45566 184.28.154.140 5905 24 TCP D I]l ~
0 ...|45572_1184.28.154.140 __
184.984 M ec2-34-250-237-172.eu-west-1.com... 38094 34.250.237.172 6066 EI 001
184.986 M a184-28-154-140.deploy.static.akam... 45578 184.28.154.140 443 4398 23 TCP 0.001 » o
185.079 M server-13-224-13-133.seal9.r.cloudf... 40928 13.224.13.133 443 17886 23 TCP 0.001
185.797 M ec2-34-250-237-172.eu-west-1.com... 38106 34.250.237.172 443 2583 21 TCP 0.003
185.801 M ec2-34-250-237-172.eu-west-1.com... 38108 34.250.237.172 443 2583 21 TCP 0.008
185.898 M 3184-28-154-140.deploy.static.akam... 45596 184.28.154.140 443 4434 23 TCP 0.007
185.906 || a184-28-154-140.deploy.static.akam... 45598 184.28.154.140 443 4437 23 Tcp 0.003 v
Request/Response View Packet View Content View Delay
™ Time Direction Type Payload Length TCF Flags
184.551000 UPLINK [TCP_ESTABLISH _

10624 184.553000 DOWRNLINK TCP_ESTABLISH
10625 184.650000 UPLINK TCP_ACK A
10626 184.650000 UPLINK TCP_DATA 517 AP
10627 184.650000 DOWNLINK TCP_ACK 0 A
10640 184.811000 DOWNLINK TCP_DATA 2361 AP
10653 184.870000 UPLINK TCP_ACK 0 A
10656 184.871000 UPLINK TCP_DATA 93 AP

The following table describes the columns of data in the Packet
View tab.

Column Description

ID An integer value that uniquely identifies each packet
within the trace.

Time The time, in seconds, from the beginning of the trace

Direction The packet direction. One of the following values:
UPLINK (The packet is sent up to the server),
DOWNLINK (The packet is sent down from the
server/host), UNKNOWN (The packet direction
cannot be determined).

Type Indicates the type of packet. One of the following
values: OPEN_CONN (A packet that opens a
connection), ACK (An acknowledgement packet),
DATA (A data packet).

Payload The length of the payload (the data being sent in the

Length packet) in bytes.
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TCP Flags Each letter in this field represents a different TCP
flag associated with the packet. More than one flag
can be associated with a packet. The possible flags
are: AS - Ack; P - Push; R - Reset, S - Synchronize,
F - Finish/End, E - Echo, U - Urgent, C - Congestion
Windows Reduced.

The Content View tab displays the content of the HTTP
request/response (Figure). All Request and Responses will
show in the same order as in Request/Response View. It has
a Search field to the right of the content window, in which you
can enter a search string. All instances of the string will be
highlighted in the content window and the Find Next button can
be used to navigate through the instances. The Content view is
not editable.

AT&T Video Optimizer - a X
File Profile Tools View Data Collector Help
Best Pr 5/ Overview DI Video Statistics Waterfall
Date : Mon Mar 15 13:23:64 PDT 2021 Down link Throttle : N/A Up link Throttle : N/A Network Type(s) : Advanced pro LTE
Trace:. . . S Total Bytes : 18190462 Profile : ATE&T LTE
-
Network Type
Throughput (kb..| 5.000 i “
i J [V AN 4/U\’\_/\_M /J m\_A_A_J\
) DY | S L . /N | ORI S -
002 H
Latem i
e | R
000 — ,mmv—&—\ Q
pcasts |11 I AN T VY 5
O W1 7 AT OO AT AR AR
soss | IO | O O I v () 1]
werew || (I [V L0 L IHIMI IHI I T AN 1
RRC States ‘
Timeline
< >
TCP/UDP Streams
~
Time 1 pomain Hame Local Port  Remote IP Remote Port Byte Co... Packet Count Protocol Round...
93.273 || 151.101.1.67 40468 151.101.1.67 493799 77 TCF 0. UUZ ~
9 | 9 151.101.1.67 40470 __[151.101.1.67 _ c
93.374 [v] 151.101.1.67 40476 151.101.1.67 23254 24 TCP D 002
93.376 [v| sfon3s08-in-f2.1e100.net 47136 172.217.6.34 443 24088 33 TCP 0.002 v
Request/Response View Packet View ContentView pelay
~ || search...
~-UPLINK--
GET / HTITP/1.1 Find Next

Host: www.cnn.com
Connection: keep-alive

ication/uml;qg=0.9, image/webp, image/apng, */*;q=0.5,application/signe

age: en-US,en;g=0.9
okie: FastAB=0=2227,1=2015,2=9313,3=9148,4=2778, 5=5385, 6=0300,7=1094, 8=3756, 9=1600; psmRetryExternallds=false ¥

Delay: Displays the delay associated with a response corresponding to
each request in a trace. Below screenshot displays the fields added:
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REqust/REsp;mEV\Ew Packet View Contentview Delay =
Request Time stamp First Packet Arrival Time First Packet Delay Last Packet Arrival Time Last Packet Delay Content Length
93.781 93.825 0.044 93.971 0.18 158763 ~

94.093 94.158 0.065 94.259 0.186 378189
94.334 94.393 0.059 94.436 0.102 126919
96.214 96.311 0.097 96.311 0.097 6777
7242 35t Tos 5 i 20575
98.538 100.651 2,113 100.651 2.113 27949
Column Description
Request Time This field represents the timestamp of the
stamp first TCP_DATA packet in a given request
First Packet This field represents the timestamp of the
Arrival Time first TCP_DATA packet in a corresponding
response.

First Packet delay | Difference between the First Packet Arrival
Time and the Request Time stamp

Last Packet This field represents the timestamp of the
Arrival Time last TCP_DATA packet in a corresponding
response

Last Packet delay | Difference between the Last Packet Arrival
Time and the Request Time stamp

Content Length Displays the size of the response in bytes

Export TCP/UDP: Right click on the tcp/udp table to export the table. All
the columns including the SYN and SYN ACK Times for the Round Trip
Time are exported to an excel file and saved by default in Trace Folder
location. The default naming convention for the exported file is
<Trace_Folder_Name>_diagnostics_tcp_udp_streams.

5.2.4. Video Tab
The Video tab breaks down the video usage during the data
collection. This feature helps you understand how your
application downloads video. If you have a trace with video
collected, you will see this tab populated with Segment
Throughput graph, Segment Progress graph, Segment Buffer
graph, Video Stream, and Video Requests.

o Segment Throughput graph:

This graph is enabled when at least one stream is selected in the
case where there are multiple streams present. However, if the
trace has only one stream then the graph is displayed as soon as
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the user loads the trace. Based on the type of stream that has

both audio/video or Muxed, the graph will be displayed with the
headers below.

Audio/Video Stream Segment Throughput graph:

Segment : 6
4 Track:9

H DL Start Time : 32,135
R DL End Time : 32.93s

281 Duration : 5.005s
24 Throughput (MB/s) : 5.75| _—
. —
i ' - < —
' . ‘L)l-/“ . ! T W T~ - ‘/’- \s_
o} A . ] - S —
A o a4 e 1 e ma 7 T ) o 3
<

. Stream Examples

If Video Optimizer can read the movie stream, it will break
down the observed videos into tables.

Video Stream !

O | stream -0970- 4/94900713-293, o

5_corrected.mpd, segment count.79 |  Set StartupDelay [V] video  [/] Audio

O | Stream2: dm_210223_SVP_on_Tiger_crasnidm_210223_SVP_on_Tiger_crash.smilimaster.m3u6, segment count10 | SetStartupDeiay

Click the arrow ——! for one of the Streams to expand the
Audio/ Video segments table with each segment that is
observed from that Stream.

Figure above shows that Audio/Video segment number from
0-19 in Video and 0-20 in Audio. In the table, Segment
number 0 was downloaded with Audio Track 0 and Video
Track 2. When user double clicks on any of the segment row
then user will be taken to diagnostic tab.
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When audio and video are sent separate from each other
(demuxed) there will be separate tables for video & audio.
You can view partial details of video & audio side by side or
uncheck one or the other to see full details.

Export: Clicking on Export, exports the details of all the streams. The
exported data is saved in .xlIsx file. The default naming convention for
the file is <Trace_Folder_Name>_video_streams. In the file, the first
column of the first line will be "Name" and the second column of the first
line will be the actual "Stream Name". The sheet names will correspond
to Stream numbers like Stream 1, Stream 2, and so on. For CSV export,
"Stream<Number>" is added on the line above the Stream Name. In the
case of Video, and Audio tables present for a stream, the excel sheet
displays the Video table information above the Audio table information.
In the case of Muxed video, the information is displayed under the video
table.

Save As X

Save in:
=
ik

Recent Ttems

Desktop

Documents

L

This PC

L} File name: [table]

Network

Save

Files of type:  Excel Workbook (*.xi¢) v Cancel

You may see a message indicating Video Optimizer observed
a gap in the segments, based on one or more missing
records in the list of sequential segments. This message is
primarily informational. There are many reasons a gap may
have occurred, and it might not signal a problem. Refer to the
screen shot below.

Audio Segments:
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Video Segments:

1 2 St 605715 5550700407458 08 1647100051 T30 C_CTUCkS M S8MAnt COPE 111 D [ Starep Dotsy: 1275

daEgdad

FEEREEEE

MUXED(Audio/Video):

£ =) Stwam: 10/Siomgan_Grourc_Eo_ 4 20210310 1013305024078 mathe bt compete_aeevmoed vt segrment count 30

fESEZEEEEfEEEIEiEEEEEEE

The Diagnostics tab reveals that the segments from Figure
are not actually movie segments, but an entire Mp4 video

advertisement.
282.321  COES RV packet View  Content View
‘ Time Direction Req Type/Status Host Name/Cont... Object Name/Co... On Wire HTTP Compressi...
1277.476 REQUEST GET cdn09dlId.uvers... /m/1/372496/... 0
|282.321 RESPONSE 200 video/mp4 3120740 3120740

‘ S

This ad was downloaded twice during the trace (possibly due
to slow network connectivity). A full 3 MB file that is
downloaded twice can add significant delay to the end user
(and it does appear as a failure in the duplicate file best
practice). Video Optimizer uses the Stream and a URL
parsing method to retrieve the values that are displayed in
the Video tab.

o Video Request Examples
The last chart in the Video tab, Video Requests, is a list of all
the URLs that are used in video requests:
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v _|Video Requests

Request URL
http://directvist.vo.linwd.net/el/livetv/30/8249/03/20170424T203725129.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/01/20170424T203742852.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/01/20170424T203749206.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/01/20170424T203757015.ts?p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/02/20170424T203757015.ts?p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/02/20170424T203805887.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/02/20170424T203813500.ts?7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/02/20170424T203821682.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http://directvist.vo.llnwd.net/el/livetv/30/8249/02/20170424T203830828.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.llnwd.net/el/livetv/30/8249/02/20170424T203837641.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/02/20170424T203845656.ts?p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/02/20170424T203854671.ts?p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.llnwd.net/el/livetv/30/8249/02/20170424T7203901283.ts?p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.llnwd.net/e1/livetv/30/8249/02/20170424T7203909299.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.linwd.net/el/livetv/30/8249/02/20170424T203917002.ts?p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.llnwd.net/el/livetv/30/8249/02/20170424T203927188.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http:/ /directvist.vo.llnwd.net/el/livetv/30/8249/02/20170424T203935947.ts7p=43&e=1493080688&h=abdf871b3e04fb0ad72ef9
http://cdn09did.uverse.com.edgesuite.net/m/1/372496/59/2646587/Whatever_It_Takes_30_1489375254_165772_113.mp4
http://cdn09dld.uverse.com.edgesuite.net/m/1/372496/59/2646587 /Whatever_It_Takes_30_1489375254_165772_113.mp4
http:/ /directvaav.vo.llnwd.net/e5/aav/30/B002332115U3/HLS2/8002332115U0_2_0.ts?p=40&e=1493080951&h=520e887c80110a
900

http:/ /directvaav.vo.linwd.net/eS5/aav/30/B002332115U3/HLS0/B002332115U0_0_1.ts?p=40&e=1493080951&h=520e887c80110a
900

http:/ /directvaav.vo.linwd.net/e5/aav/30/B002332115U3/HLS0/8002332115U0_0_2.ts7p=40&e=1493080951&h=520e887c80110a
900

http:/ /directvaav.vo.llnwd.net/e5 /aav/30/B002332115U3/HLS0/B002332115U0 0 3.ts7p=40&e=1493080951&h=520e887c80110a"

5.2.5. Flows Tab

The Flows tab displays individual flows and the analysis of the network flows.
The information in the Flows tab is divided into the following sections —

e Flows Graph
e Flows Table
e Flows Summary

o Flows Graph

The Flows Graph displays the throughput for each individual flow group
in a different color. The graph for each of the flow groups can be hidden
or displayed by right clicking in the Flow Group column in the Flows
Table and selecting Toggle Group. This can also be done for individual
flows within a group by checking or unchecking the checkbox for that
flow in the Flows Table.

Ll DAUANDDNDNUHU AV, A o

T W 1 £ " E

The X-axis displays time in seconds, and Y-axis displays the total
throughput (download+upload) in kbps. The graph will display multiple
(overlapping) lines for each set of data plots. Each will have a unique
color. The sum of ALL traffic, including traffic not included in any flow
group, can be displayed by right-click selecting “Toggle Background”.
Sometimes the other flow groups will completely overlap this gray
colored graph. When no flow is selected, the graph is will be blank.
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Clicking on a position in the chart will sync the video player to the
timestamp of the click, like it does on the Diagnostics tab. While video is
playing the hairline will move synchronously.

. Flows Table

Flows table will show individual flows, also known as sessions or
streams.

Flaws

T-0141
T-0142
T-0140
T0273
T-0272
T-0301
T-0270
T-0271
T-0085
T-0094
T-0109
T-0105
T-0092
T-0126
T-0106
T-0095
T-0107
T-0084
T-96

Faws  Tims #  Domain o1

48.716 8 sdk.iad-06.braze.com

48.999 B sclkiad-06 braze.com

47.560 8 sck.iad-06.braze.com
263.013 (8 23.32.75.158

B 23.32.75.158
280,066 (8 23.32.75.158
261,508 [ 23.32.75.158
262,608 [ 23.32.75.158

i

Remota I ByteCoust  Peemi Avengekbps  Pukklps  Active

151.101.1.180 2674430 13.88 78175

233275158 1999201 10.37 234129 1921408 400
23.32.75.158 1356401 6.52 328793 2291144 4.00

L LG LG gm
B

232756 766 0.00 0407 8752 1.00
AT w0 0704 5.788 1.0

The flows table will have the following columns —

Flow # - Prefix ‘T-* is for a TCP stream and ‘U-‘ is for a UDP
stream and the number following the prefix is the stream number.
Time — Flow start time

Checkbox — adds or removes a flow from the graph and summary
sections

Domain

SNI — Server Name Indicator

Flow Group — Selected flows will have a color and a group name
indicating what flow group the flow belongs to. Flows are auto
detected and grouped.

= Starting with the largest flow, the remaining flows will be
searched for a match with SNI, Domain name, or remote
IP address, in that order.

» Sorted flows are then scanned through for the first or the
next unassigned flow. Scanning flows that are not
assigned to a flow group continues until flows have no
payload, or all of the default flow groups have been
assigned.

» All matching flow groups with less than 1 percent of total
trace traffic will be dropped unless 're-assign without limits'
option is chosen. In that case, the flow groups below 1%
will be retained.

» Group fields can be changed to match group number of
other flows.

Label — blank until user defined

Remote IP

Byte Count

Percent — percentage of total trace traffic

Average kbps

Peak kbps - highest bitrate in a time period

Active — time from start of bitrate exceeding the minimum active
bitrate until the bitrate falls below a defined bitrate

Protocol — TLS, UDP, QUIC, etc
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151.101.1.190 3054755 15.85 89200 1163320 500 T
816.544 600 TCP
151.101.1.190 15475 0.08 0450 77.304 200 T

2332756 247151 126 79.511 669,344 200 T
23.32.75.6 61088 0.32 31277 512376 200 TCP
2332756 6066 0.03 3.083 56.144 100 T

23.32.75.158 913674 4.74 142.447 986,544 400 T
2332.75.158 20067 0.11 2742 58648 300 T
23.32.75.158 3077 0.02 0.530 38.016 100 TR
232756 621945 3.23 155.656 1211688 200 T
2332756 562618 2.2 194241 1156.888 200 T
2332756 439870 2.28 25203 1394224 3.00
2332756 207689 1.54 103157 1561672 1.00
23.32.75.6 280222 145 107.083  2175.792 2.00
233275.34 252348 131 15498 977.006 400 T
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The column widths are adjustable, and the column positions in the table
can be changed. Rows are initially auto sorted by Flow Group and each
checkbox is checked for display. User can uncheck the box to temporarily
hide the flow from the chart and summary. Changing the checkbox in the
flows table will not change the selections in the Diagnostic tab.

There are two different popup menus within the Flows table. One is for the
Flow Group column and other is for all other columns.

Starting with all other columns, select any row and right click on any cell
other than a Flow Group cell.

Fiowe T 4 Deman a1 Flew

v ok iad-06.bea2e. com
B8 sdk.iad-06. braze.com Assign selection to group
sdk.iad-06.braze,com =
23.32.75.158 Zoom

1 Boid

48.999
47500 B
263,014 §
263.013 B

280.066 B 23.32
261.508 £

Toggle Rows
Toggle Background

Clear rows selections

4
c
Export [4
c
3

A popup menu is displayed with the following options —

« Assign selection to group
o Row selection(s) highlighted in blue will be assigned to
the chosen group.
o FlowGroup dropdown chooser will appear in a dialog
along with an option to edit color.
o All row selection(s) will be assigned to a new flow
group regardless of their current group assignment.

o All selected rows will be zoomed into within the graph.
No flows will be bolded.

o Zoom will display the start-time through end-time of the
selection and the vertical height will be controlled by
the peak kbps of selected rows.

o If no rows are selected, Zoom will zoom out to the full
trace length, and height will be based on the peak total
throughput. Any previous bolding will be un-bolded.

+ Bold
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o All selected rows will toggle the line in the graph
between bold and un-bold.
Toggle Rows
o All selected rows that are in a flow group will toggle
their checkbox on/off.
o Each row is independently toggled off or on based on
its current checkbox status.
Toggle Background
o Toggles the background throughput in the graph. The
gray plot line in the chart will be displayed/hidden.
Clear rows selections
o All selected rows will lose flow group assignments if
they had an assignment.
Export
o Exports the graph, Flows table, and Flow Summary
table to a multi-tab xIsx file.

e Insert Pagelayout Formules Data Review View Automate Help

S

|ﬂnnnnnnnr\nnnnnnnr\

The exported xlIsx sheet will display the chart at the top. Below the
chart it displays the Flows table in the ‘Flows’ sheet and the Flows
summary table in the ‘Flow Group’ sheet. The spreadsheet is not
dynamically updating, unlike inside VO. For example: a checkbox
will be displayed for the selected flows, but changing the
checkboxes will not make any change to the rest of the
spreadsheet. Sometimes the column widths may be too wide and
the graph might not be completely visible. In those instances
reducing the column widths can bring the graph back into
complete view.

Flow Group Pop-up: Select any row and right click on a Flow Group cell.
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A popup menu is displayed with the following options —

» Edit color of FlowGroup

o Provides a selection of color choices.

o Select a color and click 'OK' to set the new color for all
flows within the named flow group, within the trace
only. Default colors will not be changed.

» Assign selection to group

o A FlowGroup dropdown chooser will appear with a
color editor.

o The rows selected will be added to the group selected
in the dropdown.

* Re-Assign a FlowGroup

o Based on the Flow Group cell that received the right-
click, and effecting all flows within that flow group

o A FlowGroup dropdown chooser will appear with a
color editor.

o The entire Flow Group selected will be added to the
group selected in the dropdown.

* Zoom Group

o Based on the Flow Group cell that received the right-
click, ignoring rows selected.

o This will Zoom the chart from start-time to end-time and
vertical height of peak kbps of flow group.

o Will also make the flow group be bold.

o To un-Zoom the group, you need to Zoom it a second
time.

* Bold Group

o Based on the Flow Group cell that received the right-
click, all the flows in that group will toggle to be bold or
not.

* Toggle Group

o Based on the Flow Group cell that received the right-
click, the reverse of that row will be applied to all Flows
within the Flow Group.
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o If de-selected the Flow Group will still remain as a Flow
Group, but temporarily disappear from the summary
table.
* Remove FlowGroups
o Based on the Flow Group cell that received the right-
click, all Flows will lose their Flow Group assignment.
o The Flow Group itself will vanish.
» Toggle Background
o Toggles the background (sum of ALL traffic) throughput
in the graph to be hidden or visible.
* Reset
o Deletes the existing FlowTableHistory.json
o Any color changes will revert to the defaults from the
user’s Library file.
o Re-creates default FlowGroup assignments.
* Re-assign with no limits
o Deletes the existing FlowTableHistory.json
o Re-creates default FlowGroup assignments
o Will assign Flow Groups until ALL of the Flows have
been scanned, or until VO runs out of Flow Groups to
assign.
o The 1 percent rule will be ignored.
o Flows with zero data will be ignored.
* Export
o Exports the graph, Flows table and Flow Summary
table as described above.

A file called FlowTableHistory.json is created and saved in the trace folder
when a trace is opened. This file will include a complete log of changes
since the file was created, and the current state of the Flows tab.
Choosing the option "Reset" or "Re-assign with no limits" from the
dropdown will delete and create a new FlowTableHistory.json.

. Flows Summary
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The Flows Summary table consists of the following columns —
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Flow Group

Flow Count - the number of flows in the group

Packet Count

Byte Count — is the sum of all flows in the group

Percent — percent of total bytes in the trace

Start — start time of the earliest flow within the Flow Group
End — last time stamp of all the flows within the Flow Group
Duration — difference between the Start and End time
Average kbps — Byte Count times 8 divided by Duration
Peak kbps — the highest combined throughput throughout the
Duration of the Flow Group

¢ Idle secs — idle time between flows of the Flow Group

Flows Summary table is sorted by the Byte Count of each Flow Group.

Sometimes the Flows Groups may appear to be out of order
alphabetically. This might happen when a flow grouping starts with a
relatively small byte count but with many flows culminates into a larger
flow group. It can also happen when some flows in a Flow Group are
deselected manually.

If the checkbox status changes in the Flows table on any of the flows
within a flow group, the values in the Flows Summary table will change. A
deselected flow is temporarily removed from the Summary calculations.

5.2.6. Statistics Tab

The Statistics tab displays key statistical information based on the
analysis of the loaded trace. The information on the Statistics Tab is
divided into the following sections:

* Header

* TCP(Session) Statistics

« Attenuator Simulation

« Endpoint Summary

*+ RRC(Radio Resource Control) State Machine Simulation
* Burst Analysis

+ HTTP Cache Statistics

» Energy Efficiency Simulation

. Export Button

The top right corner of the Statistics tab has an Export
button.
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|AT&T Video Optimizer Statistics

1. Click Export.

2. The default naming convention for the file is
<Trace_Folder_Name>_best_practices_results. Click Save
in the Save As dialog box to save all the data from the Best
Practices/Results tab as a .html file.

3. Click OK when the file has been saved or click Open to open
the file immediately. When you click Open, the export file will
be opened using the program that you have identified in
your OS as the default program for .html files.

) Header Section

The Header section of the Statistics tab displays information
about the trace that the statistics are derived from. The
information in the Header section is the same as in the
header of the Best Practices/Results tab.

The following table describes the information displayed in the
Header section:

Label Description
Date The date when the trace files were
generated.
Trace The name of the folder containing the
trace files.
Time Range The time range description name

followed by the time range that is used
to open the trace.

Application(s) Name: The names and versions of the
Version applications that were running when
the trace data was collected.
Data Collector Version The version of the Video Optimizer

Data Collector that was used to collect
the trace data.

Device make/model The make and model of the device
from which the data was collected.
Display Resolution The Orientation mode, and the Width

and height of the display from which
the data was collected.

OS/Platform Version The operating system version or
platform version of the device that the
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Label Description

trace was captured on.

Network type The type of network, like 3G or LTE,
which was in use when the data was
collected.

Carrier Name/Cell ID Carrier name, and the Cell tower ID

the device was connected to when the
trace was captured.

Profile The device profile that was used for
the trace analysis.
Secure True for a secure trace and False for

non-secure traces.

. TCP (Session) Statistics

The TCP (Session) Statistics section of the Statistics Tab
information page provides overall statistics about the TCP
Packet information captured in the loaded trace files. The
minimum, maximum, and average values for the captured
latency measurements are displayed. The values are
calculated only for sessions where session based latency is
available.

TCP(Session) Statistics

Duration of the packets analyzed (sec): 6420

Total Bytes: 217,617,795
TCP Packet Count: 26,282

Avg Rate (kbps): 27119
Minimum Latency: 0.001s
Maximum Latency: 0.065s
Average Latency: 0.004489 s

The following table describes the statistics contained in the
TCP (Session) Statistics section:

Field Description
Duration of the The time difference, in seconds, between the last packet
packets analyzed time stamp and the first packet time stamp in the loaded
(sec) trace.
Total Bytes The sum of the packet length values from the loaded

trace. The packet length value includes both the header
length and the data length.

TCP Packet Count | The total number of tcp packets in the loaded trace.

Avg Rate (kbps) The average transfer rate of data in kilobytes per
second. This value is derived from the total number of
transferred bytes and the trace duration.
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Field Description

Minimum Latency | Displays the minimum latency detected across all TCP
sessions in a trace.

Maximum Latency | Displays the maximum latency detected across all TCP
sessions in a trace.

Average Latency Displays the average latency for all TCP sessions in a

trace.
) ATTENUATOR Simulation
ATTENUATOR Simulation
Diown link Throttle: A
Up link Throttle: I
° Endpoint Summary Section

The Endpoint Summary section of the Statistics Tab information page
contains two tables that summarize the packet information for each
application, and for each IP Address. These two tables are:
e Endpoint Summary
Per Application
¢ Endpoint Summary
Per IP Address

o Endpoint Summary Per Application Table

The Endpoint Summary Per Application table summarizes the number
of packets, the total payload bytes, the percent of total payload bytes
in regards with the total bytes, and total number of bytes for each
application in the trace.

Endpoint Summary Per Application

Application Mame Packet Count Total Payload Bytes Percent Total Bytes
Unknown [27131 |216,992,922 99.36 218,391,178

The following table describes the statistics contained in the Endpoint
Summary Per Application table:
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Column Description

Application Name | The name of the application.

Packet Count The total number of packets for this application.

Total Payload The total number of payload bytes for this application.

Bytes

Percent The percent of total payload bytes in regards with the
total bytes for this application.

Total Bytes The total number of bytes for this application.

° Endpoint Summary Per IP Address Table

The Endpoint Summary Per IP Address table summarizes the
number of packets, the total payload bytes, the percent of
total payload bytes in regards with the total bytes, and total
number of bytes for each IP address in the trace.

Endpoint Summary Per IP Address
IP Address Packet Count Total Payload Bytes Percent Total Bytes
Unknown 18 1808 57.386 1,408 -
8.8.8.8 510 57,698 77.159 74,778
69.28.162.28 5225 63,553,299 99. 574 63,825,031
34.223.195.221 158 1,250,284 99,34 1,258,596
34.223.195.220 10 2,895 84,378 3,431
34.223.199.219 235 1,274,230 99.015 1,286,898
34.223.199.218 10 3,386 86,334 3,922
54.196.120.204 18 8,065 89.447 9,021 W

The following table describes the statistics contained in the
Endpoint Summary Per IP Address table:

Column Description

IP Address | The IP Address.

Packet The total number of packets for this IP

Count address.

Total The total number of payload bytes for this IP

Payload address.

Bytes

Percent The percent of total payload bytes in regards
with the total bytes for this IP address.

Total The total number of bytes for this IP address.

Bytes

. RRC (Radio Resource Control) State Machine Simulation

The RRC (Radio Resource Control) State Machine
Simulation section of the Statistics Tab information page
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displays an analysis of how much time was spent in the
various RRC states.

Note: The names of the RRC states and the information
displayed in this section depend on the type of device profile
that is selected (3G, LTE, or WiFi).

When a 3G device profile like AT&T 3G is selected, then the
section appears like the following:

RRC(Radio Resource Control) State Machine Simulation

DCH {Active): 60.12 (45.30%)
FACH (Standby): 42.70 (3217%)
IDLE: 21.73(16.37%)
IDLE-=DCH (Active): 4.83 (3.64%)
FACH (Standby)->DCH (Active): 3.34 (2.52%)
DCH (Active) Tail Ratio: 0.47

FACH (Standby) Tail Ratio: 0.41

Promotion Ratio: 0.08

The following table describes the statistics contained in the
RRC (Radio Resource Control) State Machine Simulation
section when a 3G device profile like AT&T 3G is selected:

Field

Description

DCH
(Active)

FACH
(Standby)

IDLE

IDLE->DCH
(Active)

FACH
(Standby)
- DCH
(Active)
DCH
(Active) Tall
Ratio
FACH
(Standby)
Tail Ratio
Promotion
Ratio

The amount of DCH (Active) state time, in seconds,
and its percentage of total packet duration.

The amount of FACH (Standby) state time, in
seconds, and its percentage of total packet
duration.

The amount of IDLE state time, in seconds, and its
percentage of total packet duration.

The amount of time spent in promotion from the
IDLE state to the DCH (Active) state, in seconds,
and its percentage of total packet duration.

The amount of time spent in promotion from the
FACH (Standby) state to the DCH (Active) state, in
seconds, and its percentage of total packet
duration.

The ratio between the amount of DCH (Active) Talil
state time and the amount of DCH (Active) state
time.

The ratio between the amount of FACH (Standby)
Tail state time and the amount of FACH (Standby)
state time.

The ratio between the sums of the total promoted
RRC states time and the total packet duration. The
promoted RRC states are IDLE->DCH (Active) and
FACH (Standby) ->DCH (Active).
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When an LTE device profile like AT&T LTE is selected, then
the section appears like the following:

RRC(Radio Resource Control) State Machine Simulation

0.78 (0.59% oftime)
16.07 (12.11% oftime)
11.30 (8.51% oftime)
2.17 (1.64% oftime)
89.70 (67.58% oftime)

IDLE-=Continuous Reception:
Continuous Reception
Continuous Reception Tail:
Short DRI

Long DRX:

IDLE: 24.00 (18.08% oftime)
Continuous Reception Tail Ratio: 0.70
Long DRX Ratio: 0.02
Short DRX Ratio: 0.84
Promotion Ratio: 0.0

The following table describes the statistics contained in the
RRC (Radio Resource Control) State Machine Simulation
section when an LTE device profile is selected:

Field Description

IDLE- The amount of time spent in promotion from

>Continuous | the IDLE state to Continuous Reception, in

Reception seconds, and its percentage of total packet
duration.

Continuous The amount of Continuous Reception state time, in

Reception seconds, and its percentage of total packet
duration.

Continuous The amount of Continuous Reception Tail state

Reception time, in seconds, and its percentage of total packet

Tail duration.

Short DRX The amount of Short DRX state time, in seconds,
and its percentage of total packet duration.

Long DRX The amount of Long DRX state time, in seconds,
and its percentage of total packet duration.

IDLE The amount of IDLE state time, in seconds, and its
percentage of total packet duration.

Continuous The ratio between the amount of Continuous

Reception Reception Tail state time and the amount of

Tail Continuous Reception state time.

Ratio

Long DRX The ratio between the amount of Long DRX state

Ratio time and the amount of Continuous Reception and
Short DRX state time.
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Short DRX The ratio between the amount of Short DRX state

Ratio time and the amount of Continuous Reception and
Long DRX state time.

Promotion The ratio between the promoted state time

Ratio (IDLE->Continuous Reception), and the sum of the

IDLE, IDLE->Continuous Reception, Continuous
Reception, and Continuous Reception Tail state
times.

When a Wi-Fi device profile like AT&T Wi-Fi is selected, then
the section appears like the following:

RRC(Radio Resource Control) State Machine Simulation

WiFi Active: 28.36 (21.37% oftime)
WiFi Tail: 13.00(9.80% oftime)
WiFi Idle: 104.36 (78.63% oftime)

The following table describes the statistics contained in the
RRC (Radio Resource Control) State Machine Simulation
section when a Wi-Fi device profile is selected:

Field Description

Wi-Fi Active | The amount of Wi-Fi Active state time, in seconds,
and its percentage of total packet duration.

Wi-Fi Tall The amount of Wi-Fi Tail state time, in seconds,
and its percentage of total packet duration.
Wi-Fi Idle The amount of Wi-Fi Idle state time, in seconds,

and its percentage of total packet duration.

. Burst Analysis Section

The Burst Analysis section of the Statistics Tab information
page, contains two tables that provide burst information. One
that groups the bursts by burst type, and another that lists
individual bursts. These two tables are:

. Burst Analysis
. Individual Burst Analysis

. Burst Analysis Table

The Burst Analysis table provides information about the
collected bursts from the loaded trace, summarized by burst
type. You can export the contents of this table in the
preferred format by right-clicking on it.
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Note: The columns of information displayed in this table
depend on the type of device profile that is selected.

When a 3G device profile like AT&T 3G is selected, the
Burst Analysis table appears like the following:

Burst Analysis

| Burst Bytes % of Bytes Energy % of Energy ~ DCH (Active) =~ % DCH {Active) =~ IpkKB
TepControl 0 0.0 9.97 10.3 3.850 6.4 0.000
‘UserInput 5,968 3.1 27.38 28.3 15,693 26.1 0.574
‘ADD 182,733 94.5 45.01 46.5 31.196 51.9 0.031
jSeretDeIay 4,625 2.4 14.41 14.9 9.377 15.6 0.389

When an LTE device profile like AT&T LTE is selected, the
Burst Analysis table appears like the following:

Burst Analysis

: Burst Bytes % of Bytes Energy  %ofEnergy  Continuous Reception % of Continuous Reception | JpKB
|TepControl 0 0.0 21.29 17.6 0.810 5.0 0.000
\UserInput 4,602 2.4 3z2.21 26.6 1.278 8.0 0.875
|App 184,099 95.2 50.62 41.8 12.679 78.9 0.034
:SeretDelay 4,625 2.4 17.08 14.1 1.301 8.1 0.462

When a Wi-Fi device profile like AT&T Wi-Fi is selected, the
Burst Analysis table appears like the following:

Burst Analysis

Burst Bytes % of Bytes = Energy % of Energy  WiFi Active % of WiFi Active JpKE
TepContral 0 0.0 1.12 8.3 1.560 5.5 0.000
UserInput 4,602 2.4 1.75 13.0 2.963 10.4 0.048
App 184,099 95.2 9.24 63.3 21.042 74.2 0.006
SvrhetDelay 4,625 2.4 1.41 10.4 2.794 9.9 0.038

The following table describes all the statistics contained in
the Burst Analysis table for all types of device profiles
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Field Description

Burst One of the following Burst types according to
the request/response types in the loaded
trace.

TCP Control

TCP Loss
Recover

User Input

Screen
Rotation

App
SvrNetDelay
NonTarget
LargeBurst
Periodical
Unknown
Userdef 1
Userdef 2
Userdef 3

Bytes The payload length, in bytes, for the
corresponding Burst type. The payload length
considers only the data length of packets
which occurred during the burst.

% of Bytes | The percentage of total payload used by the
individual burst payload. The total payload is
the sum of all burst payloads.

Energy The amount of Energy, in Joules, for the
corresponding Burst type.

% of The percentage of total burst energy used by

Energy the individual burst. Total burst energy is the
sum of all individual burst Energy amounts.

DCH The amount of DCH Active time for the

(Active) corresponding Burst type. Note: This column
is only displayed when a 3G device profile is
selected.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide



((

AT&T Entertainment Experience Suite

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.

Video Optimizer User Guide

Field Description
%DCH The percentage of total DCH Time used by
(Active) the individual burst. The total DCH Time is the
sum of all individual burst DCH Times.
Note: This column is only displayed when a
3G device prdfile is selected.
Continuous | The amount of Continuous Reception time for
Reception | the corresponding Burst type.
Note: This column is only displayed when an
LTE device profile is selected.
% of The percentage of total Continuous Reception
Continuous | time used by the individual burst. The total
Reception | Continuous Reception time is the sum of all
individual burst Continuous Reception times.
Note: This column is only displayed when an
LTE device profile is selected.
Wi-Fi The amount of Wi-Fi Active time for the
Active corresponding Burst type.
Note: This column is only displayed when a
Wi-Fi device profile is selected.
% of Wi-Fi | The percentage of total Wi-Fi Active time
Active used by the individual burst. The total Wi-Fi
Active time is the sum of all individual burst
Wi-Fi Active times.
Note: This column is only displayed when a
Wi-Fi device profile is selected.
Jpkb The number of Joules per Kilobytes for the

corresponding Burst type calculated from the
amount of burst type energy and burst type
payload.

Individual Burst Analysis Table

The Individual Burst Analysis table provides information
about each individual burst in the loaded trace. You can
export the contents of this table in the CSV format by
right-clicking on it.
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Individual Burst Analysis

| Start Time Time Elapsed Bytes Packet Count Burst
14,465 S.240 78,568 146 App
23.757 12.496 42,367 171 App
38.155 3.138 24,380 91 App
43.477 7.985 37,418 124 App
55.323 1.091 1] 32 TcpControl
60.104 0.656 1,229 10 UserInput
|72.772 2.193 1,041 9 UserInput
85.046 0.037 1] 2 TcpControl

The following table describes the statistics contained in
the Individual Burst Analysis section:

Field Description
Start T The start time of the burst, in seconds, from the beginning
Time T of the trace.
Time P The time elapsed during the burst, in seconds.
Elapsed
BytesC The payload length, in bytes, for the burst. The payload
a length considers only the data length of packets which
C occurred during the burst.
Packe? The number of packets in the burst.
Count®
Burst S One of the following Burst types according to the
i request/response types in the loaded trace.
C BurstCategories. ]
t
i TCP Control
S TCP Loss Recover
t User Input
i Screen Rotation
C App
s SvrNetDelay
NonTarget
T LargeBurst
n Periodical
© Unknown
H Userdef 1
T Userdef 2
T Userdef 3
P

Cache Statistics section of the Statistics Tab information
page displays statistical information about the cache
based on the data in the loaded trace. Caching is the
process of storing data on the client side to avoid the
repeated download of data from the server. This
increases the amount of bandwidth available for
common requests and responses.

This section contains the following sub-categories:
* Cacheable vs. Non-Cacheable
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* Cache Simulation Results

* Duplicate File Analysis
The following figure shows the columns and sub-
categories of the HTTP Cache Statistics section.

HTTP Cache Statistics
% of Responses % of Bytes

Cacheable: 100.0 100.0
Specified - No Store: 0.0 0.0

Acceptable Behavior

Files downloaded once: 65.0 97.4
Files specified as "No-Store": 0.0 0.0
Expired, but correct 304 response sent from server: 0.0 0.0
Expired, downloaded again, but file has changed: 0.0 0.0
Duplicate File Download
Duplicate download (not expired): 35.0 26
Duplicate download (expired, but no "I Modified-Since" header sent): 0.0 0.0
Duplicate download (expired, but"I-Modified-Since" header ignored): 0.0 0.0
Duplicate File Download: Streaming
Partial duplicate download {Not Expired): 0.0 0.0
Partial duplicate download (expired, but no "I-Modified-Since" header sent): 0.0 0.0
Partial duplicate download (expired, but"I-Modified-Since" header ignored): 0.0 0.0

---------- Duplicate File Analysis ----------

Duplicate download (Cache not expired): 71.4 453
Duplicate download (24 hr cache not expired): 28.6 54.7
Duplicate download (Cache expired): 0.0 0.0
Duplicate download {24 hr cache expired): 0.0 0.0

The HTTP Cache Statistics section contains the
following columns:

Column Description

% of Displays the amount of responses for this

Response | row item expressed as a percentage of the
total number of responses.

% of Displays the number of bytes for this row

Bytes item expressed as a percentage of the
total number of bytes.

° Cacheable vs. Non-Cacheable

The Cacheable vs. Non-Cacheable section of the HTTP
Cache Statistics section contains the following rows of
information:
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Row

Description

Cacheable

Specified - No Store

This field analyzes the cacheable
contents from the loaded trace. The
percentage of Cacheable Responses
is calculated from the amount of
Cacheable content and the amount
of total cache content. The
percentage of

Cacheable Bytes is calculated from
the number of

Cacheable bytes and total number of
cache bytes.

This field analyzes the files from the
loaded trace that are specified as “No
Store”. The percentage of No Store
Responses is calculated from the
amount of No Store content and the
amount of Total Cache content. The
percentage of No Store Bytes is
calculated from the number of No
Store bytes and the total number of
cache bytes.

° Cache Simulation Results

The Cache Simulation Results sub-category of the HTTP
Cache Statistics section contains the Acceptable
behavior, Duplicate File Download, and Duplicate File
Download: Streaming sub-sections.

The following tables describe the rows of information in

those sub-sections.

Row

Description

sent from server

Files downloaded | The percentage of total responses and total bytes for

once files that were downloaded only once. This content is
populated from the caching missed contents.

Files specified as This content is calculated from the “No-Store” HTTP

"No-Store" responses. The percentages are calculated from the
cache diagnosis total and the number of total bytes.

Expired, but correct | The percentage of total responses and total bytes for

304 responses content with the HTTP response code 304.
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Row Description

Expired, The percentage of total responses and total bytes for
downloaded again, | content where the HTTP response has changed from
but file has the expired response.

changed

Duplicate download
(not expired)

Duplicate download
(expired, but no "If-
Modified Since"
header sent)

Duplicate download
(expired, but "If-
Modified Since"
header ignored)

The percentage of total responses and total bytes for
content which is a duplicate download but has not
expired.

The percentage of total responses and total bytes for
content which is a duplicate download that has expired,
and for which an “If-Modified-Since” header was not
sent.

The percentage of total responses and total bytes for
content which is a duplicate download that has expired
and contains an “If-Modified-Since” header that was
ignored.

Partial duplicate
download (Not
Expired)

Partial duplicate
download (expired,
but no "If-Modified
Since" header sent)

Partial duplicate
download (expired,
but "If-Modified
Since" header
ignored)

The percentage of total responses and total bytes for
content which is a partial duplicate download that has
not expired.

The percentage of total responses and total bytes for
content which is a partial duplicate download that has
expired and for which an “If-Modified-Since” header was
not sent.

The percentage of total responses and total bytes for
content which is a partial duplicate download that has
expired and for which an “If-Modified-Since” header was
ignored.

. Duplicate File Analysis

The Duplicate File Analysis section of the Statistics Tab
information page displays information about duplicate
files that were downloaded during the trace.

The Duplicate File Analysis section contains the
following information:
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Field Description

Duplicate download The percentage of total responses and

(Cache not expired) total bytes for content which is a
duplicate download, and for which the
cache has not expired. These values are
calculated with the total cache expiration
count and cache expiration ratios.

Duplicate download The percentage of total responses and
(24 hr. cache not total bytes for content which is a
expired) duplicate download, and for which the
24-hour cache has not expired.
Duplicate download The percentage of total responses and
(Cache expired) total bytes for content which is a
duplicate download, and for which the
cache has expired.
Duplicate download The percentage of total responses and
(24 hr. cache total bytes for content which is a
expired) duplicate download, and for which the
24-hour cache has expired.

Energy Efficiency Simulation

The Energy Efficiency Simulation section of the Statistics
Tab information page displays the overall energy
efficiency from the loaded trace. The section lists the
amount of energy used for each of the different types of
energy consumption that can affect the performance of
the application, or the energy level of the device.

Note: The information displayed in this section depends
on the type of device profile that is selected.

When a 3G device profile like AT&T 3G is selected, the
Energy Efficiency Simulation section appears like the
following:

Energy Efficiency Simulation

DCH (Active): 78154
FACH (Standby): 12814
IDLE: 0.00J
IDLE-=DCH (Active): 3144
FACH (Standby)-=DCH (Active): 2.68J
DCH {Active) Tail: 36.40J
FACH (Standby) Tail: 5224
Total RRC Energy: 96.78J
Joules per Kilobyte: 0.43
GPS Active: 0.00J
GPS Standby: 2654
Total GPS Energy: 2654
Total Camera Energy. 0.00J
Bluetooth Active: 0.00J
Bluetooth Standby: 0.00J
Total Bluetooth Energy: 0.00J
Total Screen Energy: 84.54
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When an LTE device profile like AT&T LTE is selected,
the Energy Efficiency Simulation section appears like the
following:

Energy Efficiency Simulation
IDLE-»Cantinuous Reception: 0.94 J

Continuous Reception: 19.43J
Continuous Reception Tail:  13.56J
Short DRI 2444
Long DRX: 97.86J
IDLE: 0544
Total RRC Energy: 121.21J
Joules per Kilobyte: 053
GPS Active: 0.004J
GPS Standby: 2654
Total GPS Energy: 2654
Total Camera Energy: 0.00J
Bluetooth Active: 0.00J
Bluetooth Standby: 0.00J
Total Bluetooth Energy: 0.00J
Total Screen Energy: 76.98J

When a WiFi device profile like AT&T WiFi is selected,
the Energy Efficiency Simulation section appears like the
following:

Energy Efficiency Simulation

WiFi Active: 11.43J
WiFi Tail: 5.24J
WiFi ldle: 2.08J
Total Wi-Fi Energy: 13524
GPS Active: 0.00J
GPS Standby: 2654

Total GPS Energy: 2.65J
Total Camera Energy:  0.00J
Bluetooth Active: 0.00J
Bluetooth Standby: 0.004J
Total Bluetooth Energy: 0.00 J
Total Screen Energy:  76.98J

The following table describes all the statistics contained
in the Energy Efficiency Simulation section for either
type of device profile:

Field

Description

CELL_DCH
(Active)

CELL_FACH
(Standby)

IDLE

IDLE->DCH
(Active)

FACH (Standby) -
>DCH (Active)

The total DCH time energy expended in the loaded
traces. This is calculated from the RRC DCH time value
and the power DCH value.

The total FACH energy expended in the loaded trace.
This is calculated from the RRC FACH time value and
the power FACH value.

The total idle time energy from the loaded trace. The
idle energy should always be O.

The amount of RRC IDLE to DCH (Active) state time
energy consumption.

The amount of RRC FACH (Standby) to DCH (Active)
time energy consumption.
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Field

Description

DCH (Active) Tail

The amount of energy consumed during the RRC DCH
(Active) Tail state period.

FACH (Standby)
Tail

IDLE ->
Continuous
Reception

Continuous
Reception

Continuous
Reception Tail
Short DRX
Long DRX
WiFi Active
WiFi Tall

WiFi Idle

Total RRC Energy

Joules per Kilobyte

GPS Active

Long DRX
WiFi Active
WiFi Tall

WiFi Idle

The amount of energy consumed during the RRC FACH
Tail state period.

The amount of energy consumed during all transitions
from the IDLE state to Continuous Reception.

The amount of energy consumed during the Continuous
Reception state.

The amount of energy consumed during the Tail time of
the Continuous Reception state.

The amount of energy consumed during the Short DRX
state.

The amount of energy consumed during the Long DRX
state.

The amount of energy consumed during the WiFi Active
state.

The amount of consumed during the WiFi Tail state.

The amount of energy consumed during the WiFi Idle
state.

The sum of the CELL_DEH (Active), CELL_FACH
(Standby), FACH (Standby) ODCH (Active), IDLECDCH
(Active), and IDLE energy consumption amounts.

The number of Joules per Kilobyte from the loaded
trace, calculated from the amount of total energy and
total bytes.

The total energy consumed during the GPS Active state.
In GPS Active state, the energy consumption will be
eqgual to the time multiplied by the energy draw for
Active GPS.

The amount of energy consumed during the Long DRX
state.

The amount of energy consumed during the WiFi Active
state.

The amount of energy consumed during the WiFi Tall
state.

The amount of energy consumed during the WiFi Idle
state.
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Field Description

Total RRC Energy | The sum of the CELL_DEH (Active), CELL_FACH
(Standby), FACH (Standby) ['DCH (Active), IDLECJDCH
(Active), and IDLE energy consumption amounts.

Joules per Kilobyte | The number of Joules per Kilobyte from the loaded
trace, calculated from the amount of total energy and
total bytes.

GPS Active The total energy consumed during the GPS Active state.
In GPS Active state, the energy consumption will be
equal to the time multiplied by the energy draw for
Active GPS.

5.2.7. Waterfall Tab
The Waterfall tab displays a waterfall view chart of the TCP
connections from the trace spread over time. The chart can be
expanded or contracted to get a detailed view into the connections in
the trace data. The following image shows the Waterfall Tab. (Note:
The URLSs of the TCP connections have been deliberately hidden.)

1. As the key at the bottom of the tab indicates, the color-coded plots on
the chart indicate the following information for each connection listed
on the left side of the chart:
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Label Description

DNS The time until the DNS

Lookup lookup was completed.

Initial The time until the initial

Connection connection was made.

SSL The time spent in SSL

Negotiation negotiation.

Request The time spent requesting

Time data from the server.

Time to The time until the first byte

First Byte was downloaded.

Content The time spent downloading

Download the content.

3xx result An HTTP response code in
the 300 range.

4xx+ result An HTTP response code in
the 400 or 500 range. These
codes indicate an error.

2. When any of the color-coded plots on the chart are clicked, a
Request/Response Detail dialog box (like the following) is shown:

| £ Request/Response #25 Detail
DEtﬁ"S Request Response

URL:

Host:

IP: <77 770

ErroriStatus Code: Encrypted
Start Offset: 9.126 s

DNS Lookup: N/A

Initial Connection: N/A

SSL Negotiation: -197 ms
Request Time: 0 ms

Time to First Byte: 0 ms
Content Download: 14,844 ms
Bytes In (downloaded) 0.9 KB
Bytes Out (uploaded) 0.6 KB

OK

3. The tabs on the dialog box show details about the connection,
information about the request, and the actual content of the response.
The request/response data is like the detail provided in the
Request/Response View table on the Diagnostics tab.
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Multiple Simultaneous connections to many end points

Double clicking on the results section of the Multiple Simultaneous
Connections to Many Endpoints best practice navigates to the
waterfall tab.

The Waterfall tab displays appropriate domain names and IP
addresses and shows the total connections at any point in time in the
graph where a user hovers. The Maximum Simultaneous Connections
count for the trace is highlighted using a blue vertical line indicator at
the moment when the most connections were open

Double clicking on the results section of multiple simultaneous
connections navigates to the waterfall tab shows the maximum
connections at that point.

ke Prefds Toch View Outa Collector Hdp
St Prachcrn umin | Qo | Diagrntcs | oo | statanca | el

s
)
g ATAT Video Optimizer Watertall View
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The sections in Appendix | list the error messages for the Data Collector and for Video

Optimizer.

6.1. Data Collector Error Messages
The following table lists and describes the error messages that can appear
when using the Data Collector option in Video Optimizer.

Error Message

Condition

Please enter trace
folder name.

Trace folder name
cannot have
special characters
or spaces.

Trace folder
already exists! Do
you want to
overwrite existing
trace?

SD card is either
not available or it is
mounted. Please
check the SD card
before running
Video
OptimizerData
Collector.

SD Card mounted,
Video Optimizer
Data Collector
trace session
terminated.

SD Card memory
full, stopping Video
Optimizer Data
Collector.

Video Optimizer
Data Collector
trace session can't
be started with
Flight Mode on and
no active WIFI
connection.

This error occurs if data collection is started without
providing a trace folder name.

This error occurs if data collection is started, and the
trace folder name contains either non-alphanumeric
characters, or spaces.

This error occurs if data collection is started, and the
trace folder name already exists. When this error
occurs, click Ok to proceed and overwrite the folder
contents, or press Cancel to provide another name.

The Data Collector writes data files to a folder on the
device's onboard SD card—but the SD card must not be
mounted during data collection. This error occurs if no
SD card is detected, or if the SD card is mounted when
starting the Data Collector.

When the Data Collector finishes collecting data, it
writes the data files to the device's onboard SD card—
but the SD card must not be mounted during data
collection. This error occurs if data collection is started,
and the SD card is mounted.

This error occurs during data collection, if the data
collection process terminates because the SD card is
full.

This error occurs if data collection is started when the
device is in Flight Mode and there is no active WiFi
connection.
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stopped due to
Flight Mode being
turned on while
there was no active
WIFI connection.

trace session can't
be started with no
active network
connection.

Error Message Condition
Video Optimizer This error occurs if Flight Mode is turned on while there
Data Collector is no active WiFi connection and data collection is taking
trace session place.

Video Optimizer This message appears if an unexpected error occurs
Data Collector when the Start Collector button is clicked.

failed to start!

Video Optimizer This error occurs during data collection, if the data
Data Collector collection process terminates unexpectedly.

trace collection

stopped.

Video Optimizer This error occurs if a trace session is started with no
Data Collector active network connection.

6.2. Video Optimizer Error Messages

The following table lists and describes the error messages that can appear

when using the Video Optimizer.

Error Message

Condition

iOS: Remote Virtual Interface (rvi) error.

There was a disconnect
between the mac interface and
RVI. Please disconnect and
reconnect the device or restart
the device for continuation.

iOS: Video Optimizer is unable to locate
Wireshark/Dumpcap, Please update the
Wireshark location in the preferences
setting.

This error messages occurs
when the location is not
configured properly. The default
location is under Applications.

iOS: Error.rvi.reset connection

There was a disconnect
between the mac interface and
RVI. Please disconnect and
reconnect the device or restart
the device for continuation.
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Error Message

Condition

O & B o

ec e Instructions for using trouble shooting the RVI error

w  Dial Use g check your Virtual Intertace)

@ Use Finder,Go => Go to Folder..., enter the location */Library/Apple/'System/Library/Extensions/™

® Isfile "L

* presented in the folder
‘@ if the Kextfile isn't present at the location above, thats because kextfile hasn't been installed.

# Run - sudo installor -phg

arget

® NOTE: May noed to deiete "/L before
running installer for MobileDeviceDevelopment kg

MSTICS

ransferred | oarn mon
oK

METADATA
Trace type -
Device orlentation
Targeted App

This troubleshooting message
provides instructions to check
the RVI status in case of an
error.

Missing Prerequisite Library:
Unable to detect prerequisite dependency
ideviceinstaller. Please verify.

This message occurs when one
of the pre-requisites is not
installed.

Missing Prerequisite Library:
Unable to detect prerequisite dependency
libimobiledeivice. Please verify.

This message occurs when one
of the pre-requisites is not
installed.

Missing Prerequisite Library:
Unable to detect prerequisite dependency
ifuse. Please verify.

This message occurs when one
of the pre-requisites is not
installed.

“Video Optimizer requires Npcap installed
in WinPcap API-compatible Mode. It can
be found at: https://nmap.org/npcap/

The Startup Delay cannot be set on this
video stream. You can log a support ticket
by visiting Help -> Support...

Video Optimizer requires AppleQuartz
renderer. Please set
apple.awt.graphics .UseQuartz flag to true

Unexpected Exception: exception
message

Video Optimizer User Guide

The Video Optimizer application
is dependent on WinPcap, and
it looks for the WinPcap
installation during every launch.
This error occurs if WinPcap is
not found, or if Npcap is not
installed in WinPcap API-
compatible Mode

This message is displayed
when FFprobe is not installed
on the machine or the path is
not set correctly.

This error occurs if the Video
Optimizer is being used on a
Mac OS, and the
apple.awt.graphics.UseQuartz
flag is not set to true.

This error occurs if Video
Optimizer encounters an
unexpected exception.
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Error Message

Condition

The previous operation had caused the
system to reach it's memory limit. To
recover, Video Optimizer had to restart the
application

Video Optimizer is unable to open a file of
this size.

Please Save As... to a local disk and open
from there.

This occurs if Video Optimizer
reaches the maximum amount
of memory allocated for it. The
message also displays 2
buttons — Edit Memory Settings,
and OK. Clicking on the Edit
Memory Settings button
navigates the user to File-
>Preferences so that the user
can edit the memory allocation.
Clicking on OK navigates the
user to the Best
Practices/Results tab.

This error occurs if the opening
of a trace file will force Video
Optimizer to reach the
maximum amount of memory
allocated for it.

Video Optimizer is unable to open a file
extension type file. Please Save As... to a
local disk and open from there.

Invalid trace in directory: trace folder path
and exception message.

An error occurred when trying to save the
chart.

No trace loaded. Please load trace files
before selecting this option.

Video Optimizer User Guide

This error occurs if the type of
the file that is being opened is
not recognized by Video
Optimizer.

This error occurs if Video
Optimizer encounters data in a
trace file that is invalid when
performing analysis.

Occurs if there is an error while
saving the Diagnosis Chart to an
image file.

This error occurs if one of the
following menu options is
selected before a trace file has
been opened in the Video
Optimizer:

e Time Range Analysis
(Tools Menu)

e PCAP File Analysis (Tools
Menu)

e Select Applications/IPs
(View Menu)
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Error Message Condition

Video Optimizer could not find trace folders
in selected path. Please select a valid trace
folder path.

The USB device got disconnected. Please
check the connection.

Video Optimizer Collector is already
running on the device. Please stop it and
try again.

Time values must be numeric.

Start time must be less than End Time.

This error occurs when a folder
that does not contain valid trace
files is selected when using the
Open Trace or Data Dump
menu options.

Occurs when a device that is
connected via USB to a device
running the Data Collector, is
disconnected unexpectedly.
Occurs when an instance of the
Data Collector is running on a
device while another instance is
started.

Occurs in the Time Range
Analysis Dialog if a honnumeric
value is entered for the Start or
End time.

Occurs in the Time Range
Analysis Dialog if a Start Time
value is entered that is greater
than the End Time value.

Start Time and End Time must be between
0.00 and trace length.

The system is unable to open .csv files by
default. Please set a default program for
.csv files.

Unable to connect to printer: printer name.

Error in parsing alarm analysis info.

More than one device or emulator is
connected to PC.

Video Optimizer User Guide

Occurs in the Time Range
Analysis Dialog if time value is
entered that is less than 0 or
greater than the total time of the
trace.

Occurs if the Export option is
selected to save one of the
charts or tables in the Overview,
Diagnosis and Statistics tabs to
the .csv format, and there is no
default program set in the
system for .csv files.

Occurs when Video Optimizer is
unable to connect to a printer
when the Print option is selected
in the File menu.

Occurs when Video Optimizer is
unable to parse information
about an alarm on the device.
Ocecurs if the computer is
connected to multiple devices of
device emulators, when the
Start Collector option on the
Data Collector menu is selected.
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Error Message

Condition

Could not find device or emulator

connection. Please verify the connection

and ADB daemon is started.

An unexpected error has occurred, please

restart the device.

Connection to device or emulator is lost.
Please wait for some time before starting

data collector.

Trace directory already exists. Do you want
to overwrite trace files in the directory?

Unable to create the Emulator trace

directory.

Ocecurs if the user is not
connected to a device or device
emulator, or if the ADB daemon
is not started, when the Start
Collector option on the Data
Collector menu is selected.
Occurs when there is an
unexpected error in the device
emulator.

Occurs if there is an error with
the ADB connection.

Occurs if an existing Trace
directory name is entered in the
dialog box when the Start
Collector menu option is
selected on the Data Collector
menu.

Occurs when the trace directory
cannot be created.

Trace name which you want to replace is
currently loaded. Do you want to clear the

trace?

Error starting Video Optimizer Data

Collector.

Error tcpdump not compiled for this device.

Error stopping
Video Optimizer Data Collector.

Error pulling Video Optimizer Data
Collector traces.

Occurs if the name of the
currently loaded Trace is
entered in the dialog box when
the Start Collector menu option
is selected on the Data Collector
menu.

Ocecurs if there is an error when
the Start Collector menu option
is selected on the Data Collector
menu.

Ocecurs if the device is not
supported by the Data Collector.

Occurs if there is an error when
stopping the Video Optimizer
Data Collector (using the Stop
Collector menu option on the
Data Collector menu) after it
has been started from Video
Optimizer.

Ocecurs if there is an error when
pulling Trace files from the
Video Optimizer Data Collector
to the local system.
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Error Message Condition

Video Optimizer Analyzer stopped
unexpectedly.

ADB Rejected the
Video Optimizer Data Collector device
Connection.

Emulator SD card is full. Please free some
space to start Video Optimizer Data
Collector.

Please set your device USB Mode to
"Charge Only" - otherwise the SD Card is

not available but is required by application.

Video Optimizer requires a virtual SD card
to be configured when using the Android
Emulator.

Occurs if the Data Analyzer
unexpectedly stops.

Occurs if the Android Debug
Bridge (ADB) cannot connect to
the device.

Occurs if the Emulator does not
have enough space on its SD
card to save the trace files
collected by the Video Optimizer
Data Collector.

Ocecurs if the Emulator does not
have an SD card available. An
SD card is required by the Video
Optimizer Data Collector when
using the Emulator.

Ocecurs if no virtual SD card was
configured before using the
Android Emulator.

Emulator SD card does not have enough
space; it must have 5 MB or more.

Device SD card does not have enough
space; it must have 5 MB or more.

Emulator SD Card memory full, stopping
Video Optimizer Data Collector.

Device SD Card memory full, stopping
Video Optimizer Data Collector.

Video Optimizer User Guide

Ocecurs if the Emulator does not
have at least 5MB of space
available on its SD card to save
the trace files collected by the
Video Optimizer Data Collector.
Occurs if a device does not
have at least 5MB of space
available on its SD card to save
the trace files collected by the
Video Optimizer Data Collector.
Ocecurs if the Emulator does not
have enough any memory
remaining on its SD card. When
this error occurs the Video
Optimizer Data Collector is
stopped.

Occurs if the Device does not
have enough any memory
remaining on its SD card. When
this error occurs the Video
Optimizer Data Collector is
stopped.
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Error Message

Condition

Unexpected error accessing emulator SD
Card:
exception message

Unexpected error accessing device SD
Card: exception message

Device SD card is not available but is
required by application.

Trace folder name should not contain
special characters or spaces.

Trace folder name should not be more
than 50 characters.

Occurs if there is an unexpected
error while the Video Optimizer
Data Collector is accessing the
Emulator.

Occurs if there is an unexpected
error while the Video Optimizer
Data Collector is accessing the
SD Card of a device.

Occurs when the Video
Optimizer Data Collector
attempts to access the SD Card
of a device when it is not
available.

When the Start Collector menu
option is selected on the

Data Collector menu, the user is
prompted to enter a Trace folder
name. This error occurs if the
Trace folder name contains an
invalid special character or a
space. The folder name can
only contain alphanumeric
characters or a (-) special
character.

Occurs if the Trace folder name
that is entered in the dialog box
when the Start Collector menu
option is selected on the Data
Collector menu, is longer than
50 characters.

Emulator error with tcpdump/key.db push.

Emulator 1/0 exception caused data
collector failure.

Occurs if there is an error while
transferring the collected trace
files from the device or device
emulator to the local system.

This transfer is initiated by the
Video Optimizer Data Analyzer
when the Stop Collector menu
option is selected on the Data
Collector Menu, and the Pull
Traces menu option is selected
on the Data Collector.

Occurs if there is an Input /

Output exception when the Data
Collector tries to connect to the
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Error Message Condition

No application found to open PCAP trace.
Please install an application like
WireShark for

PCAP analysis.

Wireshark is a required utility and could not
be found, please install Wireshark and set
its path in File:Preferences for Wireshark

No traffic.cap file found in trace.

Not able to start.

Video file is not valid.

Unable to read file.

Video display conversion of video.mp4 to
video.mov file failed.

ERROR: Trace
directory is empty

device or device emulator.

The Data Collector is started
from the Data Analyzer by
selecting the Start Collector
option on the Data Collector
menu

Occurs if the PCAP File
Analysis option is selected on
the Tools menu, but an external
tool (like WireShark) for
analyzing PCAP files is not
installed.

Occurs if Wireshark PATH is
incorrect in preferences and
system Path has wrong
Wireshark path or is missing.

Occurs if the PCAP File
Analysis option is selected on
the Tools menu, but a traffic.cap
file is not found in the loaded
trace folder.

Ocecurs if the APK is unable to
start.

Ocecurs if the Video Optimizer
Image/Video Viewer attempts to
load an invalid video file, or if a
trace is loaded that contains an
invalid video file.

Occurs if the Video Optimizer
Image/Video Viewer attempts to
load a video file that it is unable
to read, or if a trace is loaded
that contains a video file that
Video Optimizer is unable to
read.

Occurs if the Video Optimizer
Data Analyzer fails while
converting the video file from
.MP4 to .MOV.

Ocecurs if the Video Optimizer
Image/Video Viewer attempts to
load a video file, but the Trace
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Error Message

Condition

ERROR: Input file does not exist; nothing

directory is empty.

Occurs if the .MP4 video file

to convert. does not exist when the Video
Optimizer Image/Video Viewer
is attempting to convert it to
.MOV.

ERROR: No Occurs if the Video Optimizer

permission to write to output file for
conversion.

ERROR: Input file
is a directory; cannot be converted.

ERROR: Output

file is a directory; cannot be converted.

ERROR: Output
file still exists after deletion; cannot be
converted.

ERROR: Unable to read file.

ERROR: Video display conversion of
video.mp4 to video.mov file failed.

ERROR:
Exception setting up video player.

Video is already Synched. Do you want to

Re-Sync again?

Image/Video Viewer does not
have permission to write the
output file, when it is converting
the .MP4 video to the .MOV
format.

Occurs if the Video
Optimizer Image/Video
Viewer cannot convert the
input file (an .MP4 video)

to the .MOV format.

Occurs if the Video Optimizer
Image/Video Viewer encounters
a directory name instead of a
file name when it is converting
the .MP4 video to.MOV format.
Occurs if the Video Optimizer
Image/Video Viewer encounters
an error when preparing the
output file for conversion from
.MP4 to.MOV.

Occurs if a file that was placed
in the trace directory cannot be
read by the Video Optimizer.
Occurs if the Video Optimizer
Image/Video Viewer encounters
an error when converting the
output file from .MP4 to.MOV.

Occurs if there is an exception
when the Video Optimizer
Image/Video Viewer is
initializing.

Ocecurs if the Sync Video button
is clicked when the video is
already in sync.
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Error Message

Condition

The previous sync point has been cleared.
In order to Re-sync the video, select the
desired time point in the Video player and
then press the Sync Video button now.

Ocecurs if the Sync Video button
is clicked when no sync points
have been set.

ERROR: Multiple external video files exist
in the trace folder. Please add only one
external video and remove the rest.

Category String Error

Unexpected error exporting table

Error loading the list of profiles.

Error setting the selected profile to the
Video
Optimizer.

Error loading last device profile. Default
device profile is being used.

Error reading device profile attributes:
attribute name.

Unable to save file due to the errors below:
file error(s).

Unable to open file due to errors below: file
error(s).

Unable to load file due to errors below: file
error(s).

Error writing to file:
file error(s).

Video Optimizer User Guide

Occurs when there is more than
one video file in the trace folder
when the trace is loaded.

Occurs when an invalid string is
entered for the name of a User
Defined Burst.

Occurs when there is an error
exporting the Burst Analysis
Table.

Occurs when there is an error
loading a device profile.

Occurs when there is an error
setting a device profile in
selected in the Select Device
Profile dialog box that is opened
by the Load option in the Profile
menu.

Ocecurs if there is an error
loading the device profile. In this
case, the default profile will be
used instead.

Occurs when a Device Profile is
loaded that contains an
unrecognized attribute name.

Occurs when there are file
errors while attempting to save
a customized Device Profile.
Occurs when there are file
errors while attempting to open
a Device Profile.

Occurs when there are file
errors while attempting to load a
Device Profile.

Occurs when there is an error
writing to the file selected in the
file chooser dialog.
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Error Message

Condition

Unable to load content. Download may
have been interrupted.

Microsoft Network Monitor related error.

Occurs when there is an error
opening content in the Video
Optimizer Image/Video Viewer.

Occurs when there is an error
related to the Microsoft Network
Monitor.

Could not load Microsoft Network Monitor
trace file.

Video Optimizer was unable to

open the file. It

may be necessary to install Microsoft
Network Monitor.

Timeout in starting the collector trace.

Video Optimizer Collector is not installed
on the device.

Video Optimizer collector is not started. Its
current activity has been brought to the
front. Please exit the activity and try again.

Video Optimizer collector is not stopped.
Please hide the activity on the device and
press OK.

Video Optimizer could not find a trace in
the selected folder. Please select a valid
trace folder.

To perform video analysis you must have
VLC player 64 bit version. Please check
the user guide for installation. Contact us
for further troubleshooting.

Occurs when there is an error
loading a trace file that was
collected by the Microsoft
Network Monitor.

Occurs when a trace file that
was collected by the Microsoft
Network Monitor is opened, but
Microsoft Network Monitor is not
installed.

Occurs when the trace file is so
large that it time out before it
can be loaded by the Analyzer.
Occurs when the Start Collector
menu option is selected but the
Data Collector apk is not
installed on the device.

Occurs when activity by the
Collector is displayed in front of
the main start screen before the
Collector is started.

Occurs when the Collector is not
stopped, and activity on the
device is displayed in front of
the main screen.

Occurs when a trace folder is
selected (using the Open Trace
menu option) that does not
contain valid trace files.

When a user with the wrong
VLC version (ie: 32 bit) opens a
trace, and the installed VLC is
an incompatible architecture
with the Video Optimizer
installation (64 bit).

Video Optimizer User Guide
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6.3. Glossary
This following table contains a list of Mobile Web-associated terms, with

their associated definitions. For a more comprehensive list, see the World
Wide Web Consortium (W3QC).

Term

Definition

Age

A property of a Response Entity. The length of the
elapsed time since the Entity was either Served by
the Origin Server, or successfully validated.

Average Rate

The amount of data in KB over the time the trace
was run. Apps that stream content should score
high here, apps with few connections should score
lower.

Burst

Consecutive packets of data transferred in a batch
over a TCP connection. Bursts can be initiated by
the user, the app, or the network.

Cache

A local process implemented in the client that
creates copies of Response Messages and serves
them to the client on the Server's behalf, if it
remains identical to the Origin Server's copy.
When used properly, the use of Response Caches
significantly reduces application response time and
bandwidth consumption.

Cacheable

A response is cacheable if the requirements of the
Request Method, Request Header Fields, and the
Response Status indicate that it is cacheable.

Client

A program that establishes connections for sending
requests.

Connection

A virtual circuit, established at the Transport Layer,
that is used to connect two programs so that they
can communicate using TCP.

Content Negotiation

The mechanism for selecting the appropriate
representation for servicing a request.

The representation of entities in any response can
be negotiated (including Error Responses).

Core Network

The Internet backbone. The network that the Radio
Access Network is connected to.

Energy Consumption

As your application becomes more efficient, the
J/IKB should decrease. This means you are
consuming less battery energy per kilobyte.

Entity

The requested content. Delivered as the payload of
Response/Request messages. Request and
Response messages do not always carry a
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Term Definition

payload.

An Entity consists of entity-header that contains
meta-information and an entity-body that contains
web content, although some responses will include
only the entity-headers.

Explicit Expiration The expiration time associated with an Entity—
Time when specified by the Origin Server.

Beyond that point in time, the Cache can continue
serving the local copy of the Entity, but only if it
passes a Validation test.

File Types A breakdown of all files seen during the trace (in
bytes). Files sent through HTTPs are listed as
Encrypted.

First-Hand A property of a Response. A response that is

received directly from the Origin Server. Cached
Responses are copies of First-Hand
Responses.

Fresh A property of a Response Entity. Indicates that a
Cached Response is still implicitly valid. A Fresh
Response is a response that has not exceeded
its Freshness Lifetime.

Freshness Lifetime A property of a Response Entity. The period in
which a cacheable response remains implicitly
valid.

How long it takes for a cacheable response to
reach its expiration time.

Gateway A Server that acts as an intermediary for another
server.

Unlike proxies, gateways behave like Origin
Servers, receiving resource requests. The
requesting client cannot be aware that it is
communicating with a gateway.

GPRS General Packet Radio Services.
Single GSM error-corrected circuit-switched data
channel.
Heuristic Expiration The expiration time associated with an entity—
Time determined programmatically by Cache

management logic.

A Cache management strategy used whenever the
Origin Server doesn't specify an Explicit Expiration
Time.

HSDPA High-speed Downlink Packet Access. In the
same way that EDGE uses techniques to
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Definition

increase speeds over GPRS, HSDPA employs
these same techniques, as well as others, to
increase the speed of UMTS data channels. Also
known as UMTS/HSDPA. UMTS/HSDPA is a
wide-area wireless data service

Application level, stateless, communication
protocol.

Client/server communication consists solely of
independent pairs of Requests and Responses.

Terms indicating the path of Request and
Response messages.

Inbound messages travel toward the Origin Server.
Outbound messages travel toward the User Agent.

Term
HTTP
Inbound/Outbound
Joules

The Sl unit of energy.
The work required to produce one watt of power for
one second (think of Kilowatt Hours).

Long Burst Connection

A long burst is one that sends a large amount of
data in a short period of time. If most of the data is
consumed, this is a good way to send data (see
tightly grouped above).

Message

The basic unit of HTTP communication.

MIME

Multipurpose Internet Mail Extensions.

Non-Periodic
Connections

Connections that recur periodically can cause rapid
battery drainage. Consider if your periodic pings are
required, if the timing could be lengthened, or if
other alternatives exist (Pushing alerts is more
efficient than regular polling).

Origin Server

The server on which a given Resource either
resides or is created.

Pcap

Packet Capture

An API for capturing network traffic.

Unix-like systems implement Pcap in the libpcap
library; Windows uses a port of libpcap known as
WinPcap.

Proper Session
Termination

The percentage of connections that close
immediately with no delay. Connections that close
in a delayed fashion, keep the RRC state Machine
on longer - needlessly draining the battery.

Proxy

A program that acts as both a server and a client for
making requests on behalf of other clients.
Requests are either serviced internally, or are
passed on with possible translation, to other
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Term

Definition

servers.
A proxy MUST implement both the client and server
HTTP requirements.

A transparent proxy is a proxy that does not modify
the request or response beyond what is required for
authentication and identification.

A non-transparent proxy is a proxy that modifies the
request or response to provide some added service
to the user agent, such as group annotation
services, media type transformation, protocol
reduction, or anonymity filtering.

Except where either transparent or non-transparent
behavior is explicitly stated, the HTTP proxy
requirements apply to both types of proxies.

Radio Access Network
(RAN)

The UMTS wireless network, connecting mobile
devices to the Core Network.

Representation

A Response Entity that is subject to Content
Negotiation.

Multiple representations can be associated with a
Response Status.

Request

A request message from a client to a server
includes, within the first line of that message, the
method to be applied to the resource, the identifier
of the resource, and the protocol version in use.

Resource

Any network Data Object or Service that can be
identified by a URI.

Resources can be made available in multiple
representations (e.g. multiple languages, data
formats, size, and resolutions) or vary in other
ways.

Response

After receiving and interpreting a Request
Message, a web server fulfills the request by
sending back an HTTP Response Message, which
contains the requested content as the payload.

Semantically
Transparent

A property that describes the way a Cache
behaves. In terms of content quality, content
served from a Cache that is Semantically
Transparent matches that served from the Origin
Server.

Except for the addition of hop-by-hop headers, the
client receives Responses that are identical to First-
Hand Responses.
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Definition

Server

A program that accepts connections to service
requests and sends back responses.

Any given program can be capable of being both a
client and a server; our use of these terms refers
only to the role being performed by the program for
a connection, rather than to the program's
capabilities in general. Likewise, any server can act
as an origin server, proxy, gateway, or tunnel,
switching behavior based on the nature of each
request.

Session

HTTP Session. The conversation that takes place,
between a client and a server.

Initiated by the client but concluded by either the
client or the server.

Consists of a series of network Request-Response
transactions.

Lasts for the duration of the conversation, usually
minutes.

Session Termination

This graph is scoring the types and actions of the
TCP connections found in this trace.

Signaling overhead

The higher the percentile, better the performance of
your application. Signaling overhead indicates the
time spent in RRC state transitions. The lower the
signaling overhead number, lower the count of state
transitions, and the higher your percentile rank.

Simulation Based on device profile.

Stale A property of a response entity that indicates that
a cached response is no longer implicitly valid. A
stale response is a response that has exceeded its
freshness lifetime.

Stateful In a session, at least one of the communicating
parties needs to save information about the session
history to be able to communicate.

Stateless The communication consists of independent
requests and responses.

Tightly Grouped Connections that are grouped together efficiently

Connections use the radio while it is turned on. Connections that

are spread out keep the radio on for a longer period,
adding to the battery drain.
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Term

Definition

Trace

A record of the Information generated by a device
and by the network communicating with the device.
Trace information can include packets transferred
between the device and network, radio energy
usage information, user input information, device
information, and information from peripheral
applications.

Trace Benchmark

This graph benchmarks your trace to the results of
traces run on top mobile applications. This gives
you an idea of where your application stands in
comparison to other applications. The rankings here
do not signify anything specific other than a ranking.

Tunnel

An intermediary program that acts as a blind relay
in the Client/Server connection.

Once active, a Tunnel is not considered a party to
the HTTP communication.

Tunnels are initiated by an HTTP Request. A
tunnel ceases to exist when the connections
terminates.

UMTS

Universal Mobile Telecommunications System. The
3G version of the GPRS technology. Based on
GSM. UMTS radio link.

UMTS Data Channel

The link established between the mobile device and
the cell tower.

Upstream/Downstream

Terms that describe the direction in which
messages flow.
Messages travel from Upstream, to Downstream.

User Agent

The client that initiates a Request.

Clients are usually End-user programs, such as
Web Browsers, but they can also be Service
programs such as Spiders (web-traversing robots).

User Agent

A client application. Usually implements HTTP 1.1,
to communicate with a web server.

Validator

Timestamp information that accompanies Response
Entities.

Stored a Response Entity header field.

Used to validate Stale cache entries.

When an Origin Server sends a Full Response, it
includes a Validator in the Entity-header, which
along with the Entity-body, becomes a local cache
entry.

A Client (user agent or proxy cache) makes a
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Conditional Request for a cached copy a Resource
when it must guarantee the Resource's validity. The
Server evaluates the condition based on the result
of comparing the value of its local copy of the
requested resource's validator (the current version
of the Resource), against that of the value of one in
the Request. If they match, it responds with a
special status code (usually, 304 (Not Modified))
and no entity-body. Otherwise, it returns a Full
Response.

Thus, we avoid transmitting the full response if the
validator matches, and we avoid an extra round trip
if it does not match.

A protocol element (e.g., an entity tag or a
LastModified time) that is used to determine
whether a Cache Entry is usable (i.e., an equivalent
copy of an entity.

Variant

At a given instant, Resources can have multiple
Representation(s).

Each Representation is referred to as Variant. Use
of the term Variant does not necessarily imply that
the resource is subject to Content Negotiation.

7. Appendix Il

The sections in Appendix Il describe how to use the legacy Rooted Data Collector APK.
7.1. Rooted Data Collector APK

Rooted collection is a legacy product and is no longer updated. It is still included in the
Video Optimizer package, but if you encounter issues, they are unlikely to be resolved
in a future release.

7.1.1. Prerequisites for using the Rooted Data Collector APK
To collect an application trace using the Data Collector APK, you need the

following:

* A Video Optimizer Data Collector APK (included in the install on your
computer)

* An Android test device running Android version between 4.x and 6.0 (rooted
Data Collector does not work on Marshmallow and above)

7.1.2. Installing Rooted Data Collector APK

1. Start a trace as described in Using Video Optimizer to Collect Data,
selecting the rooted option.
2. The apk will be installed on your phone.
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Collecting a Trace Using the Data Collector

Once you have installed the Video Optimizer on your test device, you
can operate it directly on the device to collect a trace; or for devices
that do not allow you to capture trace video, you can operate the Data
Collector via a USB connection using the commands on the Start
Collector menu in Video Optimizer.

To operate the Data Collector from Video Optimizer, do the
following:

Step 1. Select Preferences from the File menu.

Step 2. Select the General tab.

Step 3.For the Adb Path field, browse to the directory where the
Android Debug Bridge (ADB) executable is located, and select
it.

Step 4.For mac(iOS) select the Wireshark path if not installed under
the default location displayed.

Step 5.Click Save and Close.

Step 6.Ensure that you have a USB connection between the test
device and the computer where Video Optimizer is installed.

Step 7. Select Start Collector from the Data Collector menu.

Step 8.0n the test device, select OK when the “Allow USB Debugging”
prompt asks you to confirm the RSA key on the test device.

Step 9.Run testing scenarios on your app while Video Optimizer is
collecting data. For example, launch the app, exercise the main
functions of the app, and close the app.

Step 10.  Select Stop Collector from the Data Collector menu

The trace data, including video, will be transferred to the computer via
USB as part of the trace collection process.

Note: This method allows you to capture a video of the trace via USB
for Android devices that do not support the Video Optimizer Data
Collector capturing trace video directly.

To operate the Video Optimizer Data Collector directly on an
Android test device, do the following:

Step 1.Open the program list on your device (Figure), find the “Video
Optimizer” icon, and launch it.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.

Video Optimizer User Guide



AT&T Entertainment Experience Suite Video Optimizer User Guide

=,
—~

Step 2.Click Accept on the Legal Terms screen (Figure) to proceed to
the main screen of Video Optimizer.

L £V @ )

ATST ARO

This experimental device is installed with the
AT&T Application Resource Optimizer (ARQ)
which can collect all your data, including
personally identifiable information (P), during
the mobile devices operation. | fully understand
the Developer's activities, and | voluntarily grant
consent to the Application Developer/AT&T to
the collection and use of all my device data
including PIl, by proceeding to use this device
hereafter. Further, | voluntarily agree to
participate in the development, modification or
improvement of device capabilties, activities or
application(s) resident on the device.

BN

Step 3.Use the controls on the Video Optimizer main screen to cancel
any running applications that you do not want to test.

Step 4. Select whether to record video with your trace and start the
Data Collector.

Step 5.Click Open Task Killer to stop running tasks and select the
tasks that you want to stop before you start collecting data. This
ensures that you are collecting trace data only from the
application that you want to test.

Step 6.Click Record Video to record video while you are capturing the
trace.

Step 7.Click Start Collector to start the Data Collector.

ARO

Use only test data while running ARO Data
Collector.

Ooen Taok ke

Start Collector

+ | Record Video

Learn more at
http://developer.att.com/ARD/quickstart
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